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The EPiServer Commerce User Guide

EPiServer Commerce is based on EPiServer CMS for content management and the Commerce Manager
module for managing online purchasing procedures. With EPiServer Commerce you can quickly build
and deploy state-of-the-art online stores.ltis tightly integrated with EPiServer CMS so that you can com-
bine powerful content display with your online store managementin the background. The EPiServer
OnlineCenter provides easy access to both your web content through EPiServer CMS, and your online
store through the Commerce Manager module.

This User Guide provides guidance to the usage of the various functions of EPiServer Commerce, both
within web store administration as well as content management for your website. The purpose of the EPiS-
erver Commerce sample site, which is described here, is to provide an example of how you can work with
EPiServer Commerce, in order to get your web store up and running in as little time as possible.

To find out more about how to integrate, develop and extend the functionality of EPiServer Commerce,
please refer to the EPiServer Commerce Developer Guide.

© EPiServer AB
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About This Documentation

This documentation is intended for the target groups as described below.

e The EPiServer Commerce User Guide:
e Content editors and system administrators working in EPiServer Commerce and EPiServer
CMS.
e Web shop administrators working with online store procedures in EPiServer Commerce
and Commerce Manager.
e The EPiServer Commerce Developer Guide:
e Developers working with development and customization of EPiServer Commerce sites.
e System architects and others with an interest in the technical features of EPiServer Com-
merce.

This documentation describes features in EPiServer Commerce. The following documentation accessible
from world.episerver.com, may be of use for reference purposes:

User documentation for editors of EPiServer CMS.

User documentation for administrators of EPiServer CMS.
User documentation for EPiServer OnlineCenter.

SDK for EPiServer CMS and the EPiServer Framework.

Online Community on EPiServer World

EPiServer World is an online community where you can find the latest product information. Itis open to
the public, for partners, customers, and everyone working with EPiServer products, such as editors, web-
masters, site owners and developers. Here you can download material, participate in discussions, read
articles, receive support and much more. Feel free to sign up as a member.

Copyright Notice
Copyright © 1996 — 2011 EPiServer AB. All rights reserved.

Changes to the contents, or partial copying of the contents, may not be done without permission. The doc-
ument may be freely distributed in its entirety, either digitally or in printed format, to all users of EPiServer
Software. We assume no liability or responsibility for any errors or omissions in the content of this doc-
ument. We reserve the right to alter functionality and technical system requirements. EPiServer is a reg-
istered trademark of EPiServer AB.

© EPiServer AB
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The EPiServer Commerce Platform

EPiServer Commerce comes with a sample site including a complete set of page templates containing all
the necessary functions for setting up a website with an online store. The purpose with the sample site is
to exemplify and illustrate the code behind the templates, and to provide inspiration when building your
own e-commerce solution.

The Commerce Manager module is closely integrated with EPiServer CMS. Editors and store admin-
istrators can work with the content as well as managing the online store administration using the same
interface for easy access. The EPiServer OnlineCenter provides the overall frame for accessing the
entire website and other systems integrated, as well as the personalized dashboard with gadgets for
individual users.

Overview

The foundation of the EPiServer Commerce platform is EPiServer CMS for presentation, and the Com-
merce Manager module for web store management with functionality for managing customers, products
and orders. Customers can register an account on the website and manage their account details, as well
as create their own personal wish lists. When a shopper is ready to finalize a purchase, the Commerce
Manager will provide functionality for handling the checkout procedure with shipping and payment
options and order confirmation.
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Functions and Page Templates

The functionality of an EPiServer CMS website is controlled by page templates. These are linked to page
types, in which the editor enters the content of the web page. The functionality in the page template
decides what will happen with the content and how it will be displayed. With the use of customized page
templates the various products and shopping activities can be displayed on the website, with information
collected from the Commerce Manager module.

© EPiServer AB
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Access Rights

Access rights control what editors and administrators can do and what visitors to the website can see.
Access rights in EPiServer Commerce can be managed from the EPiServer CMS Admin and Edit mode,
as well as from the Commerce Manager administration interface, depending on type of role and per-
missions.

Editorial Content

Editors enter information into the page types, and the information is then stored in the EPiServer data-
base. Generally the EPiServer Commerce specific sample templates contain few editor fields, since they
are only used for display, and most of the functionality is built into the page templates.

Store Administration

The online store is administered through the Commerce Manager user interface. Store administrators can
easily access all the online store functions including customer, product and order management, as well
as system configuration features. The Commerce Manager information is stored in the Commerce data-
base.

Terminology

In this section we will describe some of the specific terms used in e-commerce and EPiServer Commerce.

Editorial Content

With editorial content we mean content that is created from inside the EPiServer CMS Edit mode, such as
articles, news or other information pages. Compare this to content thatis displayed as pages on the web-
site, but where the content itself is data fetched from Commerce Manager. This type of data cannot be
only be edited in Commerce Manager.

Modes

You will work with EPiServer Commerce in different modes.

View mode

What will be displayed to visitors of the website.

Edit mode

Editors will work in the EPiServer CMS edit mode when creating and editing EPiServer CMS content
pages of the website.

Admin mode

System administrators will work in the EPiServer CMS administration mode to modify system settings and
access rights.

Commerce Manager interface

Store administrators will access the Commerce Manager interface to manage online store data and activ-
ities. The Commerce Manager interface can be reached either from inside the EPiServer OnlineCenter, or
directly from View mode when right-clicking in a page.

Roles

EPiServer Commerce has a number of different roles that are active in the editorial and online store man-
agement activities. These are described further in the following.

© EPiServer AB
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Visitor

A visitor is someone using a web browser to visit the website and use available functions and services. A
visitor can register an account and become a customer when purchasing a product. Customers can
update information related to their personal account. In EPiServer Commerce, visitors use the same login
procedure to the website as site administrators, without getting access to the back-end functions.

Editor

The editor will work with website content from the EPiServer CMS Edit mode. Working with content here
means create editorial content such as news, company related information, or articles on different sub-
jects.

Store Administrator

The store administrator works in the Commerce Manager interface, with information related to customers,
orders and products. Store administrators may also work with configuration of the Commerce Manager
system settings.

System Administrator

The system administrator works with the administration of the entire EPiServer Commerce platform. This
is done from the EPiServer CMS administration mode and involves setting access rights for pages, web-
site language management and other tasks.

Commerce Manager roles

The Commerce Manager module has its own set of user roles covering the different tasks that store
administrators work with. These roles are described further in the Commerce Manager section under Cus-
tomer Management.

Commerce Manager Glossary
Application Configuration

e Shipping Gateways - Under Shipping Providers, a shipping gateway is the specific class that you
select (Generic Gateway or Weight/Jurisdiction Gateway).

e Shipping Jurisdictions - an option which allows you to define values for region-specific shipping
rates; this is only used when you select the Weight/Jurisdiction Gateway (i.e. California).

e Shipping Jurisdiction Groups - group of jurisdictions; this is required because this is a required
field when configuring the Shipping Method parameters (i.e. Southwest region).

e Shipping Method - A shipping method manages a set of information and rules that determines the
shipping cost and displays it on the front-end public site while a customer checks out an item from
his/her shopping basket. The shipping fee is added to the total price of the purchase. A shipping
method is mapped to a shipping provider visible to a back-end administrator in Commerce Man-
ager. This allows the public site to display friendly names such as "Ground Shipping" to the cus-
tomer and this is mapped to a provider such as UPS. Therefore, when a customer picks "Ground
Shipping," he/she will be using UPS.

e Shipping Providers - A shipping provider is the class(es) that interacts directly with one or more
actual shipping services such as USPS, UPS, or FedEX. It retrieves shipping price information
from the shipping service(s) its associated with. One typical scenario would be to have a provider
that represents a particular service (e.g. USPS). A provider can also represent a particular type of
shipping situation. One example is that you could have a provider for overnight delivery. The pro-
vider could retrieve pricing for that service to determine the lowest price given the location of the
customer. A provider could also represent other specific scenarios with one or more services such
as price by weight or ground shipping.

Business Foundation

e Business Foundation Object (BF Object) - Similar to a meta class; allows end users to create cus-
tom objects with Ul presentation, business objects, and a database layer without modify code.
e Bridge - A "many to many" or N:N relationship between two business objects.
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Extension - this allows you to extend an existing meta class with extra properties. For example,
you can have a download class and you can extend it with "imagedownload" which contains width
and height as extra parameters.
Field Type - The type of data that the data field supports. There are multiple types included with
Commerce Manager out of the box:
Boolean
Currency
DateTime
Dictionary items
File
Guid
Integer
Referenced Field (read-only)

e String
1 to Many Relationship - 1 object can be associated or related with multiple object-related data.
For example, one organization can be associated with multiple contracts.
Many to 1 Relationship - Multiple object-related data can be associated or related with a single
object. For example, multiple contacts can be related to a single organization.
Many to Many Relationship - Multiple object-related data can be associated or related with mul-
tiple objects. For example, different SKUs (Store Keeping Unit) can be associated with one or
more Warehouses for tracking and storage.

Catalog Management

Assets - downloadable contents such as documents, links, videos, and images that can be linked
to specific products.

Associations - one or more products can be related to or associated to another product so that
these associated products can be displayed or advertised on the public site as a product acces-
sory, or as an upselling/cross-selling item. Associations can be made from any of the individual
products (Product Entries, SKUs, Bundles, Packages, and Dynamic Packages).

Catalog - a catalog is a top-level container for all catalog entries such as Categories, Products
and SKUs.

Category - a category is a grouping of purchasable products.

Node - a node is the same thing as a category.

e Product - a product represents various forms of merchandise that you can display and pur-
chase from the public site, including Products, Variations/SKUs, Bundles, Packages and
Dynamic Packages.

e Product Entry - a product entry typically contains a product name, part number, descrip-
tion and images.

e Variation/SKU - a variation or SKU (Store Keeping Unit) corresponds to a specific type of
product with specific characteristics. For example, a product of Shirts will have an individ-
ual variation/SKU which includes size, color and sleeve length.

e Bundle - a bundle is a collection of variations and SKUs allowing customers to purchase
two or more items at once.

e Package - a package is comparable to an individual SKU because the package item must
be purchased as a whole (i.e. computer system).

¢ Dynamic Package - a dynamic package is similar to the package definition above with the
added ability to configure the package during checkout.

Tax Category - this separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for "General Sales"
items and another rate for "Luxury Sales" items.

Customer Management

Account - a user account that can be created under a Contact. Once an Account has been
created, the Contact can be assigned Roles and access the Commerce Manager. A user account
is automatically created for a user who registers from the front-end public website which allows a
customer to login prior to checking out. They default to the "Everyone" and "Registered"” roles and
permissions.

Contacts - these are users that are created either when an external customer registers on the pub-
lic site orwhen a Commerce Manager admin creates them directly from the Commerce Manager;
typically, users that are internal to your organization are assigned to organizations or organization
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units and assigned varying permissions based on role. By default, new users that are created by
registering from the public site are given the "Registered" and "Everyone" roles.

e Organizations (or organization units) - groups or sub-groups of registered users and customers.
An organizational unitis a "child" or subsidiary of a "parent" organization. Within Commerce Man-
ager, you can assign an organization as a parent of another organization. For example, the parent
company Company X, and the organizational units are Company X West and Company X East.
Organization units include regional branches or departments or you could name them by busi-
ness categories such as "Computer and Electronics" or "Clothing and Accessories." Organizations
can be structured into a tree structure with sub-units with different levels of permissions assigned
to each. So for example, you can set up your company as a parent level organization while your
departments such as Sales & Marketing, IT/Development, and Operations as organization units.
With this scenario, you can allow users in each departments to have access to only relevant sub-
systems, screens and functionality within Commerce Manager.

¢ Roles - these control the level of access privileges of each user accountin Commerce Manager.
Users can be either granted or restricted access to an entire subsystem or a particular menu item
within a subsystem based on the role assigned to them. Different roles may be added to user
accounts (i.g., store operator or webmaster) so that they can access, edit, or process relevant infor-
mation. By default, a customer who registered his/her account to make a purchase in the front-end
site will have no roles assigned to them, hence giving him/her preventing access to both the edit-
ing feature of the front-end site as well as the back-end Commerce Manager.

Marketing

e Campaigns - a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied to Cus-
tomer Segments for targeted marketing purposes.

e For example, you can create a seasonal campaign that will include different Promotions tar-
geted for the Spring season.

e Customer Segments - these determine the target audience for the Promotions. Customer Seg-
ments determine the target audience for the Promotions. Within a Campaign, all Promotions will
be applied to whatever Customer Segments associated with the same Campaign. Members of the
Customer Segments can be pre-defined in static groups or you can use the Expressions Engine to
create dynamic groups whenever Promotions are run.

e Forexample, you can have a Customer Segment that targets all users from the Los
Angeles area. You can create an Expression that will include all the customers whose
home city is Los Angeles. Thus, when a user registers on the site he immediately becomes
part of the target Customer Segment.

o Expressions - these are customizable Conditions which allow users to extend different aspects of
the Marketing system -- Promotions, Customer Segments and Policies all rely on Expressions.
There is an Expressions Engine which is a core technology behind the Marketing system.

e Forexample, you want to set a Promotion for "40% off Item X." The Expression or Con-
dition to enable this Promotion would include: Catalog ID for ltem X and Reward of 40%.

e Policies - rules that are always executed when Promotions are applied. This allows a Marketing
manager to declare rules just once for the whole site.

e An example of a rule is as follows: Do not allow negative orders.

e Promotions - a way to apply various discounts to the products, order totals or shipping. A Pro-
motion is a marketing tool used to increase sales of certain products or product lines. Various
incentives such as lowered pricing and other discounts can be employed as part of a Promotion.

e Promotions are always tied to Campaigns.

e Promotions can be classified into two types: 1) either you can create a Promotion that is vis-
ible prior to checkout or 2) you can configure the Promotion to be displayed during the
checkout process.

e The most powerful aspect of the Marketing system is the Expression Engine which allows
variable conditions to be applied when creating a Promotion. These conditions vary from
the number of items, the percentage discount, shipping rates and many others.

Order Management

e Browsing and Creating Purchase Orders
e Purchase Orders - the manual method of generating an order for a customer (rather than
having the customer checkout and complete an order from the front-end website). It allows
Commerce Manager users to generate orders directly from the Commerce Manager.
e Status - setto "NewOrder," "Submitted," "Processing," "Canceled," "Rejected," "Shipped".
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Currency - select a Currency type from the drop-down menu.
Customer - select a Customer from the drop-down list of Contacts.
Billing Address - select a Billing Address from the drop-down menu.
Affiliate - select an Affiliate from the drop-down list. (Affiliates can be used when inte-
grating with other systems and can only be edited in the database. Users do not have Com-
merce Manager access for managing Affiliates).
Tracking Number - enter in a Tracking Number of the shipment.
e Expiration Date - enter in an Expiration Date for the order if this order is tied to a recurring
payment plan for subscription-based transactions.
e Parent Order Id - this can be used to relate Purchase Orders to a payment plan or other
order. When creating a Purchase Order from a Recurring Payment Plan, the Parent Order
ID is automatically associated with the Payment Plan ID.
e Line ltems - you can associate actual Products/SKUs/Packages/Bundles to orders or Pur-
chase Orders.
e ID -itis automatically generated.
Display Name - this can be edited and changed.
List Price - enter in the price that will appear for the item.
Discount - enter is the Discount value that will subtract from the List Price.
Shipping Address - This is automatically generated if a Shipping Address has
already been associated with the Purchase Order.
e Shipping Method - This is automatically generated if a Shipping Address has
already been associated with the Purchase Order.
e Creating a Recurring Payment Plan
e Recurring Payment Plans - payments that are initiated by the Commerce Manager on a
regular cycle (i.e. applicable in a subscription-based scenario).
e Plan Cycle - this determines the period of time that a payment plan will be initiated.
Options include: "No Cycle," "Daily Cycle," "Weekly Cycle," "Monthly Cycle," "Yearly Cycle."
Cycle Length - Unit of the PlanCycle.
Max Cycle - the maximum number of cycles that this payment plan will be initiated.
e Completed Cycles - this value displays the number of times that this payment plan has
been initiated.

Reporting

o Best Sellers Report this reportis used to determine which products sold the most in terms of
quantity and total revenue over a period of time.

e Low Stock Report - this report is used to determine which products are running low in inventory. If
a product's inventory is less than its reorder minimum quantity, it will be included in this report.

e Sales Report - this report provides an overview of a site's sales performance over a period of

time.
o Shipping Report - this report provides the shipping method, number of orders and total shipping
cost over a period of time.

Prerequisites

This documentation is intended for website editors, and store and system administrators. The doc-
umentation describes a sample installation based on EPiServer CMS and the sample template package
of EPiServer Commerce. Please be aware that your specific system may differ from what is described
here, since your website is most likely customized and may be integrated with additional products.

O In order for EPiServer Commerce to work properly, it is essential that you are using the specific
language culture setting "Ul Culture" (ASP.NET) on your website (i.e. "en-US", e"en-GB", "nl-
BE" etc.). This is crucial in order for the different languages to display correctly on the site.
Make sure this is set up correctly from the start to avoid problems later on. Find out more about
this topic in the Globalization section.

In this documentation you will learn about specific functions and features of the EPiServer Commerce
sample site and templates. Prior knowledge of EPiServer CMS and e-commerce procedures is required
to fully understand what is described. To find out more about other EPiServer products such as EPiServer
CMS, please refer to the documentation for each specific product available on world.episerver.com.
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Getting Started

In the following sections we will describe how you can access, log on to and navigate an EPiServer Com-
merce website. Note that the logon procedures may be slightly different from what is described here,
depending on how your website and infrastructure is set up.

Logging on to the Website

To access the website, open a web browser and enter the address of the website. Most often, Commerce
Manager is accessed through the front-end of the EPiServer CMS site. There are different ways of logging
on as an editor or administrator of an EPiServer Commerce site. Often you add a path such as "epi/ui/edit"
or "epi/ui/fadmin” to the URL of your website, or there might be a login link as for the EPiServer Commerce
sample site.

On the EPiServer Commerce sample site, clicking on Log in in the top menu will take you to the login
page of the website. Enter your user name and password, and click Log In. Note that this login page is the
same for both customers logging on to their account, as well as for web editors and store administrators
logging on to work with content or administer the online store parts. What you are allowed to do after log-
ging on to the website depends on your access rights.

Login My Account My Cart Wish List English {United States) ¥ US dollar ¥

o CLICK+TA|_K Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Login

Login or Create an Account

Existing customers log in New Customers
Please type your user name and password to login. This will allow you to review your By creating an account with our store, you will be able to move through the checkout
previous orders and access certain other pages. If you do not have an account yet, process faster, store multiple shipping addresses, view and track your orders in your
create a new one by clicking create new account. account and more. =
User Name /Email.  Mary Smith (=] Create a New Account
Password: sssssss @
Y] Remember me nexttime

Forgot your password?

Buyers guide Aboutus Our Services Customer Service Support
Didigtal cameras History How lo place an order? New Customer? Download
lMobile Phones Our success Your payment methods Register Help
Site Map Contact Terms and Conditions Forgotten your password
Press Order tracking

Guarantee

Affiliate Program
Join our program

Copyright @ 2010 EPiServer AB

Accessing the Different Modes

When you are logged on to your EPiServer Commerce website, right-clicking on a page will display a
menu with a number of options. What you see here depends on your access rights, here we assume that
you have full permission to the different parts.

From the EPiServer right-click menu you can directly access the Commerce Manager module of EPiS-
erver Commerce. Choosing this option will take you directly to the Commerce Manager administration
interface. Selecting the Edit or Admin mode will take you to the EPiServer CMS editor or administration
interface. If you select Dashboard you will be taken to the Dashboard of the EPiServer OnlineCenter.
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« Cn-page Edit

=
®

‘ New Page

B Quick-edit

EJ Dashboard

I® Edit Mode

B admin Mode

ﬁ Commerce Manager
o Visitor Groups

& Print

Refresh

E

Dizable Menu

For the other options available, please refer to the EPiServer CMS user documentation.

Logging on to Commerce Manager

You can access Commerce Manager through right-clicking in View mode after logging in to the website,
and then select Commerce Manager in the right-click menu. You can also select Commerce in the top
menu when you are in the EPiServer Online Center or from the EPiServer CMS Edit mode.

O You may be required to provide your logon credentials once more when accessing the Com-
merce Manager module. When you log on you will be taken to the Commerce Manager Dash-
board Home page.

Navigation

EPiServer Commerce has an intuitive navigation. When logged on to EPiServer Commerce, use the right-
click menu to go directly to the Commerce Manager interface to work with web store back-end pro-
cedures. Or, choose the EPiServer CMS Edit or Admin mode to work with content management or sys-
tem administrative tasks. See also Accessing the different modes .

Navigating Commerce Manager

Once you firstlogin to Commerce Manager, you are directed to the Dashboard homepage.

e The Dashboard has Controls showing various information, including Alerts, News & Announce-
ments, Help, and a Summary.
e More Controls can be added by clicking on Add.
e On the leftis the Left Menu or Navigation iframe where users can switch between Commerce Man-
ager systems and navigate a folder trees of options.
e On the top-right, you can see your login name, product version, and installed license.
By clicking on the top-left header, you will be directed back to the front-end site.
On the menu bar below header, there are additional options available to the user.
e By clicking Welcome, you can adjust your Settings, Sign In As a Different User, or Sign
Out of Commerce Manager. You can also change the language used to a different one if
your Commerce Manager is configured for multiple languages.
e By clicking About, you can Send Feedback using a form, get information on the Database
Schema for support purposes, and open up our Online Help repository.
e On the right side of the menu bar, you can click on Get Help For this Page to gethelp on a
specific page you are in, such as the Catalog Edit page under Catalog Management.
e Rightnextto the Get Help For This Page button is an Up-Down Arrow, which allows you to hide
or unhide the header above the menu bar to save screen space.
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Start CMS Commerce EPISERVER @ ? ~ L admin~ Q
Commerce Manager Settings
. .
EPISERVER COMMERCE Dashboard Home ersion. 5.2 (build: 91)
License: ECF G5 Deplayment (EpiServer)
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ﬁ Customer Management
Help will appear in a separate window.

==

Catalog Management Find answers ta questions about Commerce Manager containin =
the terms

nﬁ Order Management Search Help

) Examples: Campaigns and Promotions
E Marketing a. How do | Create a Discount Promation?
= b. How do | Create a New Product?
zﬂ Asset Management C. Where is the release history?
fl Reporting

m Administration i

Other Basic Ul and Navigation Elements

e The Dashboard Controls can be collapsed, rearranged, and closed by clicking on the Arrow but-
ton, clicking on the X button, and click-dragging the title bar, respectively.

e There are tabs below the left navigation frame that corresponding to a specific system of the Com-
merce Manager. Clicking on each button results in a change of the top side menu.

e A common navigational model is the hierarchical folder/node structure.

e Some systems, such as Customer Management, do not have collapsible nodes. Instead, you click
directly on the menu options to access its contents.

Working Procedures

There are many different types of e-commerce websites, however the two most common ones are:

e Business-to-Consumer (B2C) - typically designed for selling goods and services to consumers.
e Business-to-Business (B2B) - used to build strategic relationships with other businesses, and to
ease the supply and procurement processes that characterize trade among those organizations.

Sites can also have multiple roles, and a single EPiServer Commerce site can provide several functions.

Working with EPiServer Commerce involves various tasks and roles using different parts of the system. In
the following we will describe the tasks involved when working with the different parts of EPiServer Com-
merce:

e EPiServer OnlineCenter - for monitoring website activities.
e EPiServer CMS - for managing and displaying content on the website.
e Commerce Manager - for administration of back-end online store tasks.

Depending on how you choose to work with editorial content and your online store administration, you
will define your user roles and groups, and give them access rights to the different parts.Example of user
roles in EPiServer Commerce are content editors, marketers, business owners, and store and system
administrators.

EPiServer OnlineCenter

All users of EPiServer CMS and Commerce Manager, including business and website owners, can use
EPiServer OnlineCenter to get an overview of the website and activities of interest. Through the usage of
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customized gadgets on the personalized dashboard, you can create your own website workspace. The
OnlineCenter also has a global search function where you can search for topics in both pages and files
on the entire website.

EPiServer CMS

In EPiServer CMS you will work with your editorial content, just as you would with any website. The dif-
ferent tasks are done in the EPiServer CMS Edit and Admin modes.

Edit mode

Web editors will work inside the EPiServer CMS editorial interface to update content of web pages. Per-
haps you want to create news or article content related to the products in your online store. This is most
typically done by web editors creating EPiServer CMS pages.The EPiServer Commerce page types in the
sample site do not require much editorial work, since most of these are only for display purposes fetching
data from elsewhere. Some editorial efforts are often needed on content pages such as news listings, pri-
vacy and shopping policies and similar.

Admin mode

The EPiServer administration interface is where you will manage the administrative tasks for the website.
These may involve setting access rights for EPiServer CMS web pages in the page tree structure, con-
figuration of page types, management of scheduled jobs, and globalization settings.

Commerce Manager

This section describes the most common tasks for users including business managers, marketing staff, Ul
staff and IT professionals. For your convenience, these tasks have been categorized by functional area.

System Administration and Configuration

System Administration includes various configuration tasks such as setting up shipping and payment gate-
ways, your default language, currency, units, tax configuration, licensing, and search settings.

e System Administration
Administrative Users and Customers

Users and customers are managed by the Customer Management system. Users are internal to your
organization and should not be confused with customers, partners and organizations. Generally, only
your team of internal users will have access to the Commerce Manager and depending on their per-
missions will have varying access to the systems and menu items within each system.

e Customer Management
Catalogs and Product Entries

An Commerce Manager front-end site allows customers to shop for products. Products are arranged into
a particular catalog. Catalogs are independent from one another and you may create as many catalogs
as you need. Catalogs can be structured in a number of ways and organized into Categories, Products,
SKUs, Bundles, Packages and Dynamic Packages.

The Catalog Management system provides users with the ability to manage catalogs, product categories
and products. A default B2C Sample Site along with a default electronics catalog (consisting of a Brands
catalog + Everything catalog) is included giving you a running demo site after you run the installer.

e Catalog Management
Purchase Orders, Shopping Carts, Shipping, and Returns/Exchanges

The Order Management system is where you can monitor, track, change or create new orders, ship out
items, and create returns/exchanges. Orders are highly flexible, giving internal Commerce Manager users
the ability to create Purchase Orders with various options including split payments, split shipping, and
split shipping addresses.
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e Order Management
Customer Campaigns, Promotions, and Discounts

One area handled by the Marketing system is promotions. A Promotion is a marketing tool used to
increase sales of certain products or product lines. Various incentives such as lowered pricing and other
discounts can be employed as part of a promotion.

Promotions can be classified into two types: either you can create a promotion that is visible prior to check-
out or you can configure the promotion to be displayed during the checkout process. The most powerful
aspect of the Marketing system is the Workflow Engine which allows variable conditions to be applied
when creating a Promotion. These conditions vary from the number of items, the percentage discount,
shipping rates and many others.

Creating custom promotions is incredibly powerful; users have many ways in which to configure pro-
motions based on their needs.

Marketing teams also have the ability to target specific customer segments by region, individual cus-
tomers or customer groups.

o Marketing
Assets and Web Files

The Asset Management system allows for Assets including images, mp3s, pdfs, software packages and
other downloadable files to be centrally stored, displayed on either the public site or the Commerce Man-
ager site and ultimately to be shared or purchased.

e Asset Management
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User Access and Roles

By default, EPiServer Commerce uses a customized role and membership provider where groups and
users are stored in the Commerce Manager database. The information is then shared between EPiServer
CMS and Commerce Manager. This means that the same users and groups will be available both from
the EPiServer CMS Admin mode as well as from Commerce Manager under Customer Management.
Both website administrators and customers registering on the e-commerce site will managed by the same
provider and the user account information will be saved in the same place.

Most of the user and group/role management for the e-commerce part will be done from Commerce Man-
ager. This includes managing user accounts and adding roles to users (contacts). When you need to set

access rights for editorial content management in the page tree of the website, this will be done from the

EPiServer CMS Admin mode.

The EPiServer Commerce sample site has a number of predefined users and groups (roles), both for man-
aging editorial content as well as for administering the e-commerce tasks. Remember that these users
and groups are only examples of how you can set up access rights for your website.

User Access from Commerce Manager

Managing users and roles for store administrators is done from Commerce Manager under the Customer
Management sub-system. EPiServer Commerce is built with flexibility in mind for structuring internal
teams and departments as well as external organizations, partners and customers. The Customer Man-
agement system allows for creating users and groups with either pre-configured Roles or custom Roles
which control access to different systems or individual elements within a system.

When you install EPiServer Commerce, you are provided with an administration account. This account
is given full privileges, meaning itis full access to all systems and all elements within each system. Addi-
tional accounts used by your internal team to access Commerce Manager must have one or more Roles
assigned to them. A role can be for instance "Catalog Viewers", "Marketing Admins" or "Asset Managers".

O Commerce Manager users are internal to your organization and should not be confused with
customers. By default, customers who register from your public site are given the "Everyone"
and "Registered" Roles, but these roles do not allow access to Commerce Manager.

A standard installation of the EPiServer Commerce sample site has a number of predefined roles. These
roles are based on common e-commerce working procedures and provides a suggestion to how you can
work with the system.
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Each role is associated with a range of permissions on different levels, related to the various parts of the
Commerce Manager system.

The following roles are available by default, with a set of permissions for each role:

Admins - default role allowing to fully administer most areas of the Commerce Manager.

Order Managers - this role can create returns and exchanges, view and edit orders, send noti-
fications, process payments and split shipments. You can also allow order managers to manage
discounts and/or change the line item price.

e Order Supervisors - this role has full permissions for the entire order management procedure,

including the entire Order Managers permissions.

Shipping Manager - this role allows for viewing, packing and completing shipments.

Receiving Manager - this role can view shipments and receive returns.

Everyone - assigned when a customer registers an account from the front-end public site.

Registered - assigned when you register from an Account from the front-end public site.

Management Users - this role allows users access to Commerce Manager.

Administrators - this role has extensive administration rights in areas such as assets, catalogs,

core functions, marketing and customer and order management.

e WebAdmins - this role is EPiServer CMS specific and provides access to the EPiServer CMS
administration interface, needed when administering the content management parts of EPiServer
Commerce.

e WebEditors - this role is EPiServer CMS specific and provides access to the EPiServer CMS edit-
ing interface, needed when working with content on the EPiServer Commerce website.

You can change the detailed permissions for each of these roles, as well as define your own roles and
set permissions, all in order to match the specific working procedures in your organization.

User Access from EPiServer CMS

You will need to access the EPiServer CMS Admin mode to manage access rights for content editors. In
the EPiServer CMS Admin mode, you will be able to view all users and user groups under Search
User/Groups.

Setting access rights for editorial content and the page tree structure is done from the Set access rights
section, just as you normally do in EPiServer CMS.

In EPiServer CMS, there are the following default roles:
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e Everyone - an anonymous visitor browsing to your website. Can only access the View mode of
the website.

e WebAdmins - membership in this group provides access to the EPiServer CMS administration
interface.

e WebEditors - membership in this group provides access to the EPiServer CMS editing interface.

Please refer to the EPiServer CMS administration documentation on world.episerver.com, for more infor-
mation on how to work with access rights for editorial content.

[ s ETERN Commerce EPISERVER & ? - L admin- Q
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Admin || Config || Page Type
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Delete Unused Files
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Experne & Shiping Manager CMSRoleProvider
Import Data
File Management m WebAdmins CMSRoleProvider
Content Channels ‘ 5
Workflows m WebEditors CMSRoleProvider
1

Product licensed to EPiServer AB Dung Le

As with any EPiServer CMS website, you can work with role and membership providers from Windows or
SQL, or both using the multiplexing setting. You can also build your own user and membership provider
to be used with EPiServer Commerce. Find out more about membership and role provide managementin
the documentation for EPiServer CMS on world.episerver.com.

© EPiServer AB



30 | User Guide for EPiServer Commerce 1 R2

Globalization

With "globalization" we mean the possibility to display content in different languages to website visitor
groups with different language preferences. When a visitor to the website selects a language option, the
content for thatlanguage will be displayed. If content doesn't existin a selected language, a fallback pro-
cedure may be applied if this has been configured. Another dimension of globalization is the possibility
for users to select different language options for the user interface inside EPiServer Commerce.

Find out more about globalization and language managementin general on a website in the doc-
umentation for EPiServer CMS on world.episerver.com. In this section we will describe in more detail how
you work with the different language settings in EPiServer Commerce.

Working With Language Settings

Specific Language Settings

In EPiServer CMS there are three different language concepts, two which are defined by ASP.NET (Cul-
ture and Ul Culture), and one which is the EPiServer contentlanguage. The ASP.NET Culture is referred
to as "System Language", and Ul Culture as "User Interface Language". A typical culture is "en-US" which
defines the language as English (en) with the culturally defined specifics for United States (US).

O In EPiServer Commerce, "Ul Culture" is used and "English (United States)" is the default lan-
guage used by the system. This is due to the Commerce Manager database which uses "UlI
culture" in the matching. In order for EPiServer Commerce to work properly, it is therefore
essential that you are using the "Ul Culture" setting on your website to make the different lan-
guages display correctly.

Make sure this is set up right from the start to avoid problems later on. Itis recommended that only
"Ul Culture" languages, i.e. "en-US", "en-GB", "nl-BE" efc., are enabled on the website.

Content Language

To display contentin the desired language on your EPiServer Commerce website, you may apply the lan-
guage management options available in EPiServer CMS Edit mode, to create pages in different lan-
guages. Available languages for CMS pages are enabled from the EPiServer CMS Admin mode under
Config and Manage Website Languages. For more detailed information on how the language settings
work, please refer to the user documentation for EPiServer CMS.
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m [e" N Commerce EPISERVER @ ? » A admin> Q

Edit Mode Admin Mode Reports

Admin || Config || Page Type .
Manage Website Languages @
¥ System Configuration
System Settings Define the languages that should be available to visitors on your website.
Site Information
Edit Frames 5 Add Language
DR W ey Move Up | Move Down | Name Language Code | Enabled | System lcon | Template Icon
R te Websit
emote HEbsites B English en v = =
¥ Security - : - —
S it 3 English (United Kingdom) ~ en-GB 55 55
¥ Tool Settings Iy 3 English (New Zealand) en-NZ = =]
Plug-in Manager 4 5 English (South Africa) en-ZA =} =}
ginnge g & o Deutsch de = =
Rebuild Name for Web Addresses
Wiaries 4t 5 francais fr (] ]
Register Web Parts & L espafiol es = =
Search Configuration
@ 3 svenska sv v H
4 3 norsk no =
& o dansk da = =
4 i suomi fi += =
it 3 Nederlands nl = =
Pi a5 Nederlands (Belgig) nl-BE [0 ] (]
4t i Portugués (Brasil) pt-BR
@ 5 English (United States) en-Us v = =
iy 5 Deutsch (Deutschland) de-DE ¥4 =
@ espariol (Espafia) es-ES v =

Languages for Product Catalogs

For products in the product catalog, the language information is setin the product database. EPiServer
Commerce will display the product information in the language selected by the website visitor. Lan-
guages for the content of a product catalog is set when you create the product catalog. Find out more
about this under Create a Catalog in the Catalog Management section.

User Interface Language

To set the user interface language from EPiServer CMS, click your user profile name in the upper right
corner. Select My Settings and then the Display Options tab. Select the language of your choice in the
list, and click Save. Note that you may need to refresh the browser window for the changes to apply.
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Start CMs Commerce EPISERVER & 7 ~ m Q

v EFiServer CMS
My Settings
Components
Microsoft Office Add-In

My Settings @

User Information || Display Options

Language Settings

Personal Language Use system language

Use system language
dansk

Symbols in the tree peyesch

Use default settin espafiol
frangais
ssi|Nederlands
_|norsk

~ |Portugués
“suomi
svenska

" |A#EE (Japanese)
'|English (United States)

| shEzishds A BAA0E]) (Chinese (People's Republic of China))

1

Save

To set the user interface language from Commerce Manager, select Change Language in the upper
menu of Commerce Manager. Choose the language of your choice in the list and click OK to save you

changes.

Start CMs

Commerce Manager Settings

EPISERVER COMMERCE

Dashboard Home

EPISERVER © 7?7 -~

L admin v O.

zome, admin

Version: 5.1 (buil

Welcome ¥ Change Lﬁ:\guage About ¥

License: ECF G5 D

@ Cet Help For This Page %

e 2

Dashboard

73 Home

= v PO

Performance

-

- X —

db Products: 1319 O Categories: 64
£ orders: 7 &1 customers: 4
“2 promotions: 1

Help - X

Help will appear in a separate window.

Find answers to questions about Commerce Manager

containing the terms...
Search Help

Examples: Campaigns and Promotions

a. How do | Create a Discount Promation?
b. How do | Create a New Product?

c. Where is the release history?

ﬁ Dashboard

Add

Customer Management

Catalog Management

Order Management

Marketing

I
m
4

Asset Management

Reporting

Administration

(@

Sales Graph

no sales data available

Total Sales (this year)

m

no sales data available
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File Management

In EPiServer Commerce, there are two places to store content files (assets):

e In the File Manager of EPiServer CMS.
e Inthe Asset Management sub-system of Commerce Manager in EPiServer Commerce.

However, files can be managed entirely from the File Manager in EPiServer CMS. Using the Virtual Path
Provider (VPP) technique, the two storage areas are "synchronized" meaning that when you create fold-
ers and add files in one place, the same content will be available in the other location. Assets can be
created, updated, moved and deleted from the File Manager, and changes will be reflected in the Asset
Manager as well.

When installing the EPiServer Commerce sample site, the Asset Management sub-systemwill be auto-
matically configured and available in the File Manager as the Commerce Assets starting point. In the fol-
lowing we will briefly describe how files are managed in EPiServer Commerce.

Working With File Management
Woorking with the File Manager

Files such as images and documents, that are used in the editorial parts of the sample website, are stored
in the File Manager of EPiServer CMS, just as for any other EPiServer CMS site. With editorial content, we
hereby mean web pages with content that is created from the EPiServer CMS Edit mode. For instance,
this could be a news section with news items, or articles related to products on the e-commerce website.

The Asset Manager sub-system is made available in the File Manager of the sample site as the Com-
merce Assets starting point, making it possible to work with all files on the website in one place.

cMs o EPISERVER @ 7 + AL Adminv Q
Edit Mode Admin Mode Reports  Visitor Groups
0O % 4 B > & | @ @ @ B & B
e Action Window Hide
Structure Search page T
s = | Page Type: [Commerce] Search Status{ 5 English (United States) Folders 4 | (] Commerce Assets
Affilate Program Published Version Compare With
- [d Page Files Path: Commerce Assets
B My Account (3 J Preview || £di || Versions || Workflow | SEErpRS 4 %
- My Account A \Welcome. admint Log, ™ | || Global Files [7] Shaw thumbnails
[ e (4 Documents Name size Modified
[ e (] Dowrloads
© CLICK+TALK Jlgcmmes | G
| Lagini lassets d

|- Register : || My Favorites A

H (1] software
Mscarch page B Digital Cameras Camera Accessories Add folder ] specifications

- Payment[]] favorites using ] User Guid
the right-click €] user Guides
{- Forgot Password [} Start - Search page menu for any of LlVidEu

m

- Product Page [ the folders in the
list to the right
f- Compare products[ ]
L Paypal |
Search result
B3 [Resources] i -
Sarry, no matching results for
Please check your spelling or search for a different keyword
Show Page Tree: 2
5 English (United States) | v « 1L v

You work with folders and files in the Commerce Assets folder structure just as you do with other parts of
the File Manager. You can copy and move folders from Commerce Assets to other starting points such as
Global Files. However you cannot move or copy folders and files from other starting points to Commerce
Assets, since versioning is not supported. Also, metadata is not supported for the files under Commerce
Assets structure, so these fields need not to be filled in when adding new files to the structure.

To find out more about general file managementin EPiServer CMS, please refer to the EPiServer CMS
user documentation.

Woorking with the Asset Manager

Files can also be managed from the Asset Management sub-system in Commerce Manager. The Asset
Manager folder structure can be used for storing documents related to products in the product catalog.
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This can be for instance user guides, software downloads or product sheets. Each asset file can then be
related to a productin the product catalog.

Start CMs Commerce EPISERVER @ ? ~ L admin~ Q

Commerce Manager Seutings

[Z] Specifications
(Z] Software

[ Downloads
[~ User Guides
[Images

EP'SERVER COMMERCE Asset List fon: 5.2 (build: 204)
G5 Deployment (EpiServer)
Welcome ™ Change Language About €/ Get Help For This Page %
Asset Management & ‘D Create NEW" Zi More Actions*
=13 Reot [ 4 New Folder Size Created
[ Video [ NewFile
[ Presentations |D Upload Multiple Filgs |
A A

.ﬁ Dashboard

Ig Customer Management
=

Catalog Management
-ﬁ Order Management
S5 marketing

eﬂ Asset Management
m— q | ,

m Administration Page Size: | 20 (1items) | Page 41

For more information about asset management, please refer to the Asset Management section.

O Productimages in the EPiServer Commerce sample site are stored in the database, and thus
are not available from the File Manager or the Asset Management sub-system.

File Formats

Files stored in EPiServer Commerce are often image files in different formats such as .jpg or .png, or doc-
uments in .pdf formats. However, files stored in EPiServer Commerce can be of almost any type since a
wide selection of file formats are supported. Depending on how your website is configured, files will also
be indexed and appear in the global search for the website.
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Commerce Manager

This section explains how end users can administer the EPiServer Commerce site by logging into the
back-end Commerce Manager module. Commerce Manager includes a number of sub-systems for man-
aging the different parts of an online store.

Dashboard

The Dashboard is an aggregated view of a site's status. Typically, the Dashboard > Home is the first
screen seen that a user sees when he/she logs into Commerce Manager. This is the area that a user can
geta quick overall snapshot of his ecommerce site, including notifications and alerts, an overall summary
of products, categories, orders, customers, and promotions, sales performance graphs, customizable
news and announcements, and a search field for help.

Customizing the Dashboard

The user can customize the Dashboard by re-arranging the layout of the Controls, remove or add Con-
trols, or adjust the page template. The five Controls available are: Help, Summary, News & Announce-
ments, Alerts, and Performance.

To access the Dashboard, click on Dashboard > Home from the left navigation frame.

Users have five controls out of the box:

e The Help control allows users to search for help topics that links directly to the EPiServer Com-
merce documentation site.

e The Summary control displays the total number of Products, Categories, Orders, Customers,
and Promotions.

e The News & Announcements control displays a feed of the latest articles from a selected source.

e The Alerts control displays warnings about each site that may hinder performance and sales,
such as the lack of site analytics installed on the site

e The Performance control displays a Sales Graph and a graph for the Total Sales of the year.

Rearranging, Collapsing, and Removing Controls

To rearrange Controls, hover the mouse cursor over the title bar and drag the Control to another "space"
in the Dashboard.

ERCE

Dashboard Home

| News & Announcements

Help - X

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms.
Examples: Campaigns and Promotions

a. How do | Create a Discount Promotion?

b. Howdo | Create a New Product?

. Where is the release history?

Summary

& products: 1320 2 caregories: 64 [ orders: 17 &1

3 promotions: 1

To collapse Controls, click on the Up-arrow icon. To expand a collapsed Control, click on the Down-
arrow.
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Summary

& Products: 1320  © categories: 64  [E] orders: 17 &1 Customers: 10

= Promotions: 1

MNews & Announcements

Help

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms...

Examples: Campaigns and Promaotions

a. How do | Create a Discount Promaotion?
b. How do | Create a New Product?

C. Where is the release history?

Add

To remove a Control, click on the Xicon.

Adding Controls and Adjusting the Page Template

Click on Add on the Dashboard page. The Information form pops up above the Dashboard page.

Information

Controls Set

EOEE

]

Page Template
Help
News & Announcements
Performance
Summary

| ESetto default || E]Add and cli\\sy| X Cancel |

The Controls Set tab allows you to select which Controls you want to add to the Dashboard. Check the
boxes and then click on Add and Close. The Controls you selected will appear on the Dashboard.

To reset the Dashboard back to the default state before any customizations were made, click on Set to

Default.

On the Page Template tab, you can adjust the Dashboard page layout to a One column template, Two
columns template (first twice bigger than the second), Two columns template (2nd twice bigger than
the 1st), and Two equal columns template. Click on the layout you want and then click on Add and

close.
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Information *

Controls Set Page Template

One column template

Two columns template (first twice bigger than the secand)

Two columns template (2nd twice bigger than the 1st)

Two equal calumns template

] [}

| £|5etm default | | E,Add and clnseh| | A Cancel

The screen below is an example of how a One column template looks.

News & Announcements

Summary

&b Products- 1320 () Categories: 64 [ Orders: 17 &1 Customers: 10 = promotions: 1

Help e

Help will appear in a separate window.

Find answers to questions about Commerce Manager containing the terms
Examples: Campaigns and Promations

a. Howdo | Create a Discount Promation?

b. How do | Create a New Product?

€. Where is the release history?

dd

Customer Management

The Customer Management system is where you can add individual organizations, contacts, and Com-
merce Manager users. You can also create purchase orders for each individual customer account.

Organizations - groups or sub-groups of Contacts
Contacts - individuals with a certain set of personalized information (name, address, email, etc.).
Contacts can be customers or users with Commerce Manager permissions to manage one or

more systems.
e Commerce Manager User - this is a user with an assigned role which provides access to the Com-

merce Manager site.

Organizations

In the Organizations section, Commerce Manager users can create new organizations or organization
units, which are basically groups or sub-groups of assigned contacts.

Organizations can be categorized into different types such as organization or organization units (i.e.,
regional branches, departments) and also business categories such as "Computer and Electronics" or
"Clothing and Accessories." Organizations can be structured into a tree structure with sub-units with dif-
ferent levels of permissions assigned to each. For example, you can set up your company as a parent
level organization while your departments such as Sales & Marketing, IT/Development, and operations as
organization units. With this scenario, you can allow users in each departments to have access to only rel-
evant systems, screens and functionality within Commerce Manager.

The Organizations section also comes with a new customizable filtering feature to display organizations
and sub-units based on any of their attributes such as name, organization types, business categories, etc.

© EPiServer AB



38 | User Guide for EPiServer Commerce 1 R2

Browsing Organizations

Organizations are one of the major function areas of the Customer Management system. You can browse
and view existing Organizations.

To browse Organizations, go to Customer Management > Organization on the left menu.

Customer Management e

@ Organizations

[t
l_‘a Contacts U

&5 Roles

This will open the Organization List page.

Viewing Organization Details

Organization details are separated by four columns:

Name Name of the organization
Description Additional details of the organization
Type The kind of organization itis

Business Category Under which category the organization falls

JERCE Organization List

| |,J View: | All organizations E‘
y[;EI MNew Organization ﬁ Printer Version 'X Delete

|:| Marme Description Type Eusiness Category

D Company X West  Online software applications Organization Computers & Electronics

|:| Company X On[:'ge software applications Organization Computers & Electronics

You can click through the name of the Organization to view more details about it.

Organization Info

Edit Organizations

Name: Company X West Parent: Company X
Information Information
Information Or
Contacts Name: Company X West Type: Organization
Organizations
Addresses Description: Online software applications Business Category-Computers & Electronics

Credit Cards

Searching for Organizations

You can also use the search field on the Organization List to find specific Organizations by name. To con-
duct a search, enter in your search terms and click on the Search button.

To conduct a new search, click on the Reset button to reset the form and enter your new search terms.
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Printing a List of Organizations

If you want to generate a printer-friendly list of Organizations, click on Printer Version. A new window will
pop-up and render a simple table suitable for printing. Click on the Print button on the upper right corner
of the page.

Creating or Customizing Views for Browsing Organizations

As an Organization List gets longer, users can create and customize views to filter the list.

To create a new view, click on the View drop-down menu and select "New View."

ERCE Organization List

| |,) View: | All organizations E
” y I[ System Views ]

= New Organization | (S Printer Version | X Delete All organizations

|:| Matre Description Twpe

= Company ¥ East Online software application Crganization Computers & Electronics

|:| B¢ Company X West  Online software applications Organization Computers & Electronics

|:| B¢ Company X Online software applications Organization Computers & Electronics

A pop-up form appears above the Organization ListThis form gives users the ability to customize which
columns appear and apply a variety of filters.

New View o

|General || Fields || Filters |

Enter Title

Everything is ready
0O Create a new view
for entities list.

Please, type view
name.

DShowthis view for all users

| Save | | Close |

The default tab is General. Enter in a Title for the custom View. Click the check-box Show this view for all
users, if you want other users to see this custom View.
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New View *
General || Fields || Filters
Enter Title
Professional Services Companies Ewverything is ready
to create a new view
[¥] show this view for all users for entities list.

Please, type view
name.

| Save | | Close

Click on the Fields tab to select which columns you want to appear in the custom View. Select the col-
umns you want to have appear by clicking and highlighting the column name and moving it over to the
Visible columns list by clicking on the Right Arrow icon.

MNew View 4

General || Fields || Filters

Available columns: Visible columns:
Description " Creator
Id h Business Category
Modified
Modifier
MName
Parent |
Parent (ref)
Primary Contact
Primary Contact (ref)
Type

m
|
[=]

=
[]

1|

| Sawve | | Close |

To deselect a column, click and highlight a column name from the Visible columns list and then click on
the Left Arrow icon.

To change the ordering of the Visible columns list, click and highlight a column name and click on the Up
and Down Arrow icons on the right of the list to reposition the column.

Click on the Filters tab to set the View filters. Users are given precise controls over filters for setting up
rules for their custom View. Clicking on the + icon allows you add an additional filter.
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New View *

Ceneral || Fields || Filters

o And
Business Category Equals Arts & Entertainment

Or

Please choose -

Please choose
And

Or

Business Category
Created
Description

Id

Maodified

Parent

Parent (Reference)

Primary Contact

Primary Contact (Reference)
Type

| Save | | Close |

Click on Save to save the settings and return to the Organization List screen.

To edit an existing View or a View you just created, select the View from the drop-down menu and click
on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

FRCE Organization List

| |,) View: | Professional Services Companies |E| %X
= New Organization | &3 Printer Version | ¥ Delete Edit h
|:| Creatar Eusiness Categary Marre

]

To delete a custom View, click on the X icon next to the Edit icon.

There are a multitude of options available for customization, but here are some examples to get you
started.

Example View Filter Setups

The examples here will start off with the following list of sample Organizations, Organization Units, and
Divisional Units:

ERCE Organization List

| |,.) View: | All organizations lz‘

= New Organization | =3 Printer Version | % Delete

|:| Marme Description Type Eusiness Categary

|:| =¥ Company X East Online software application Organization Unit Computers & Electronics h
|:| = Company X West Online software applications Organization Unit Computers & Electronics

|:| = Company X ITW... Online software application IT s... Divisional Unit Computers & Electronics

|:| = CompanyX Online software applications Organization Computers & Electronics
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Example 1: Creating a View to Only Show Organizations that Match a Business Category and Organization Name

1. In this example, we will create a filter condition that display Organizations with a Business Cat-
egory that equals "Business & Professional Services" and an Organization Name that equals
"Company X."

2. Click on the +icon and from the drop-down select "Business Category." Two fields, which default
to "Equals" and "Arts & Entertainment," automatically appear. Click on "Equals" and a drop-down
appears. Keep the field as "Equals." Click the field to the right of it and select a "Business Cat-
egory" name (such as "Business and Professional Services").

3. Since we want to add another filter so that the Organization not only matches this "Business Cat-
egory," but also a specified name, click on the following + icon and then on the drop-down select
"Name."

4. Inthe nextfield, select "Equals" and then on the field that says "Text" enter in the name of the
Organization (such as "Mediachase").

5. Once done, click Save to save the View.

New View

Ceneral || Fields || I-'ilter5|

And

Business Category Equals Business & Professional Services

Mame Equals Cc’n:aﬂ-[l' X

Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

View: | Professional Services Companies - b
[ System Views | —
All organizations

Mafl Yser views ]
Professional Services Companies k
[ New Wiew ]

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom View, your Organization List will reflect those options.

ERCE A Organization List

| |,J View:| Professional Services Companies IZI = X
;[:ElNew Organization ﬁPrinter\-’ersion X Delete

[ Business Category Mame Cescriptian Type

|:| Computers & Electronics Company X Online software applications Organization

Example 2: Creating a View to Display Companies with Specific Business Category or Organization Name

In this example, we will create a filter condition that display Organizations with a Business Category that
equals "Computer & Electronics" or an Organization Name that contains "X."
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New View b4

Ceneral || Fields || Filters

- () Or

Mame Equals X

b Business Category Equals Computers & Electronics

ERCE Organization List

| |') View: | Professional Services Companies IZI =
‘= New Organization | () Printer Version | ¥ Delete

|:| Business Category Marme Description Type

|:| Computers & Electronics Company X East Online software application Organization Unit

|:| =¥ Computers & Electranics Company X West Online software applications Organization Unit

|:| =¥ Computers & Electranics Company X IT West Online software application IT... Divisional Unit

|:| =¥ Computers & Electranics Company X Online software applications Organization

Example 3: Creating a View to Display Companies with Specific Business Category and/or Name

In this example, we will create a filter condition that displays Organizations with a "Business Category"
that equals "Computer & Electronics" and/or an Organization Name that contains "X."

New View *

Ceneral || Fields || Filters

) o

Mame Equals k4

Business Category Equals Computers & Electronics

MName Contains X

ERCE Organization List

| |,) View: | Professional Services Companies Iz‘ = X
>’|§_§| Mew Qrganization 5 Printer Version }( Delete

|:| Business Category Marne Description Type

|:| Computers & Electronics Company X East Online software application Organization Unit

|:| Computers & Electronics Company X West Online software applications Organization Unit

|:| Computers & Electronics Company X IT West Online software application IT... Divisional Unit

|:| D}:mputers & Electronics Company X Online software applications Organization
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Creating an Organization

To create an Organization, click on New Organization.

Organization List

| |,.J View:| All organizations

“(=5) New Organization | =3 Printer Version | Delete

|:| Marme U Description Type Business Category

]

The Organization Edit page appears.

Field ____[Descripon |

Name Enter in the organization name (this is the only required field).
Description For additional details about the organization.
Type Select from the drop-down menu to assign a type to the organization. More

types can be added to the drop-down by clicking on the icon.

Business Cat- Select from the drop-down menu to assign a category to the organization.
egory You can add more categories by clicking on the icon.

You can assign a parent organization to an organization. If the organization
you are creating is a sub-unit of a larger organization, then select the parent
in the drop-down menu. If you do not see the Organization listed on the
drop-down menu, click on "More..."

Parent

Once you have entered all relevant information, click on OK. The Organization Info window of the organ-
ization appears.

From here, you can view Information about the Organization you just created. Out of the box, you can
also see associated Contracts, Organizations, Addresses, and Credit Cards. You can further edit the
Organization by clicking the Edit button. To go back to the Organization List, click on Organizations on
the menu bar next to Edit.

Organization Info

Edit Organizations

Name: Company X West Parent: Company X

Information Information
Information Or
Contacts Name: Company X West Type: Organization
Organizations
Addresses Description: Online software applications Business Category-Computers & Electronics
Credit Cards

Creating an Organization Unit

An Organizational Unitis a "child" or subsidiary of a Parent organization. Within Commerce Manager, you
can assign an Organization as a Parent of another Organization. For example, the Parent company "Com-
pany X," and the Organizational Units are "Company X West" and "Company X East."

To create an Organization Unit, either create a New Organization or Edit an existing one.
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Enterin a Name and Description.

From the drop-down, select the Type as "Organization Unit."

Select a Business Category.

Select a Parent Organization from the drop-down menu. Selecting a Parent Organization will des-

ignate this Organization as a unit (or in other words, a division, sub-organization, subsidiary, etc.)
5. Click OK to save the changes.

PoN=

Overview

Name: Company X Morth

Description: Online software applications i
Type: COrganization Unit IE‘ ﬁl
Business Category: Business & Professional Services |E| ﬁl
Parent: |C|:|rr1par11,r}1 |v|

Farent Orgamization
Ok || Cancel |

You will see in the Organization Info View form that the Organization is now a child or Organization Unit
of the Parent Organization you selected.

Organization Info

License: ECF G5 Deployment (EpiServer)

@) Get Help For This Page %

Emt a Organizations

Name: Company X North Parent: Company X

Information Information
Information or
Contacts Name- Company X North Type Organization Unit
Organizations
Addresses Description: Online software applications Business Category-Business & Professional Services
Credit Cards

Creating an Organizational Hierarchy

You can create Organization Hierarchies by assigning a Parent Organization to a "child" Organization
and then another Organization to the child. Permissions can be set to determine which users can view cer-
tain Organizations in the hierarchy.

Create an Organization Unit by assigning a Parent with a child Organization. For example, "Company X"
is the Parent Organization and "Company X West" is the Organization Unit.

Assign another Organization with the child Organization ("Company X West"). Click OK.

© EPiServer AB



46 | User Guide for EPiServer Commerce 1 R2

ERCE Organization Edit

Overview
Name: Company X West
Description: Online software applications -
Type: Organization Unit Eﬁl
Business Category: Computers & Electronics IE' ﬁl
Parent: |C|:|rr1par'|‘,r)( |v|
F N.Dz Set o
QK || Cancel | Company X Ilk'
More__.

In the Organization Info page, the Organization becomes the child to the Organization Unit you selected.

ERCE Organization Info

Edit Organizations

Name: Company X West Parent: Company X

Information Information
Information Organization
Contacts Name: Company X West Type:
Organizations
Addresses Description: Online software applications Business Categq
Credit Cards

[ Edit ][ cancel ]

Repeat the steps above to create further subunits of the Parent Organization.
Creating and Editing Dictionary Entries

By default, when creating or editing an Organization, there is a default list of Types and Business Cat-
egories available to the user. More options can be created by editing the Dictionary within the Organ-
ization Edit page.

Adding New Dictionaries for Organization Type

1. To edit the Dictionary, open the Organization Edit page by creating a new organization or editing
an existing one. Click on the icon next to the Type drop-down menu.

The new window appears allowing you to edit the existing organization Type dictionary . To add a
new item to the dictionary, click on New Item.

Select the order of the item from the drop-down on the left.

Enter in a name of the item on the field next to the drop-down.

Click Save to save the dictionary item.

The dictionary item is now available in the Type drop-down.

N

o 0ew
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Adding New Business Categories

Out of the box, there is a list of categories you can assign to an organization. You can add more cat-
egories the same way you add organization types.

1. Click on the dictionary icon next to the Business Category drop-down menu.

2. Click on New Item to add a new category.

3. Enterin a category name and then click . You can change the order the category is on the list by
clicking on number drop-down menu.

4. The category now appears in the drop-down menu.

Contacts

Contacts are individuals with a certain set of personalized information (name, address, email, etc.).

e Contacts with Accounts - a customer who registers on the public site. If this customer chooses,
he/she can login to his/her Account from the public site and access his/her order history and other
personalized information. He/she cannot access the Commerce Manager.

e Contacts with User Permissions - someone internal to your team who has varying levels of
access to the systems within Commerce Manager.

Contacts consisting of users who will be accessing the Commerce Manager can be assigned Roles
based on varying permissions. For example, a user with the "Cms Admins" role will have full access to
only the Content Management system. In addition, notes regarding the Contact's registration source can
be recorded.

The Contact section also comes with a new customizable filtering feature to display contacts based on
any of their attributes such as Name, Last Order Date and Customer Group.

Browsing Contacts

To browse Contacts, go to Customer Management > Contacts.

Customer Management e

@ Cirganizations
13 Contacts

I'é:g Roles

Viewing Detailed Contact Information

The Contact List page shows a list of existing Contacts.

ERCE List

-

|,J View: | All contacts IE‘

|

8= New Contact ﬁPrinterVersion )( Delete Selected

|:| FullMame2 FirstName2 Last Name Middle Name
|:| =¥ Receiving Manager Receiving Manager
|:| =¥ Order Manager Order Manager
|:| ennifer Browne Jennifer Browne

0 Mary Smith Mary Smith

|:| =¥ Shipping Manager Shipping Manager
|:| =¥ admin admin

|:| Order Supervisor Order Supervisor
[ Carlos Mevada Carlos MNevada

|:| =¥ Lisa Prescoftt Lisa Prescott
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You can click through the name an existing Contact to view more information.

CE

View

sout 7

& cet Help For This Page

From within the Contact Info form, you can view other recorded information about the Contact. For exam-

Emt ¥ Delete Contact Contacts D New Order
Full Name: admin Parent Organization:
Infor Information |
Information — Contact
Addresses Full N 4 c c
Credit Cards ull Name: admin ustomer Group:
Security First Name: admin Preferred Currency:
Roles Middle Name: Preferred Language:
Orders
Order History Last Name: Registration Source:
Shopping Lists Parent Organization- Last Order Date:-
Wish Lists
Shopping Carts Preferred Shipping
Address:
i Preferred Billing
Address:
~— Account Edit Account | Change Password | Remove Account —,
User Name: admin Is Locked Out: none
Description: Last Activity: Today, 2:49 PM
Email: admin@yourcompany.com Last Login: Today, 2:48 PM
Last Password 7/7/2011 9:34:48 AM
Changed:

ple, you can view Addresses and Order History related to this Contact.

O More objects or metadata can be added to the default View Form via Business Foundation.

Searching for Contacts

On the Contact Info page, you can use the search form above to search for a particular Contact using key

terms. Conduct the search by clicking
search terms will appear on the list.

on the Search icon (magnifying glass). Contacts that match the

|vi sitor

P 4

= Mew Contact

&= Printer Version

> Delete Selected

(]
(]

Full Marme

EPiserver Commerce Visitor

First Marne

Visitor

To clear the search and revert back to show all Contacts, click on the Reset icon (eraser) next to the

Search icon.

Generating a Printer Friendly List of Contacts

To generate a printer friendly layout of the Contact List, click on Printer VVersion from the menu bar on

the Contact List page.
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MERCE List

| |,.) View: | All contacts

8 New Contact | |53 Printer Version| | 3 Delete Selected

|:| FullName2 A" FirstName2 Last Mame
|:| Eeceiving Manager Receiving Manager
|:| =¥ Order Manager Order Manager
[ ennifer Browne Jennifer Erowne
[ = MarySmith Mary Smith

|:| =¥ Shipping Manager Shipping Manager
] admin admin

|:| B¢ Order Supervisor Order Supervisor
|:| = Carlos Nevada Carlos MNewvada
|:| ¢ Lisa Prescott Lisa Prescott

A new browser window opens showing a printer-friendly version of the Contact List. Click on Print on the
far right corner of the browser window.

Contact

Full Name First Name|Last Name Middle Name Last Order Date Customer Group
Receiving Manager|Receiving |Manager
Crder Manager Order Manager
Jennifer Browne (Jennifer Browne
Mary Smith Mary Smith
Shipping Manager |Shipping Manager
admin admin

Order Supervisor |QOrder Supervisor
Carlos Mevada Carlos Nevada
Liza Prescott Liza Prescott

Creating or Customizing Views for Browsing Contacts
Llke Organizations, users can create or customize Views when browsing objects.

Creating a New View

On the Contact List page, click on the View drop-down menu and select New View.
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ERCE Contact List

| |,.) View: | All contacts IE'
- [ System Views ]

S New Contact | (= Printer Version | ¥ Delete Selected All contacts

] Full Marme First Mame

[ Mats Hellstrom Mats Hellstrdm

] admin admin

A pop-up appears, very similar to the one found in Organizations. This form gives users the ability to cus-
tomize which columns appear and apply a variety of filters.

New View
x

Ceneral || Fields || Filters

Enter Title

Everything is ready
O Create a new view
faor entities list.

Please, type view
name.

DShow this view for all users

The default tab is General. Enter in a Title for the custom View. Check the box Show this view for all
users if you want other users to see this custom View.

New View

Ceneral || Fields || Filters

Enter Title

Only in Company X Everything is ready
to Create a new view

for entities list.
Please, type view
name.

Shuw this view for all users

Click on the Fields tab to select which columns you want to appear in the custom View. Select the col-
umns you want to have appear by clicking and highlighting the column name and moving it over to the
Visible columns list by clicking on the Right Arrow icon.
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New View

Ceneral || Fields || Filters

Ayvailable columns:
Caode
Created
Creator
Customer Group
Diate OF Birth

Last Mame

Last Order Date
Middle Name
Modified

| »

m

Visible columns:

First Name
Full Name
Email

B

Save

| | Close

Commerce Manager | 51

To deselect a column, click and highlight a column name from the Visible columns list and then click on

the Left Arrow icon.

To change the ordering of the Visible column list, click and highlight a column name and click on the Up
and Down Arrows on the right of the list to reposition the column.

Click on the Filters tab to set the view filters. Users are given precise controls over filters for setting up

rules for their custom View. Clicking on the + icon allows you add an additional filter.

Mew View

Ceneral || Fields || Filters

i+ And

Please choose

Please choose

And

Or

Code

Created

Customer Croup

Date Of Birth

Email

First Name

Full Mame

Id

Last Name

Last Order Date

Middle Mame

Modified

Parent Organization
Parent Organization (Reference)
Preferred Billing Address

Preferred Billing Address (Reference)
Preferred Currency

Preferred Language

Preferred Shipping Address

Registration Source

Parent Organization Equals Company X

I

Preferred Shipping Address (Reference)

There are a multitude of options available for customization.
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Applying and Editing a View

Once a View is created and saved, it appears in the View drop-down box.

JERCE Contact List

| |,J View: | Onlyin Company X > | =X
N [ System Wiews ]
8= New Contact | ) Printer Version | X Delete Selected All contacts
] Ernail Full Narme FirjLUser views ]
Only in Company X k‘
= mats@episerver.com Mats Hellstrém Mal[ New View |
D = mary.smtih@comopanyx.... Mary Smith Mary
|:| E/ peter.sunna®episerver.com Peter Sunna Peter

To apply the View, select it from the drop-down. Based on the columns and filters you applied for the cus-
tom View, your Contact List will reflect those options.

To edit an existing View or a View you just created, select the View from the drop-down menu and click
on the Edit icon next to it. The View Editing form pops up and you are able to edit all properties.

View: | Only in Company X |z| ﬁ by

Edit h

First Mame

Creating a Contact

To create a new Contact, from the Contact List page, click on New Contact.

ERCE Contact List

HNeanntacljcl =3 Printer Version | % Delete Selected

|:| Fullq:'}me First Marme

The Contact Edit page appears where you can enter all relevant information about the contact. The only
required fields to complete are Full Name, First Name, Last Name, and Email. The rest of the fields are
optional but are recommended.

1. Select a Parent Organization from the drop-down menu to associate the Contact with a single Par-
ent Organization.

2. Assign the Contact to a Customer Group. More Customer Groups can be added by editing the
Customer Group Dictionaries. Customer Groups become useful when setting specific permissions
and targeted Marketing Campaigns. (For more information, see "How to Assign a Customer Group
Sales Price for a Particular Item" section below.)

3. Selecta Preferred Currency for the contact. If the Contactis in France, you may want to associate
the Euro currency. Available currency options are based on settings in Administration > System
Settings > Dictionaries > Currencies.

4. Selecta Preferred Language to associate with the Contact. Languages are populated based on
the languages set under Administration > System Settings > Dictionaries > Languages.

5. The Registration Source field is a text field for entering in notes about the Contact. For instance,
you may want to reference which website the Contact is currently registered under.
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O The Registration Source field is automatically filled when a user creates a new Account from
the public website.

ERCE Contact Edit

Overview
Full Name: Mary Smith
First Name: Mary
Middle Mame:
Last Name: Smith

Email: mary.smtih@comopanyx.com

Cantact Email Description

Parent Organization: Company X |v|

Cantact Qrganization
Customer Group: Customer |z| =
Preferred Currency: Us dallar E
Preferred Language: | English (United States) =

Registration Source: Companyx

Ok | | Cancel

Click OK to save the Contact. The Contact Info View Form, where you can enter in additional information
about the Contact as well as go back and edit the Contact again.

O The screenshot below shows the default layout of the Contact Info form. This can be cus-
tomized using Business Foundation.

Contact Info

@ Get Help For This Page %

&=/ Edit | ¥ Delete Contacts

Full Name- Mary Smith Parent Organization® Campany X
Information Information
Information Contact
Addresses Full Name- Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency: usp
Order History Middle Name- Preferred Language: en-Us
Shopping Lists Last Name: Smith Registration Source:  companyx
Wish Lists
Shnppmlk:arts Parent Organization: Company X Last Order Date:
Account Create account

Account not found:

To go back to the Contact List, click Cancel or the Contacts button next to the Right Arrow icon.
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Creating an Account
An Account can be created with a Contact. Once an Account has been created, the Contact can be

assigned permissions using Roles and access the Commerce Manager.

O A customer Account is automatically created for a customer who registers from the front-end
public website, allowing them to login and view personalized information.

To create an Account for an existing Contact, click on a Contact name from the Contact List. On the Con-
tact Info page, click on Create Account.

ERCE Contact Info

(@ et Help For This Page %

B/ Edit | ¥ Delete | [EJ Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Orders First Name: Mary Preferred Currency-  USD
Order History Middle Name- Preferred Language:- en-Us
Shopping Lists Last Name: Smith Registration Source: companyx
Wish Lists
Shopping Carts Parent Organization: Company X Last Order Date:
Account Create ac:u{%t
Account not found:

A pop-up appears to enter in their user account credentials. A User Name and Password are required to
create the Account.

Enterin a User Name, which can include spaces and special characters.

Enterin a Password, which must be four or more characters.

Enter in a Description and Email Address, which are both optional.

To enable the account, select "Yes" under Approved. Otherwise, select "No" to keep the account
inactive and inaccessible by the user.

Click OK to save the account.

PoON=

o

Create account #

User Name: |Mary
Password: YT

Description: |mary.smith@&companyx.com

Email: mary.smtih@companyx.com

Approved: -{--‘r’es -:-N-:u

| E oK | | ﬂ Cancel

User account information appears under the Account section of the Contact Information form.

Fields Explained:
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Last Activity - last time the user logged in or made any changes to the site

Last Lockout - last time a user was locked out due to too many failed login attempts
Last Login - last time the user logged into his or her account
Last Password Changed - last time the user account password changed

1@ Get Help For This Page +

=/ Edit | ¥ Delete Contacts
Full Name: Mary Smith Parent Organization- Company X
Information
Information Contact
Addresses Full Name: Mary Smith Customer Group: Customer
Credit Cards
Security First Name: Mary Preferred Currency:  USD
Roles Middle Name: Preferred Language:  en-US
Orders Last Name: Smith Registration Source:  companyx
Order Histary
Shopping Lists Parent Organization:  Company X Last Order Dare:
Wish Lists
Shopping Carts Account Ed\[ACED% | Change Password | Remove Account
User Name- Mary Last Activity: 5/1/2010 817:44 AM
Description: mary smith@companyx com Last Lockout: none
Email: mary.smtih@companyx.com Last Login: 6/1/2010 8:17:44 AM
Last Password o !
Changea: 6/1/2010 8:17:44 AM

Editing an Account, Changing an Account Password, and Removing Accounts

To edit an Account, click on Edit Account. The same pop-up will appear. You cannot change the User

Name unless you remove the Account and recreate the same Account.

To change the password, click on Change Password. A password pop-up appears with an editable field

that allows you to enter in the new password.

To delete or remote the account, click on Remove Account.

Create an Order Within a Contact

For customer accounts, you can create purchase orders.

1. Click on a contact name. You will see the contact details.
2. Click on New Order on the menu bar.
3. The New Order form appears to generate an order for the customer.

EPISERVER COMMERCE

Welcome ¥ Change language About ™

View

Customer Management

Customer Management < = Edit | X Delete Contact Contacts | |_] Mew gpde
=] m Customer Management
N Full Name: Carlos Nevada Parent Organization:
@ Organizations
L@ Contacts Information Information
&> Roles Information Il — contact
Addresses Full Name: Carlos Nevada Custc
Credit Cards
Security First Name- Carlos Prefe
Roles Middle Name:- Prefe
Orders -
Order History Last Name: Nevada Regis
Shopping Lists
pping Parent Organization: Last
Wish Lists
Shopping Carts Preferred Shipping
Address:
Preferred Billing
Address:
i — Account
User Name: Carlos Is Lock
Description: Last Au
Email: carlos@somemail.com Last Lc
ﬁ‘ Dashboard Last Pz
Chang

Fﬁ“‘; Catalog Management
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Roles and Permissions

In the Roles section, Commerce Manager users can be either granted or restricted access to an entire sys-
tem or a particular menu item within a system. Each Role is defined by a set of Permissions that can be
added or changed based on user selection. Existing Roles can be customized; new Roles can also be
created to suit your unique business needs.

Roles control the level of access permissions of each user accountin Commerce Manager. Different
Roles may be added to user accounts (i.e., store operator or webmaster) so that they can access, edit, or
process relevant information.

There are three main categories that determine the different levels of permissions: Admin, Manager, and
Schema Manager.

e Admin Role - allows users to fully access and administer a particular Commerce Manager system.
Manager Role - allows users to manage (View/Create/Edit/Delete) existing aspects of a particular
Commerce Manager system .

e Schema Manager - allows users to access only the administrative side of an Commerce Manager
system (e.g. setting up Meta Data).

Definitions of Roles

Selecting Roles in the left menu opens a Roles List page with the default Roles shown below. The Roles
List page allows Commerce Manager administrative users to add new, edit or delete these existing roles.

Here is a listing of the roles available out-of-the-box followed by a brief high-level description of what a
user with this role can access:

e Admins - allows users to fully administer most areas of the Commerce Manager.
Everyone - one of the default roles which is assigned when a customer registers an account from
the front-end public site.
Management Users - allows users access to the Commerce Manager.
Order Supervisor - allows users to fully administer the Order Management system.
Order Managers - allows users to manage (View/Create/Edit/Delete/Others) elements within the
Order Management system.

o Registered - one of the default roles which is assigned when you register from an account from
the front-end public site.
Shipping Manager - has the ability to view, pack, and complete shipments.
Receiving Manager - has the ability to view shipments and receive returns.

O You can easily modify these existing roles or consolidate roles. In addition, custom roles can
be created depending on your business needs.

See also the User Access and Roles section, to find out more about access rights and role management
in EPiServer CMS.
Creating, Editing, and Deleting Roles

Out of the box, Commerce Manager includes a list of pre-existing Roles that can be assigned to Accounts.
Users can also create their own Roles based on a set of Permissions. Roles allow Administrators to
restrict users from accessing different systems or folders depending on their needs.

Creating a Role

To create a new Role, go to Customer Management > Roles to see the Role List.
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EPISERVER COMMERCE Role List

Welcome ™ Change Language About ™

Customer Management EE D Mew i] More Actions
sE] Organizations O ﬂ'\-_n’“ Role Mame
EE Contacts I:l X Asset Admins

Roles
33 D x Asset Managers
D X Catalog Viewers

i

]

Click on New to open up the Role Edit page.

ERCE Role Edit

Overview

Role Name:

Permissions:

»

= m Asset L
h [[Manage
[z [[lAdministration
[*7 Catalog
h [|catalogs
g [C]Administration
=l m Content
g [C]Sites
'z [[lAdministration
= m Core
h [[Management
g [ClAdministration
iﬁ Customer
‘g [C|Roles
[*3 Marketing
h [[|€ampaigns
[*z [[]Promations
h [[|Customer Segments

M

m

M

M

There is a wealth of Permissions options Administrators can set for a Role.
Enter a Role Name.

Checkmark the boxes to give Permissions to the Account for this particular function or action. For exam-
ple, if you want an Account to only View and Edit Assets, you will need to expand Assets > Manage and
checkmark View and Edit.
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ERCE Role Edit

Owverview

Role Name: | accet view/ Edit

Permissions: ;
= ['g Asset

= [*g [[|Manage
[ Wiew
[[|Create
&

Once done defining the Role, click on OK. The new Role will appear on the Role List.

elete

O % Customer Managers
O ¥ Everyone

[ ¥ Registered

[ ¥ Asset View/Edit

Page Size: | 100 |z|

Editing Existing Roles

All existing Roles, including the ones included out of the box with Commerce Manager, can edited and
customized. It is also a recommended reference to how each pre-existing Role works.

To edit a Role, click on the Edit icon.

Catalog Managers

Catalog Schema Managers

Eigc el
LA Ab G G g {

Order Admins

Order Managers

il

Marketing Viewears

Bl

OO0O0OoOO

Customer Viewers

il

The Role Edit page appears. You can customize the Permissions settings for the Role. Once done, click
OK.

Deleting Roles

To delete any Role on the list, there are two ways:

Click on the X button next to the name of the Role to delete one at a time.

>( Cms Viewars

Cms Editors

=

>( Marketing Admins

gement Users

N i i
El
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To delete multiple Roles, checkmark each box and on the menu bar, click on More Actions > Delete
Selected. Click OK when the pop-up appears.

ERCE Role List
r
DNEW ;ZII".-'In:-rnz.E'u:ticnr'ls1|r
[l )( DE|EtE5E|EEtEd’{':JJ
O = % Asset Admins L
] @' % Asset Managers
I & % catalog Viewers
% Cms Admins
¥ Cms Managars
= % Cms Viewers
= % cms Editors
)| O] &= X Management Users
4

Assigning Roles to Individual Accounts

Roles are designed to allow and disallow certain functionality and folders to individual accounts. When a
Contactlogs into his or her account, that Account is bound by the Roles it was assigned.

To assign one or more Roles to an account, go to Customer Management > Contacts and click on an
existing Contact with an Account.

ERCE

Contact Info

) Get Help For This Page ¥

&=/ Edit | X Delete Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Information
Information Contact
Addresses Full Name- Mary Smith Customer Group- Customer
Credit Cards
Security First Name:- Mary Preferred Currency:  USD
Rm% Middle Name: Preferred Language:  en-US
Orde Last Name: Smith Registration Source: companyx
Order History
Shopping Lists Parent Organization: Company X Last Order Date:
Wish Lists
Shopping Carts Account Edit Account | Change Password | Remove Account
User Name: Mary Last Activity: 6/1/2010 91744 AM
Description: mary.smith&companyx.com Last Lockout: none
Email- mary.smtih@companyx.com Last Login: 6/1/2010 9:17:44 AM
Last Password
Changed: 6/1/2010 9:17:44 AM

Under Security, click on Roles. The Security section only appears after an Account was created for the
Contact.

The Roles form appear, allowing you to assign Roles to the Account. By default, an Accountis already
assigned to the "Registered" and "Everyone" roles.

© EPiServer AB



60 | User Guide for EPiServer Commerce 1 R2

Contact Info

i@ Cet Help For This Page &

Orders
Order History
Shopping Lists
Wish Lists
Shopping Carts

EEdit | ¥ Delete Contacts
Full Name: Mary Smith Parent Organization: Company X
Information Roles
Informati ”
nrormation *5 Assign Role | ¥ Remove Roles
Addresses
Credit Cards ] Rale Name Organization Inheritance
Security = Registered none [ Undefined ]
Roles [ ) Everyone none [ Undefined ]

Page Size: 20 E‘

(2 iterns) | Page < 1 »

Click on Assign Role to assign a new Role to the Account. A pop-up appears allowing you to assign a
specific Role from the drop-down menu.

Inheritance:

Assign Role b4
Security Role: Cms Admins -
Organization: Company X

Inherit From Parent

Save | Cancel

Select a Security Role from the drop-down to assign to the Account.

Optionally, you can assign an Organization to the Account, which enables the Inheritance drop-down
menu below. If specific permissions are set for an Organization, you can set to "Inherit from Parent"
(inherit permissions from the Parent organization) or "Overwrite parent.”

Click Save to assign the role. Repeat these steps to assign more roles to the Account.

Contact Info

@ Get Help For This Page %

B/ Edit | X Delete Contacts

Full Name: Mary Smith Parent Organization: Company X

Information Rales
Information m

|EASS|QH Role | % Remove Roles ‘

Addresses
Credit Cards =] Role Mame Qrganization Inheritance

Security ] Registered none [ Undefined ]
Roles ‘ ) Everyone none [ Undefined ]

Orders - af Cms Admins Company X Overwrite parent
Order History

Shopping Lists Page size: 20 [] (3 items) | Page ¢ 1
Wish Lists
Shopping Carts
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Catalog Management

An EPiServer Commerce front-end public site allows customers to shop for products. To manage prod-
ucts, you can go to the back-end Commerce Manager and you will notice that products are arranged into
one or more catalog(s). Catalogs are independent from one another and you may create as many cat-
alogs as you need. Catalogs can be structured in a number of ways. For example, you may have various
brands or product lines. Each brand or product line can have its own catalog. Or, a retailer may have mul-
tiple suppliers, in which case, you can segment each supplier into its own catalog.

A default B2C Sample Site along with a default electronics catalog (consisting of a Brands catalog + an
Everything catalog) is included giving you a running demo site after you run the installer.

The EPiServer Commerce Catalog Management provides full complement of tools and capabilities to
create and manage a diverse range of products, variations, pricing strategies, languages, and related
website functions.

EPiServer Commerce allows you to easily and flexibly organize and categorize your products. All prod-
ucts referenced on a front-end site reside in a catalog created in Commerce Manager. Multiple catalogs
can be created and assigned to one or more sites. The dates that each catalog will be available to the cus-
tomer can also be defined. In this way, future revisions to items and pricing can be prepared easily and
reviewed in advance of the release date to the site.

Catalogs can be organized into Categories, Products, SKUs, Bundles, Packages and Dynamic Packages.

Catalog and Catalog Entries

e Catalogs - a catalog is a top-level container for all catalog entries such as Categories, Products
and SKUs.+Catalogs - a Catalog is a top-level container for all Catalog Entries such as Cat-
egories, Products and SKUs.

Categories - a Category is a grouping of purchasable products.

Products - a Product represents various forms of merchandise that you can display and purchase
from the front-end site, including Products, Variations/SKUs, Bundles, Packages and Dynamic
Packages.

e Product Entries - a Product Entry typically contains a product name, part number, descrip-
tion and images.

e Variations/SKUs - a Variation or SKU corresponds to a specific type of product with spe-
cific characteristics. For example, a shirt product will have an individual Variation/SKU
which includes size, color and sleeve length.

e Bundles - a Bundle is a collection of Variations and SKUs allowing customers to purchase
two or more items at once.

e Packages - a Package is comparable to an individual SKU because the Package item
must be purchased as a whole (i.e. computer system).

¢ Dynamic Packages - a Dynamic Package is similar to the Package definition above with
the added ability to configure the Package during checkout.

Woorking with Catalogs

A catalog is a top-level container for all catalog entries such as Categories, Products and SKUs. In this
section, you will learn how to browse, create, and delete catalogs. We recommend that you start with the
catalog that came with the EPiServer Commerce sample site, which contains the Everything/Brands
catalog. You can use the import functionality to get this into one of your environments, editmaster the con-
tent and export it so that this polished catalog can be used in a different environment. Also, you are given
the flexibility to use a CSV file to rapidly create a new catalog from scratch.

Browsing Catalogs
All Catalogs are managed under the Catalog Management system.

To browse the Catalog, click on Catalog Management on the left menu. Click on Catalogs to browse the
list of Catalogs.
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Catalog Management .,{7"'

_l, Catalog Entry Search
= Catalog Batch Update

=[] Catalogs jm
A\

The Catalog List page shows the following two sample nodes by default:

e Brands - this node contains information regarding different brands.
e Everything - this node contains information on individual sales items grouped in different cat-
egories ("Digital Cameras," "Daily Specials," etc.).

Clicking on the Memo icon, located between the check box and the folder icon, will display more infor-
mation and settings of the particular Catalog in the Catalog Edit page.

Clicking on the Catalog names ("Brands" and "Everything" highlighted in blue) will take you to the Node
List page, which is the list of Sub-Categories under the selected Catalog.

Catalog List

[_4 New Catalog ﬂ Import/Export~ z Maore Actions ¥

I:‘ Marne Available fram Expires Status
=) ﬂg‘ Everything 12/18/2007 9:00:00 AM 12/18/2020 9:00:00 AM  True
= 4 Brands 6/24/2008 7:00:00 PM 6/24/2020 7:00:00 PM True

Creating a Catalog

The Catalog List page, used to organize and manage catalogs, contains information regarding brands
and sales items. These sets of information will either be displayed on the front-end site, or used for other
purposes such as for pricing and Promotions.

To create a new Catalog, click on New Catalog.

Catalog List

i New Eftﬂlu:ug iiIrr1|:1|:|rt_.-'E)cr:n:urt1|r ill".-h:ure Actions
|:| U Marme

D ﬂg Everything

[ *  Erands

Category Name - this name will appear in the Catalog List Page (e.g., Brands, Everything).

Catalog Owner - designate an existing user as the Catalog owner.

Available from - select the date to which the Category is activated.

Expires on - select the expiration date; once the expiration date passes, the Product will no longer

appear on the front-end site.

Default Currency - this setting will set the Default Currency for the relevant Catalog contents.

e Default Language - this will set the Default Language for the contents.

o Base Weight - this assigns the weight units for the contents of the Catalog (e.g. pounds or kil-
ograms). More units may be added.

e Other Languages - you can also select other available Languages other than your default Lan-
guage.

o Sites - this determines the site/sites that the relevant Products will be displayed in. Atleast one

site must be highlighted, but you can highlight multiple sites to apply the catalog more than one

site.
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e Sort Order - the Sort Order determines the order to which the Catalog appears in the Catalog List

page.
e Auvailable - select "Yes" to make the Catalog contents appear on the front end site; select "No" to

hide the Catalog from the front-end site.

Once done setting up your catalog attributes, select OK to save the catalog. You will be brought back to
the Catalog List with the new catalog. Select Cancel to cancel out of the Catalog Edit page and back to
the Catalog List.

JERCE Catalog Edit

Owverview
Catalog Name: Everything
catalog narme description

Catalog owner: | |j

Mot Set ht
Awvailable from: 12/18/2007 ﬁ 09:00 AM
Expires on: 12/18/2020 il 09:00 AM
Default Currency: | ys dollar E

Default Language: |English (United States) ||
Base Weight: in pounds E‘

Other Languages: | English (United States)
Cerman (Cermany)

Spanish (Spain)
French (France)

Sites:

Sort Order: 0

Available: @ Yes ™ Na
oK || Cancel |

Importing and Exporting Catalogs
Preexisting catalog data can be imported or exported quickly to and from the Commerce Manager.
Accessing the Import & Export Functions

1. Access the Catalog List page in the Catalog Management subsystem. The Import/Export menu is
located in the upper left corner of the main window.

2. For exporting catalogs, click on the check box for the appropriate catalog nodes.

3. Click on the Import/Export pull-down menu to choose either import or export. The corresponding
page will appear in the main window.

IERCE Catalog List

i Mew Catalog ;.'EIIn’||::u:|rt_.‘E)q:lu:ur‘l:*lr l._"}_‘1I"--'II:rrvaﬁu:tiu:rr‘ls*lr
O Nap | % CS‘u’ImpDr‘tCatalng{'__"J
|:| ﬂ‘é‘, Ewi ﬂg Import Catalog
|:| ﬂ‘é'] Br ﬂi‘] Export Catalog
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Importing Catalogs

Browse and select the file to upload.

Click on the Upload file button. The files upload will appear in the list below.

Click on the Start Import button. The progress window will show that the import is taking place.
When the importis 100% complete, close the progress window.

PoN=

Import Catalog ) sion: 5.1 (build: 24)
ECF G5 Deployment (EpiS

-

@ cet Help For This Page 5

Import
It is strongly recommended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then click the button 'Start Import' to start importing

Add New F@
Files Available For Import:
Actions File Name Size Created Last Updated
Download | Delete MobilePhoneProductCatalog.zip S.81 KB Today, 1:42 PM Today, 1:42 PM
1 Page 1 of 1 (1 items

Start Import

Exporting Catalogs
There are two ways to export catalogs in the Export Catalogs page.
1. Export everything included in the catalog node that you've selected.

e To do this, click on the Start Export button. The progress window appears and shows the status of
the export.
o When the exportis 100% complete, click on Close to close the progress window

2. Export only the desired files.

e To do this, click on the Download links highlighted in blue.

WWelcome, admin

ERCE Export Catalog

& Get Help For This Page =

Export

You're about to export a catalog. Click the button to start.

Exported Filfs List:
Actions File Name Size Created Last Updated
Download | Delets MobilePhoneProductCatalog.zip 9.81 KB Today, 1:42 PM Today, 1:42 PM
1 Page 1 of 1 (1 items)

Using CSV Files to Quickly Create Custom Catalogs

Why Should | Use a CSV File?

The CSV catalog importis a feature in the Catalog Management system that enables you to import and
manage catalog entries (such as Products, Variations/SKUs, Packages) in bulk using an excel spread-

sheet (.csv format). It is an alternative to manually creating catalog entries directly in Commerce Manager,
which can be tedious when dealing with a large amount of catalog data.

This feature enables you to accomplish these key tasks:

e Import your .csv spreadsheets and create new catalog entries in Commerce Manager.
e Setyour catalog items into a desired category structure of your choosing
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e Create entry relations to associate one entry with others (e.g., variation/SKUs will appear within a
product or a package)
e Editor delete existing catalog items..

The CSV catalog import feature can be used for your entire catalog data, or just portions of them.

Import Overview

Here are the basic steps you can take to import and set up a new catalog using the CSV import feature.
Before you start, choose an existing catalog folder or create a new one (in the Catalog Management sys-
tem) to import the CSV files to.

1. Create CSV data files (using Excel Spreadsheet, Notepad, etc.) with information about your cat-
egories, entries, and entry relations.

2. Create necessary meta fields for the new catalog entries (in the Administration system).

3. Upload the CSV data files to the CSV Import page.

4. Create a mapping file for each CSV file. A mapping file is needed to link each column of data in a
CSV file to the correct attributes in Commerce Manager.

5. Importthe CSV files and their corresponding mapping files into a specific catalog.

6. Create entry relations to associate one entry with another (e.g., a Package and a Product, a Prod-
uct and a Variation/SKU, etc.).

Format for CSV Files
CSV files you create and import into Commerce Manager need to have a particular format.

e The first row should have headers that correspond to different attributes of the data you want to

import (e.g., product name, price, description, image file location, etc.).

There are a few attributes that are in your CSV file to correctly structure your catalog:

Code: A unique code to identify each category or entry

Name: A unique name for each row of data

Entry Type (for entries only): Each row must contain one of the following five words in order for

the Commerce Manager to correctly recognize its entry type --"Variation", "Product", "Package",

"Bundle" or "Dynamic Package"

e Parent & Child Entry Code (for entry relations only): A CSV file containing these codes can spec-
ify relationships between entries (e.g., display different Variations within a Product).
Although , the following attribute is useful in creating a hierarchy in your catalog:

e Action: A command to specify the action that will be taken during the import. Choose one of the
three options: Insert/Update/Delete or I/U/D.

Note: Please make sure to specify an appropriate command for each line of the CSV files. Enter-
ing "Insert" when that data already exist, or "Update" when no data exist will give an error during
import and those line of data will not get successfully imported.

e Category Code (by comma): By assigning a category code to an entry, you can specify the cat-
egory that you want to place your entry in.
Also please note this rule:

e SEO URL: By design, this attribute that is presentin both categories and entries must be unique
for each item in your catalog. Importing files that contain more than one identical url will resultin
an error.

Mapping Types
Different mapping types are used to create the mapping files mentioned in step 4 above.

e Category w/ Meta Data — select this type to create a mapping file for your category files.

e Entry w/ Meta Data — select this type to create a mapping file for all the entry files (i.e., Packages,
Products, Variation/SKUs, Bundles, and Dynamic Packages).

o Entry Relation — select this type to create a mapping file for your entry relation file that specifies
the relationships between entries such as many SKUs to one Product, or SKUs and Products to a
Package.

e Entry Association — select this type when creating a mapping file for entry associations (Adver-
tizing other items under titles such as "You may also be interested in...

e Variation w/ Inventory — select this type to create a mapping file to import your Pricing/Inventory
data located in your Variation/SKU Edit screen.
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e Sale Price — Select this type to create a mapping file for Sale Price file, which specifies different
currencies for each item.

By selecting these options, the Commerce Manager will display different sets of Fields and Attributes for
you to manually assign to each data column of your CSV file. Figure 8 and 9 below shows the display of
the mapping files with the Category w/ Meta and Entry Relations Data type respectively. The items under
Fields and Attributes with superscripts 1 and/or 2 are headers that are required attributes that must exist
in the CSV files you are importing (1- required field for Insert, 2 — required field for Update).

Example: Importing and Setting up a New Catalog

The example below demonstrates how to use CSV import using the guidelines provided above.

Let's say you want to set up a "Baby Stuff" catalog with categories and entries as shown here in Figure 1.

{Example Catalog)
Catalog Categories & Subcategories Products Variation/SKiLls Packages
Babvy Stuff Infants — Diapering Supplies - Diapars ————  Mewbornsize —— Package NB

Size 1 Package 30 6

——— Sizel
Size 3
Wipes—— Portable
100 sheets -
300 sheets

Toddlers Potty Training Pants Blue Pants
Fink PFants
Yellow Pants

Figure 1

Prerequisite: Create a new catalog

First, create a new catalog called "Baby Stuff" in the Catalog Management system.
Step 1: Create CSV files containing data for your new entries

The example below is based on an a set of sample .csv files.
These files provide the base for the discussion in the following section.

The sample files contain the following:

BabyStuffCategories.csv
BabyProducts.csv
BabyPackages.csv
BabyVariations.csv
BabyVariationlnventoryPricing.csv
BabyEntryRelations.csv
BabyAssociations.csv
BabySalePrice.csv

CSV File Type 1 - Category File
This file specifies data for categories and/or subcategories within a Catalog.

The top line has column headers that will be matched with the Meta fields in the later steps. The headers
can also have different names. As you will see in later steps, Category Code in column 1 is important

since it specifies where the entry data will be stored. The code entered in under Parent Code in column 2
can be used to create subcategories. If the Parent Code is set to "null" or "root," then that category will be
created in the root level of a catalog. In this example, the "Infants" and "Toddlers" category will be created
at the root level, while the "Diapering Supplies" category will be located under "Infants" as a subcategory.
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A B C D E F G
1 Action Category Code Parent Code Category Mame Available from Expires on Available (True/False
2 |Insert Catl null Infants 1/1/2009 /172009 TRUE
3 |Insert Cat2 null Toddlers 1/1/2009 /172009 TRUE
4 |Insert Catll Catl Diapering Supplies 1/1/2009 5/1/2009 TRUE
5
Figure 2

CSV File Type 2 — Entry Files

These files specifies data for Catalog Entries. The Products, Variation/SKUS, and Packages CSV files for
this example are shown in Figure 3, 4, and 5 respectively.

yil B C D E F ]
1 |Action Product Code Product Name Entry Type Category Code Available from Expires on Awvail:
2 |Insert frodl Diapers Product Catl0 1/1/2009 6/1/2009
3 |Insert orod2 Wipes Product Catl0 1/1/2009 5/1/2009
4 |Insert orod3 Paotty Training Pants Product Cat2 1/1/2009 6/1/2009
=
Figure 3
yil B C D E F G
Variation Category
1 |Action Code Variation Mame Entry Type  Code Available from  Expireson |
2 |Insert WVarl Diapers - Newbaorn size Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
3 |Insert Var2 Diapers - size 1 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
4 |Insert Var3 Diapers - size 2 Variation Catlo 1/1/2009 6:00 10/1/2012 18:00
5 Insert Vard Diapers - size 3 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
& Insert ‘ars Diapers - size 4 Variation Catl0 1/1/2009 6:00 10/1/2012 18:00
7 Insert ‘arG Training Pants - Blue Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
8 Insert Var7 Training Pants - Pink Variation Cat2 1/2/2009 11:00 10/1/2012 18:00
9 Insert arg Training Pants - Yellow Variation Cat2 1/2/2009 11:00 10/1,/2012 18:00
10 | Insert War9 Baby Wipes - Portable 80 ct Variation Catll 1/2/2009 11:00 10/1/2012 18:00
11 |Insert Warlo Baby Wipes - 300 ct Variation Catl0 1/2/2009 11:00 10/1/2012 18:00
12 Insert Warll Baby Wipes - 700 ct Variation Catl0 1/2/2009 11:00 10,/1/2012 18:00
13
14
Figure 4
A B C D E F G
1 |Action Package Code Package Mame Entry Type Category Code Available from Expires on  Availa
2 |Insert Package NB  Mewborn Package Package  Catll 1/1/2009 12/31/2010
3 Insert Package3to6 3to6mo Package Package  CatlD 1/1/2009 12/31/2010
4
Figure 5

CSV File Type 3 — Entry Relations File

This file is used to link one entry to others. In this example, Var1 ~ Var5 (different diaper sizes) are asso-
ciated to Prod1 "Diapers," Var9 ~ Var11 (different quantity for wipes) are associated with Prod2 "Wipes"
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and so forth. Also some variations are assigned to packages. Please note that the Prod, Var and Package
codes MUST BE the codes from the entry CSV files (Figure 3, 4, and 5). If you include codes that are not
defined in the entry CSV files, you will get an error while importing them into Commerce Manager in Step

4.
. B C D

1 |Action Parent Entry Code Child Entry Code

2 |Insert Prodl Warl

3 |Insert Prodl Var2

4 |Insert Prodl Var3

5 |Insert Prodl Vard

6 |Insert Prodl Vars

7 |Insert Prod2 Varg

& |Insert Prod2 Varld

9 |Insert Prod2 Varll

10 |Insert Prod3 Varg

11 |Insert Prod3 Var7

12 |Insert Prod3 Vars

13 |Insert Package MB Warl

14 |Insert Package MB Varll

15 |Insert Package3ton Var2

16 |Insert Package3ton Warlo

17

Figure 6

CSV file type 4 - Associations file

This file is used to create associations between different entries. In this example, Var 10 is associated to
Var 1 as an Accessory, and Var 2 to Var 1 as a cross-sell item.

A B C D E
1 Action  Baby Catalog Association Mame Parent Entry Code Child Entry Code Sort Order 2
2 |Insert Accessories Varl Varld 1 C
3 |Insert Customers Who Bought This Item Also Bought Varl Var2 2 (
4
Figure 7

CSV file type 5 - Pricing/Inventory file

This file is used to specify the information for the Pricing/Inventory tab of each individual entry.
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A B C ¥ E F G H J
Track Inventory
1 |Acticon |Entry Code Price |Tax Category | (TruefFalse) Warehouse Weight Package Min Quantity Max Quar
2 |Update Varl 16.99|General Sales TRUE Default Warehouse 1| box 1
3 |Update Var2 17.9%9|General Sales TRUE Default Warehouse 1| box 1
4 |Update Var3 17.9%9|General Sales TRUE Default Warehouse 1| box 1
5 |Update |Vard 18589 | General Sales TRUE Default Warehouse 1| box 1
& |Update Vars 1859 | General Sales TRUE Default Warehouse 1| box 1
7 |Update Vart 25.59% | General Sales TRUE Default Warehouse 1| box 1
g2 |Update Vary 25.59% | General Sales TRUE Default Warehouse 1| box 1
S |Update Vark 25.9% | General ales TRUE Default Warehouse 1| box 1
0 |Update Varg 445 General Sales TRUE Default Warehouse 1| box 1
11 |Update Varll 15.88 General Sales TRUE Default Warehouse 1 box 1
12 |Update |Varll 2599 | General Sales TRUE Default Warehouse 1| box 1
13
Figure 8

CSV file type 6 - Sale Price file

This file is used to specify the information for the Pricing section of the Pricing/Inventory page.

A B C D E F G H |

1 Action Entry Code Sale Type 5ale Code Unit Price Currency Start Date End Date

2 |Insert Varl BBV1 16.99 UsD 1,/1/2009 6:00 10/1,/2009 18:00
3 |Insert Var2 BBVZ 17.99 UsD 1/1/2009 6:00 10/1/2009 18:00
4 Insert Var3 BBV3 17.99 UsD 1/1/2009 6:00 10/1/2009 18:00
5 |lnsert Vard EEV4 18.99 UsD 1/1/2009 6:00 10/1/2009 18:00
6 |Insert Vars BBVS 18.99 UsD 1,/1/2009 6:00 10/1,/2009 18:00
7 |Insert Varg BBVE 25.99 UsD 1/2/2009 11:00  6/3/2009 23:00
& |lnsert Var7 BBVT 25.99 UsD 1/2/2009 11:00 6/2/2009 22:00
9 |Ilnsert Varg BEBVE 25.99 UsD 1/2/2009 11:00 6/1,/2009 19:00
10 |[Insert |Var9 BBV 4.49 UsD 1/2/200911:00 6/2/2009 22:00
11 |Insert VarlD BEVI1O0 15.99 UsD 1/2/2009 11:00  6/2/2009 22:00
12 [Insert Varll EEV11 25.99 UsD 1/2/2009 11:00 6/2/2009 22:00
13

Figure 9

Step 2: Create necessary meta fields for the new catalog entries

For this example, no additional meta fields need to be created because the sample spreadsheet uses
only the default attributes.
To create new meta fields follow these steps here.

frame.

e Go to the Administration system in Commerce Manager.
e Selectthe "Catalog System" folder and then "Meta Classes" node located in the left navigation

Select Create New, then New Meta Class from its pull-down menu.

e Enterin a Name, Friendly Name (e.g., Baby Catalog), and some description
(optional) for the meta class, and choose "Catalog Entry" for Entry Type.
e Click OK to save the new class.
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e Enterin a Name, Friendly Name (e.g., Baby Diaper Size), and some optional
description.

e Also Choose the data type for this meta field and other properties by clicking on the
checkboxes.
Click OK to save the new field.
Repeat the steps to create all the necessary fields.

e Associate the new meta fields to the meta class you created.

Select to "Meta Classes" node on the left navigation frame again.

For "Element" choose "Catalog Entry" in the pull-down menu.

Under "Type" choose your meta class (e.g., Baby Catalog) you created earlier.
Select the desired meta fields from the list displayed at the bottom of the screen.
Select OK to save the new meta class to fields association.

e You are done with setting up your meta fields.

Step 3: Upload the CSV data files to the CSV Import page

Follow these steps to prepare the CSV files for import:

e Selectthe Catalog Management system.

e In the upper-left detail area, click on Catalogs folder and you will see the Catalog List view in the
main area.

e In the action area above the main view, click the Import/Export drop-down button and select CSV
Import Catalog.

e You will now see the CSV Import Catalog page in the main screen. The screen contains two tabs
1) CSV Import and 2) Mapping File, which we will be talking about next.

CSV Import Tab

In the "CSV Import" tab in the main view, click "Add New File."

Browse for the CSV file you wish to import, then click "Upload File."

When you get the "Uploaded File:" confirmation, click "Save the file."

The CSV file you uploaded will be added to the "Files available for import:" list.
Repeat the previous four steps for each CSV file you wish to upload.
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It is strongly recommended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new ane. Then dick the button 'Start Impart’ to start impao

Add Mew File

Files Available For Import:

Actions File Marme Size Cres
Download | Delete BabySalaPrice.csv 151 bytes Todan
Cownload | Delete BabyAssociations.csv 215 bytes Todan
Cownload | Delete BabyEntryRelations.csv 254 bytes Todan
Cownload | Delete BabyVariaticnInventoeryPricing.csv 1.52 KB Todan
Cownload | Delete BabyVariations.csv i.20 KB Todan
Cownload | Delete BabyPackages 259 bytes Todan
Dovwnload | Delete BabyProducts.csv 2685 bytes Todas
Dovwnload | Delete BabyStuffCategories.csv 274 bytes Todas
1
Choose mapping file.

Actions File Marne Size Creat

Choose catalog for import.

Catalog: | grands

| Start Import

Figure 10

Step 4: Create a mapping file for each CSV file

Now create a mapping file that will specify the data in the CSV file to its corresponding attributes in the

Commerce Manager.

Mapping file tab

e Click the "Mapping file" tab in the main view. You will now see the "Mapping file" tab view of the
CSV Import Catalog view as shown in Figure 11.
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CSV Import Mapping file

Edit existing mapping file.

Load mapping file. | BabyProducts xmi v
MetaClass, Language Data File And C5V Adjustment
Mapping Type: Category w/ Meta Data » Data File: BabystuffCategories, cov v
Default Catalog Mode s Delimiter: . v
Language: English {United States) v t Qualifier: " I
oding: Default -
Fields and Attributes Column headers in the data file Custom values
Action (Insert/Update/Delete or IUD) [ column 1 - Action v
Column 2 - Category Code w
Column 3 - Parent Code v
Column 4 - Category Name N
Column 5 - Available from v

«Custom value >

Column 1 - Action

Column 2 - Category Code
Column 3 - Parent Code

fFalse) Column 4 - Category Mame
Column 5 - Available from
Column 6 - Expires on

Column 7 - Available (TruefFalse)
Column 8 - Sort Order

£
v
A
v
-
v
»
Sawve mapping file.

Figure 11
Edit existing mapping file section

¢ Load mapping file: This section is used to retrieve previously created and saved mapping files.
Since there is no existing mapping file in this example, leave this section blank.

Meta Class, Language section

e Mapping Type*: Select "Category w/ Meta Data"
e Meta Class*: Select "Default Catalog Node"
e Language™: English

Data fle and CSV adjustment section

e Data File*: The drop down values presented here are dependent on the different CSV data files

you uploaded on the "CSV Import" tab in step 2.
e Forthis example, first choose "BabyStuffCategory.csv."Leave the rest of the field as default and

move on to the next section.

Fields and Attributes, Column headers in the data file, and Selected values section

The values presented under the "Fields and Attributes" column are representative of the "Meta Class"
selected in the "MetaClass, Language" section above (which were either previously imported or created
within Commerce Manager).

The values presented in the drop-down menus under the "Column headers in the data file" column are
representative of the "Data file" selected in the "Data file and CSV adjustment" section above (which were
previously imported above).

e Select the appropriate "Column header" drop-down value to "map" with the MetaClass "Fields and
Attributes" to the left; the value selected will be reflected in the "Selected values" column to the
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right.
Save mapping file section

e Enter a file name for the "Enter file name" textbox. For this example, save the mapping files using
the same CSV file names.

e Click the "Save" button. The browser returns to the CSV Import tab, and the mapping file in . XML
format will be added to the listin the "Choose mapping file" section.

Repeat Step 3 to create and save a mapping file for each CSV files you wish to import.

For CSV Entry files, select the "Entry w/ Meta Data" option under "Mapping Type."

For CSV Entry Relations file, select "Entry Relation".

For CSV Associations file, select "Entry Association."

For CSV Pricing/Inventory file, select "Variation w/ Inventory."

For CSV Sale Pricing file, select "Sale Price."

When all the mapping files are saved, your CSV Import tab screen should look something like this.

csV Import || Mapping file
Itis strongly recommended that you back up your ECF database before performing import.

To import catalog, please pick up an existing file from the grid below or upload a new one. Then cick the button 'Start Import’ to start importing.

Add New File

Files Available For Import:

Actions File Name Size Created Last Updated

138 bytes  Yesterday, 4:35 PM Yesterday, 5:14 PM

215 bytes  Yesterday, 4:33 P Yesterday, 4:33 FM

354 bytes  Yesterday, 4:33 P Yesterday, 4:33 FM

ventoryPricing.csv 1.54 KB Yesterday. 4:23 PM Yesterday. 4143 PM

1.20 KB Yesterday, 4:23 FM Yesterday, 4:21 FM

253 bytes  Yesterday, 4:21 PM Yesterday, 4:21 BM

359 bytes  Yesterday, 4:21 P Yesterday, 4:21 FM

BzbyStuffCateg 274 bytes  Yesterday, 4:21 P Yesterday, 4:21 PM
1 Page 1 of 1 (& iterns)

Choose mapping file.
Actions File Marne Size Created Last Updated

Dovnload | Delsts BazbySalefrice.xml 2.82 KB Yesterday, 4:43 FM Yesterday, 4:35 FM

Delete EabyAssociations.xm| 2.05 KE Yesterday, 4:42 PM Yesterday, 4:42 PM

Delsts EazbyEntryRelstions.xml 1.57 KB Yesterday, 4:42 FM Yesterday, 4:42 FM

Delete BzbyVariationlnventaryPricing.xml 5.22 KB Yesterday, 4:41 PM Yesterday, 4:30 PM

Delete EzbyVariations.xml 4.12 KB Yesterday, 4:40 PM Yesterday, 4:40 FM

Delets BabyPackages.xml 4.11 KB Yesterday, 4:38 FM Yesterday, 4:38 FM

Delete BabyProducts.xml 4.14 KB Yesterday, 4:38 PM Yesterday, 4:38 BM

Dovnlosd | Delsts EzbyStuffCatagory.xml 4.63 KB Yesterday, 4:37 FM Yesterday, 4:37 FM
1 Page 1 of 1 (& itemns)

Choose catalog for import.

A

Start Import

Figure 12

Step 5. Import the CSV files and their corresponding mapping files into a specific catalog
Atthe "CSV Import" tab view (Figure 12), do the following:

e Selectand highlight the CSV file you wish to importin the "Files available for import" section. For
this example, select BabyStuffCategories.csv.

e Selectand highlight the mapping file that corresponds to the selected CSV file in the "Choose
mapping file for import" section. For this example, select BabyStuffCategories.xml.

e Select the catalog in the "Catalog" drop-down into which you would like to import your CSV data.
In this example choose "Baby Stuff".

e Click the "Startimport" button. You will see the "Importing catalog" modal dialog box which will
notify you of the percentage of completion as well as logging messages.
Click "Close Window" at the bottom of the modal dialog to complete the operation.
Repeat Step 4 to import all the remaining CSV & Mapping pairs.

Step 6. Verify Your Import

In the Catalog Management system, expand the "Baby Stuff" folder under Catalog and verify that the con-
tents of your CSV file were imported into the appropriate catalog.
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Deleting a Catalog
1. Atthe Catalog List page, check off the box to the respective Catalog you wish delete.
2. Select More Actions and then Delete Selected from its pull-down menu, located in the menu bar.

3. A pop up will appear to confirm your action. Select OK to delete it. The chosen catalog will be deleted
from the list.

ERCE Catalog List

|4 New Catalog i‘]Ir1’||':||:|rt_.-'Exr:n:ur‘l:*lr iIMDrE Actions

[l Marre | #  Delete Selected
|
ﬂ‘é‘l Ewerything

[l M Brands
i !
Message from webpage @

I Are you sure you want to delete selected iterns?

Ok ] ’ Cancel

L A

Categories and Nodes

A Category or a Node is a grouping of purchasable Products. In this section, you will learn how to browse,
create, clone, move, link, and delete Categories and Sub-Categories.

Browsing Categories

The Node List (aka the Category List) is used to organize and manage nodes/categories, subcategories
created within a Catalog.

The "Brand" Catalog for example, which is available in the Commerce Manager by default, includes
nodes assigned with brand names such as "Canon", "IZOD", and "Dell". Also the Everything Catalog con-
tains a node called "Mobile Phones & Plans" which has subcategories called "Phones" and "Plans". Addi-
tional nodes or subcategories may be created in the Node List page.

1. Clicking on the memo icon, located between the check box and the folder icon, will display the Cat-
alog Node Edit page, which contains more information and settings of that particular node. Here
you can setup the information and status that are common for all it's subcategories.

2. Clicking on any node names (highlighted in blue) will take you to the next sublevel, which shows
the list of categories under the selected node.
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Dl:reate Mew ill".-'lnrﬂhctinns'

|:| Marme

Menu Bar Functions

e Create New

& ) Daily specials
O ) pigital Cameras
[l
[l

= El Digital Downlcads

El Maobile Phones & Plans
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This dropdown allows users to create different types of Categories/Nodes or Product entries as

shown below.

Product

Package
Bundle

e More Actions

o Delete Selected
e Clone Selected

Category/Node

Variation/SKU

Dynamic Package

e Move/Link to Folder

Under "More Actions," cloning creates a duplicates with a unique ID that you can place in any loca-
tion/hierarchy that you choose. "Move/Link to Folder" allows you either to move a category/product to a
new location/hierarchy or to link one category/product to another category/product. So for example, you
can create a category called "Featured Products" and link it to items across various other categories. This
way, if you make changes to content on the original product page and that same product is part of the
"Featured Products" category as a linked product, the changes will be displayed in both locations. In

other words, changes are bi-directional. Links can be broken if either of the two are deleted.

Node List

DCreatE Mew ;EII'l--'I|:|r|=1,E'u:ti|:|r151Ir

E MNew Category /Mode
) Mew Product

il MNew Variation /Sku
B Mew Package

% Mew Bundle

g4 Mew Dynamic Package

Lns
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ERCE Node List

Dl:reate New fg’]l'l.-'lu:ure Actions ™

Mame | " Delete Selected
9 paill 23 Clone Selected

[l
[l
&l EIDigi L} Move/Link to folder
[l

EI Digital Downloads

I:l EIMI}'}”EPHI}HES&P'ELHS

Creating a Category

1. To create a new category, click on Create New and then click on New Category/Node.

ERCE Node List

D Create New~| | || More Actions ~

I Mew Category/MNode {TJ

i

() MNew Product

=i New Variation /Sku
H Mew Package
AL New Bundle

#% New Dynamic Package

This page will appear when creating a new category or editing an existing one. The Catalog Node Edit
page will contain information of a Node selected from the Node List page.
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Welcome, admin

Catalog Node Edit ) ersion: 5.1 (buid: 2

nt |

@ Cet Help For This

Overview = SEO Assets

Mame

catalog node name description

Available from: 5/25/2010 ﬁ 01:59PM
Expires on: 52572011 ﬁ 01:59 PM
Display Template: EntriesTemplate lz‘

Code:

Sort Order: 0

Available: T1Yes @ No

Meta Class: Default Catalog NUdElZ‘

Display Name (en-us):

Display Name (de-de):

Display Name (es-es):

Primary Image (en-us):

Description (en-us):

Primary Image

CssClass - | Paragraph - | Default Font ~ | Size -

EA A =N D-|>1111<
BIUESSCoA- Y- [CEsFE=esoEErk| 10 ngwe a3

Overview Fields

Name - enter a name for the product

Available from - the date to which the productis activated

Expires on - the date on which the product expires; once the expiration date passes, the product
will no longer appear on the public site

Display Template - choose a display template used to show the products in the public site from
this dropdown box; by default, the only available catalog display template is "Digital Camera". To
create your custom template, you will need some technical skills with html templates.

Code - enter a product code here (e.g. DIGICAM)

Sort Order - determines the order to which the product is sorted in the Node List page

Available - select Yes to make the product appear on the public site; select No to hide the product
from the public site

Meta Class - the choice made here dictates which the meta-fields or product attributes will appear
on the public site or Commerce Manager site

Display Name - enter a name the way you like to be displayed in the public site with appropriate
languages

Primary Image - use the browse button to select and upload an image here

Description - enter a description of a product with appropriate languages

Once done, click OK on the bottom of the page.

SEO

Search

Engine Optimization can be achieved by entering the following information for the product.

e Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window
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e Description - this is the meta description that is used for SEO purposes by search engines
e Keywords - keywords used for SEO purposes by search engines

Catalog Node Edit

Owverview SEOQ Asczets
Title {(en-us):
Url {en-us):
Description (en-us): -
Keywords (en-us): -
Title (de-de):
Url (de-de):
Description (de-de): -
Keywords (de-de): -
Title (es—as):
Url (es-es):
Description (es-es): -
Keywords (es-es): -
814 || Cancel
Assets

Under Assets, you can associate additional files such as images, pdf, and video files all stored in the
Asset Management system.

JERCE Catalog Node Edit

Overview SEO Assets

Find Assets: T | |Add Asset

Croup Name: |default

Edit Cormrnand  ID Type Marne Graup Sort Order

Page 1 of 0 {0 iterns)

| QK || Cancel |

Follow these three simple steps to add an asset file to the current entry.
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1. Click on the Find Assets pull-down menu to display all files available in the Asset system.

2. Choose one file at a time and type in an appropriate Group Name (see table below), depending
now how you would like it to be displayed.

3. Click on Add Asset. The asset associated to this entry will appear in the lower section of the
screen.

e You can edit the Group Name or sort order by clicking on the Editicon to the left of an existing
asset. After making any changes, make sure to click Update (Clicking OK at the bottom of the
screen during the editing mode will not save the changes made).

e You can delete any existing asset by clicking on the "X" icon.

File type How it gets displayed in the public site

mage Files (jpg, pgn, etc.) image Thumbnail icon will appear on the product details page

Downloadable Files (docs, A "Downloads" tab will appear towards the bottom of the
Downloads .
pdf, mp3s) details page

A "Specifications" tab will appear towards the bottom of

Specification Files (docs, pdf) Specifications the details page

ERCE Catalog Node Edit i

Lic

Overview SEO Assets

Find Assets: Root/Video/ -

Group Name: default

Edit Command 1D Type Marme Group Sart Order
=
| >< el folder Root/Video/ default lu]
1 Page 1 of 1 {1 iterns)
| (o] || Cancel |

Deleting a Category
1. To delete a category/node, go to the Node List.
2. Checkmark the box next to the node.

3. Click on More Actions and then click on Delete Selected to delete the Category/Node.

ERCE Node List

Dl:reate Mew ;EII"-'IDrE Actions ™

[ Marne |>( Delete Selected

) paill 23 Clone Selected

[l ElDigi ™3 Move/Link to folder
=
=

E' Digital Downloads

= Mobile Phones & Plans

Organizing Categories

To organize a category, enter a numerical order in the Sort Order field within the Catalog Node Edit
page. Categories and node will sort based on numercial order.
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ERCE Catalog Node Edit

Overview SEO Assets

Name: Phone Accessories
catalog node narme description
Available from: 8/5/2008 [ 10:00 PM
Expires on: 8/5/2009 m 10:00 PM
Display Template: EntriesTemplate ||
Code: phone-accessories
Sort Order: ol
Available: h.b.\"es @ No
Meta Class: Default Catalog Node [+

Display Name (en-us). |phone Accessories
Display Name (de-de):
Display Mame (es-es):

Primary Image (en-us):

Primary Image

Creating a Sub-Category
To create a sub-category, itis similar to creating a high-level category.

1. Go to Node List and click through an existing Catalog
2. Click on Create New and click on Category Node. Specify the information under Catalog Edit
(refer to Creating a Category) and click OK to save changes.

Node List

DCreate Mew ;Eil'u'lure.ﬁ.ctiuns'
|:| Marne

EIII}'ELH',.r Specials

El Digital Cameras

El Digital Downloads

(]
(]
(]
(]

= Mohbile Phones & Plans
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== Node List

DCreate New~| | |&] More Actions~

I Mew Category/Mode ’\“._")J

) MNew Product

il New Variation/Sku ro Series 52 15 GMP with 12x Image Stabilized Zoom

Ea New Package ro Series 55 |5 3.0MP Digital Camera with 12x Optical Image

45 Mew Bundle

#% New Dynamic Package

Cloning, Moving or Linking a Category

Under "More Actions," cloning creates a duplicates with a unique ID that you can place in any loca-
tion/hierarchy that you choose.

"Movel/Link to Folder" allows you either to move a category/product to a new location/hierarchy or to link
one category/product to another category/product. So for example, you can create a category called "Fea-
tured Products" and link it to items across various other categories.

This way, if you make changes to content on the original product page and that same productis part of

the "Featured Products” category as a linked product, the changes will be displayed in both locations. In
other words, changes are bi-directional. Links can be broken if either of the two are deleted.

1. To link a category, go to the Node List and checkmark a category you want linked back.

2. Click on More Actions and then click Movel/Link folder.

3. Selectlink to folder and select the link destination from the dropdown menu. Click OK to create the
link to that category under that directory.

ERCE Node List

DCreate Mew ;}_‘IMDrE Actions~

[ Mame | % Delete Selected

= [Il:lpa” |23 Clone Selected

O = [E'Digi
O
O

3 Move/Link to folder

= D Digital Downloads

= [r_;l' Mabile Phones & Flans

Move/Link to Folder ®

Tymove or @) link to folder: Everything /Digital Downloads b

| oK | | Close
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Products, Variations and SKUs, Bundles, Packages, Dynamic Packages and
Associations

A product represents various forms of merchandise that you can display and purchase from the public
site, including Products, Variations/SKUs, Bundles, Packages and Dynamic Packages.

e Product Entries
A product entry typically contains a product name, part number, description and images.

e Variations/SKUs
A variation or SKU corresponds to a specific type of product with specific characteristics. For
example, a product of Shirts will have an individual variation/SKU which includes size, color and
sleeve length.

e Bundles
a bundle is a collection of Variations and SKUs allowing customers to purchase two or more items
atonce (all pricing is SKU specific and separate, unlike a package which is multiple SKUs put
together in a single unified price).

o Packages
A package is comparable to an individual SKU because the package item must be purchased as
a whole (i.e. computer system).ltems can be put within a package and package can have its own
unique pricing.

e Dynamic Packages
A dynamic package is similar to the package definition above with the added ability to configure
the package during checkout.

e Associations
One or more products can be associated to a product so that they can be displayed advertised on
the public site as product accessories, or upselling/cross-selling item. Associations can be made
from any of the individual products (Product Entries, SKUs, Bundles, Packages, and Dynamic
Packages).

Browsing Products

Products are created within a catalog. Products can be placed one level beneath the root of a Catalog
and further down into subfolders.

To browse products, click on a Catalog and drill down categories until you see Products such as the one
highlighted below in the second screenshot..

Welcome, admin

Catalog List Product Version: 5.1 (build: 24)
License: ECF G5 Deployment (|

@ Get Help For This P

|_4 New Catalog ..2] Import/Export~ if] More Actions ~

|:| Marne Available fram Expires Status
B ﬂg Everything 12/18/2007 9:00:00 AM 12/18/2020 9:00:00 AM  True
= 48 Brands 6/24/2008 7:00:00 PM 6/24/2020 7:00:00 PM True

ERCE Node List

DCreatE Newr | [ More Actions~

|:| Marme

il

=i Camera Accessories
MV Canon PowerShot AS70IS 7.1MP Digital Camera with 4x Optical Image Stabiliz%Znnm
M canon PowerShot AGD 2ZMP Digital Camera with 2x Optical Zoom

MV Canon PowerShot A70 3.2MF Digital Camera w/ 3x Optical Zoom

p

T T
g EEE
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To create a product, click through an existing catalog and click on Create New and then click on Create

Product.

ERCE Node List

DCreatE Mew iIMl:urE Actions ™

1 Mew Category/Mode

| ) Mew Product

i New Variation [ Sku
B4 Mew Package

% New Bundle

g4 Mew Dynamic Package

Lns

Overview Tab

This is where you enter basic information about the Product.

Name - a name for the product.
Available from - the date to which the productis activated

e Expires on - the date on which the product expires; once the expiration date passes, the product

will no longer appear on the public site

e Display Template - choose a display template used to show the products in the public site from
this dropdown box; by default, the only available catalog display template is "Digital Camera". To

create your custom template, you will need some technical skills with html templates.

Code - enter a product code here (e.g. DIGICAM).
Sort Order - determines the order to which the product is sorted in the Node List page.
e Available - select Yes to make the product appear on the public site; select No to hide the product

from the public site

e Meta Class - the choice made here dictates which the meta-fields or product attributes will appear
on the public site or Commerce Manager site.
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Product Edit

J Overview Variations /5KUs SEQ Associations Assets Felations

Mame:
Available from: 6/21/2011 % 02:38 PM
Expires an: 6/21/2021 £ 02:38 PM

Display Template: | pigital Camera Template IE‘

Code:
Sort Order: 0
The sart order for the category entry.
Available: ™ Yes i@ Mo
Meta Class: Default Catalog Entry E
OK || Cancel

Depending on the meta class selected, more fields are available to enter data. For instance, selecting the
Digital Camera meta class will yield digital camera meta fields and attributes.

Overview Variations/SKUs SEQ Associations || Assets
Name
Available from: 5/27/2010 [ 08:41 AM
Expires on: 5/27/2011 [ 0841 AM
Display Template Digital CamaraE
Code:
Sort Order: o

The sort arder for the category entry.
Available: (1 Yes @ No
Meta Class: Digital Cameras Iz‘

Display Name (en-us):
Display Mame (de-de):

Display Name (es-es)

Primary Image (en-us):

Primary Image

Description (en-us):

Css Class -~ | Paragraph - | Default Font - | Size - j? $ Ea@ 9 ™ | T
EoAV | ErEFEsafer [ Nanage0d

B 7 U=

Variations/SKU Tab

Variations/SKUs are subcategories of a Product, which represents different "variations" of the particular
product (colors, sizes, different editions for example). Such Variations/SKUs can be grouped a chosen
product from this tabbed page. Follow these steps to group variations/SKUs.

1. Select the Variations/SKUs tab
Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate
with the product.

3. Click on Add Item.
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Product Edit

Overview | Variations/SKUs SEQ Associations Assets Felations

Find Item: | 7

M Yltimate Ears-Metro.fi 150 Noise I=olating Earphones I:B|E|C|-C]|.;.I

Edit Com " 510 Headset Charger GCroup
" Blantronics Yoyager 510 - Bluetooth Headset Carrying Case
" Adapter Car Lighter Explorer / Voyager

II i Apple Iphone PDA& Premium Reusable LCD Screen Protector
i Apple iIPhone Soft Polycarbonate Slim fit Case- Silver - Cozip
" Apple iPhone 1G Soft Polycarbonate Slim fit Case -Black({Co:
i Headphone Adapter for Apple iIPhone Recessed Jack, 3.5mm

I Creative Headphones HQ-140

" Koss SPARKPLUG - Stereo In Ear Ear Plugs -

You can add multiple associations to the product and they will appear in a list under the column headers
below.

Overview Variations /5KUs || SEO || Associations || Assets || Relations |

Find Item: | Apple Iphone PDA Premium Reusable LCD Screen Protector with Li = | |Add ltem

Edit Command [n] MName Oty Croup Sort Order
x 2 510 Headset Ch... 1 default 0
x 5 Apple Iphone PD... 1 default 0

1 Page 1 of 1 (2 items)

Ok || Cancel |

SEO Tab
Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window

Description - this is the meta description that is used for SEO purposes by search engines
Keywords - keywords used for SEO purposes by search engines

O If the URL field is left empty, it will be automatically filled in with a generated url (which
depends on the entry name). If the URL field is not empty (you entered some url), it will be
saved as itis, and w will not be changed automatically even if you change an entry name. If
you need the url to change, leave it blank.
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Product Edit

Overview || Variations | SKUs

‘ SEO H Associations || Assets H Relations

Title (en-us): Digital Camera Powershot

Url (en-us):

Description (en-
us):

ik

Keywaords (en-us):

iF

Title (de—de):
Url (de-de):

Description (de- -
de):

Keywords (de-de). -
Title (es-es):
Url (es-es):

Description (es-es):

i

Keywords (es-es):

i

| OK || Cancel |

Associations Tab

Different products or variations/SKUs can be linked to this product. Follow these steps to create product
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

Product Edit

&) Get Help For This Page 3

| Overview || Variations /SKUs || SEQ || Associations || Assets || Relations |

Add an association

Modify Existing Association: = |EditDet,aiI5| |Modif\rAssociation| |Delete|

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order. Once
you're done, click on Save Changes.
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Edit Association Information

MName: cts
Enter association name.

Description:

s

Enter association description.

Sort Order: 1
Enter sort order.

3. The new association will appear in the drop-down list.

| Relations

| Overview H Pricing /Inventory || SEC || Associations || Assets

- ||Edit Details| [Modify Association| [Delete]

CTS

Maodify Existing Association:

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

‘ Overview || Pricing /Inventory H SEQ || Associations || Assets H Relations |

- ||Ed'n: Detalls| [Mouaify Association| [Detete]

Modify Existing Association: | CTs

CTS
Summer Campaign
Pick ltem: | hd |
| Sort Ord Type

| Edit Command | Catalog# Entry Id | Mame

Page 1 of O (0 items)

5. Click on Modify Association and you can edit the name, description, and sort order of an existing asso-

ciation.
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Edit Association Information

Mame: cts
Enter association name.

Description: o

Enter assaciation description.

Sort Order: |1
Enter sort order.

You can also Delete an association if needed.

‘ Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |
Modify Existing Association: ‘ Crosssell v | |Edit Details] [Modify Association| [Delete]

6. Pick an item or items to add to the association. Click Add Item to do so.

Pick ltem: -

Edit Co W Ultimate Ears-Metro.fi 150 Noise Isclating Earphones (L'-;J Sort Order

Type

I 510 Headset Charger

II I plantronics Voyager 510 - Blustooth Headset Carrying
M Adapter Car Lighter Explorer / Voyager I}‘
Ml Apple Iphone PDA Premium Reusable LCD Screen Pro
Ml Apple iPhone Soft Polycarbonate Slim fit Case- Silver
i Apple iPhone 1G Soft Polycarbonate Slim fit Case -Bla
i Headphone Adapter for Apple iPhone Recessed Jack, ©
Ml Creative Headphones HQ-140

M koss SPARKPLUG - Stereo In Ear Ear Plugs =

7. Once you click on Add ltem, the item will appear in a list just below. You can have more than one item
tied to an association.

Pick Item: | Creative Headphones HO-140 -
Edit Command Marme Sort Order Type
| >< 510 Headset Charger o] OPTIONAL
| >< Creative Headphones HQ-140 u] OPTIONAL
| QK || Cancel |

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.
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Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system.

1. Under Find Assets, select from the drop-down list and click Add Asset.

Welcome, admin

Variation/SKU Edit . Version:
@ CetHelp F
Cverview || Pricing /Inventory || SEO || Associations || Assers || Relations |

Find Assets: | ¥ | |Add Asset
Group Name: | [0 poot/

D root/video/

Edit Comm = Root Presentatiors? o Sort Order
= Root/Specifications/ Page 1 of 0 (0 itemns)

I: i Root/Saoftware/

) root/Downloads/
D Root/User Guides/
) Root/Images/

2. Enter a Group Name.

By default EPiServer Commerce offers three options with names that will allow the associated assets to
be correctly displayed on the product details page of the public site.

¢ Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |
Find Assets: Root/Presentations/ ¥ | |Add Asset

Croup Name: PowerPoint

Edit Command [ Type Mame Croup Sort Order

Page 1 of O (0 items)

| QK || Cancel |

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.
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| Owverview || Pricing/Inventory || SEQ || Associations || Assets || Relations

Find Assets: Root/Presentations /Presentation Powerpoint.pptx w7

Croup Name: |default

Edit Command 1D Type Name Croup Sort Order
Pt 1 file Root/Presentati.... default 0

1 Page 1 of 1 (1 items)

| OK || Cancel |

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a product is linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

CMms Commerce EPISERVER @ ? ~ AL admin~ Q

Commerce Manager Settings

EPISERVER COMMERCE Variation/SKU Edit

Change Language About ™ @ et Help For This Page +

Welcome ™

@

Catalog Management | T H e e H SEO H oo H [ || Relations

== Catalog Management

, Catalog Entry Search o Name Catalog Full Path

@ Catalog Batch Update X digital-cameras  Digital Cameras Everything| Digital Cameras

o Catalegs ¥ dailyspacials Daily Specials Everything |, Daily Spacials
@ [ Everything
&[] Brands

Templates
a0
ﬁ Dashboard

Customer Management
a

Catalog Management
? Order Management
% Marketing

/ﬂ Asset Management
{ﬁ Administration f i +

1 Page

I

Editing Product Tabs

When editing a Product, options are divided by tabbed navigation.
Overview Tab

This is where you enter basic information about the Product.

Name - a name for the product
Available from - the date to which the productis activated

e Expires on - the date on which the product expires; once the expiration date passes, the product
will no longer appear on the public site

e Display Template - choose a display template used to show the products in the public site from
this dropdown box; by default, the only available catalog display template is "Digital Camera". To
create your custom template, you will need some technical skills with html templates.
Code - enter a product code here (e.g. DIGICAM1, DIGCAMZ2,...)
Sort Order - determines the order to which the product is sorted in the Node List page
Available - select Yes to make the product appear on the public site; select No to hide the product
from the public site
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e Meta Class - the choice made here dictates which the meta-fields or product attributes will appear

on the public site or Commerce Manager site

Product Edit

J Overview Varnations /SKUs SEQ Associations Assets Felations
Name:
Axvailable from: 6/21/2011] % 02:35 PM
Expires on: 6/21/2021 (] 02:38 PM

Display Template: | pigital Camera Template IE'

Code:
Sort Order: )
The sort order for the category entry.
Available: ™1 ¥es @ No
Meta Class: Default Catalog Entry IZ'
oK || Cancel

Depending on the meta class selected, more fields are available to enter data. For instance, selecting the
Digital Camera meta class will yield digital camera meta fields and attributes.

Overview | Variations/SKUs SEO Associations Assets

Name

Available from: 5/27/2010 ﬁ 08:41 AM
Expires on: 5/27/2011 [ og.41 am

Display Template Digital CamaraE

Code:

Sort Order: o

The sort arder for the category entry.
Available: (1 Yes @ No
Meta Class: Digital Cameras [=]

Display Name (en-us):
Display Mame (de-de):
Display Name (es-es)

Primary Image (en-us):

Browse...

Primary Image

Description (en-us):

Csg Class ~  Paragraph - | Default Font - || Size -
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Variations/SKU Tab

Variations/SKUs are subcategories of a Product, which represents different "variations" of the particular
product (colors, sizes, different editions for example). Such Variations/SKUs can be grouped a chosen

product from this tabbed page. Follow these steps to group variations/SKUs.

1. Select the Variations/SKUs tab

2. Within the drop-down menu next to Find Item, select from the list variations or SKUs to associate with

the product.
3. Click on Add Item.
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Product Edit

Overview | Varnauons/5KUs SEQ Associations Assets Felations

Find Item: | S

" ltimate Ears-Metro.fi 150 Noise Izolating Earphones (Blackjl.;.l

Edit Com 1l 510 Headset Charger Croup
" plantronics Yoyager 510 - Bluetooth Headset Carrying Case
i Adapter Car Lighter Explorer / Voyager

II i Apple Iphone FOA Premium Reusable LCD Screen Protector
i Apple iIPhone Soft Polycarbonate Slim fit Case- Silver - Cozip
" Apple iPhone 1G Soft Polycarbonate Slim fit Case -Black(Co:
i Headphone &dapter for Apple iPhone Recessed Jack, 3.5mm
" Creative Headphones HQ-140

I koss SPARKPLUG - Stereo In Ear Ear Plugs -

You can add multiple associations to the product and they will appear in a list under the column headers
below.

Overview Variations {5KUs || SEOQ || Associations || Assets || Relations |

Find Item: | Apple Iphone PDA Premium Reusable LCD Screen Protector with Li = | [Add ltem

Edit Command 1D Name ity Croup Sort Order
x 2 510 Headset Ch... 1 default 0
X 5 Apple Iphone PD.... 1 default 0

1 Page 1 of 1 (2 items)

Ok ” Cancel |

SEO Tab
Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window

Description - this is the meta description that is used for SEO purposes by search engines
Keywords - keywords used for SEO purposes by search engines

O If the URL field is left empty, it will be automatically filled in with a generated URL (which
depends on the entry name). If the URL field is not empty (you entered some URL), it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.
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Product Edit

Overview || Vanations /SKUs H SEO H Associations H Assets || Relations

Title {en-us): Digital Camera Powershot

Url (en-us):

Description (en- -
us): B
Keywords (en-us): -
Title (de-de):

Url {de-de):

Description (de- -
de): B
Keywords (de-de): -
Title (es-es):

Url (es-es):

Description (es-es): -
Keywords (es-es): -

QK || Cancel

Associations Tab

Different products or variations/SKUs can be linked to this product. Follow these steps to create product
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Information.

" N ] N f——
Edit Association Information X
MName: cts
Enter association name.
Description: -~
Enter association description.
Sort Order: 1
Enter sort order.
Save Changes

3. The new association will appear in the drop-down list.
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| Overview H Pricing /Inventory || SEO || Associations || Assets || Relations ‘

- ||Ed'lt Detalls| [Mouiry Association| [Delete]

Modify Existing Association: | CTs

4.You can also choose to Edit Details, which will allow you to edit associated items. The Pick Item drop-

down appears below Modify Existing Association.

‘ Overview || Pricing /Inventory H SEO || Associations || Assets H Relations |

- ||Edit Details| [Modify Association] [Delete]

Modify Existing Association: | CTS

CTs

Summer Campaign
5

Pick Item:

Sort Ord Type

Edit Command Catalog# Entry Id MName

Page 1 of O (0 items)

5. Click on Modify Association and you can edit the name, description, and sort order of an existing asso-

ciation.

Edit Association Information

Mame: cts
Enter association name.

Description:

Enter association description.

Sort Order: ]
Enter sort order.

You can also Delete an association if needed.

‘ Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |
Modify Existing Association: | |Crosssell - | |Edit Details| [Modify Association| [Delete]

6. Pick an item or items to add to the association. Click Add Item to do so.
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Pick ltem: -

Edit col ™" Ultimate Ears-Metro.fi 150 Moise Isclating Earphones ( '_.:f Sort Order Type
"'510 Headset Charger
II " Plantronics Voyager 510 - Bluetooth Headset Carrying
" Adapter Car Lighter Explorer / Voyager h‘

" Apple Iphone PDA Premium Reusable LCD Screen Pro
" Apple iPhone Soft Polycarbonate Slim fit Case- Silver
" Apple iPhone 1G Soft Polycarbonate Slim fit Case -Bla
"' Headphone Adapter for Apple iPhone Recessed Jack, -

" Creative Headphones HQ-140

" koss SPARKPLUG - Stereo In Ear Ear Plugs -

7. Once you click on Add ltem, the item will appear in a list just below. You can have more than one item
tied to an association.

Pick Item: | Creative Headphones HQ-140 -
Edit Command Marme Sort Order Trpe
| X 510 Headset Charger o] OPTIONAL
| >< Creative Headphones HQ-140 u] OPTIONAL
| OK || Cancel |

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
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Variation/!
& GetHelp F

| Overview || Pricing /Inventory || SEQ || Associations || Assets || Relations |
Find Assats: | ¥ | |Add Asset
Croup Name: ElRootf

E'Rootﬂ'\!ideo;"

Edit Comm ElRuutfPresentatiunsf 0 Sort Order
= Root/Specifications/ Page 1 of 0 (0 items)

|: = Root/Software/

= Root/Downloads/
= Root/User Guides/
= Root/Images/

2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

Overview || Pricing/Inventory || SEQ || Associations || Assets || Relations |

Find Assets: Root/Presentations/ ¥ | |Add Asset

Croup Name: | PowerPoint

Edit Cammand ] Type Mame Croup Sort Order

Page 1 of 0 (0 items)

| (o184 || Cancel |

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

Overview || Pricing /Inventory || SEO || Associations || Assets || Relations

Find Assets: Root/Presentations /Presentation Powerpoint.pptx -

Croup Name: |default

Edit Command o] Type MName Croup Sort Order
X 1 fila Root/Presentati_.. default 0

1 Page 1 of 1 (1 items)

OK || Cancel |
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4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a product is linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

CMms Commerce EPISERVER @ ? ~ AL admin~ Q

Commerce Manager Settings

EPISERVER COMMERCE Variation/SKU Edit

e
- a
Change Language About @ Cet Help For This Page +

Welcome ™

@

Catalog Management | T H e e H SEO H oo H [ || Relations

== Catalog Management

, Catalog Entry Search o Name Catalog Full Path

@ Catalog Batch Update X digital-cameras  Digital Cameras Everything| Digital Cameras
5 Catalogs

& () Everything

& (] Brands

Templates
a0
ﬁ Dashboard

Customer Management
@
Caralog Managemen: -

? Order Management
% Marketing

/ﬂ Asset Management
{ﬁ Administration f i +

Setting Pricing Data at the Product Level

X dailyspecials Daily Spacials Everything| Daily Specials

1 Page

I

By default EPiServer Commerce ships with the ability to set pricing information at the variation/SKU level.
In certain implementations it may be preferable to set pricing information at the Product level and/or the
variation/SKU level. This can be accomplished by editing a configuration file to add the EntryP-
ricingEditTab to the list of tabs available at the Product level.

For more information see the section "Setting Pricing Data at the Product Level" in the EPiServer Com-
merce Developer's Guide.

Creating a Variation or a SKU

1. To create a new variation/SKU for a product, go to Catalog Management and Catalogs, and then
click on an existing catalog. The Node List window appears.
2. Select Create New and New Variation/Sku. The Variation/SKU Edit window appears.

Overview Tab

This is where you enter basic information about the Variation/SKU.
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J Overview Pricing /Inventary SEQ Associations Assets Relations

Mame:
Available from: g1 /2011 EH | 01:22 M
Expires on: B/1/2021 ﬁ 01:22 PM

Display Template: | pigjtal Camera Template ||

Code:
Sort Order: 0
The sort order for the category entry.

Available: 71 Yes @ Mo

Meta Class: Default Catalog Entry IE'
| oK || Cancel |
Fied __ [Descripion ..
Name Enter a friendly name, which can include spaces and special characters.

Available from Enter the date and time the SKU will be available and active.

Expires On Enter the date and time the SKU will be unavailable and deactivated.

Chose a display template used to display the Variation/SKU in the public site from this
Display Template drop-down menu. By default, the only available catalog display template is "Digital Cam-
era," however additional templates can be developed.

Code Enter a value without special characters or spaces, such as "BlueShirtXL."
Enter a numerical value to determine the SKU's sort order on the list of variations and
Sort Order SKUSs

Set"Yes" to activate the SKU. Set "No" to keep the SKU inactive and unsearchable on the

Available front-end site.
Select from the drop-down menu a particular Meta Class (add link to how meta classes are
Meta Class created). Depending on the meta class you select, additional fields will appear in the Over-

view tab. The values entered within the fields of the meta class you selected will be shown
on the front-end public site.

Pricing/Inventory Tab

Under this tab, you can set specific pricing and inventory settings for the variation/SKU.
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Display Price:
(wsd)

Min. Quantity:

Max. Quantity:

Merchant:
Weight:

Package:

Tax Category:
Warehouse:

Track Inventory:

Inventary Status: DisamedIE‘

Pricing
Add Item

Edit Command

Commerce Manager | 99

100

select merchantIE‘

1.0

select packageIE‘

select tax categor',rlz‘

select warehouse E‘

In Stock:

Reserved:

Reorder Min.
Qty:
Allow Preorder:

Preorder Qty:

Prearder Awvail.:

Allow Backorder:

Backorder Oty:

| OK || Cancel |

Backorder Avail.:
@ No

Sale Code Currency Price Min. Quantity Start Date

Fied __________[Descripon |

Display Price
Min Quantity

Max Quantity

Merchant

Weight

Package

Tax Category

Warehouse

Track Inventory

Inventory Status

Enter the price that will be displayed on the public site.

This sets the minimum quantity the customer is able to purchase the variation/SKUs
product page.

This is the maximum allowable number of items that can be purchased at one time
(this number gets displayed as the upper range in the drop-down during the check-
out process).

Optional: if you use many merchants on your site, this provides another way to add
more information for a product; this can only be added/edited directly in the data-
base so please contact your site administrator/developer to make any changes.

Based on your shipping configuration, the weight you enter here will affect the total
shipping cost .

This value is based on width/length/height dimensions; the options for this drop-
down are configured in the Administration area.

This separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for
"General Sales" items and another rate for "Luxury Sales" items.

The details on the available selections are maintained in the Administration sys-
tem.

Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and Back-
order fields will be deducted each time a purchase is made. If this is setto "No,"
then those values will not change.

Enable/Disable. If this is Enabled, then the number of units of a product being pur-
chased cannot exceed the inventory value. In other words, the check out procedure
cannot be completed if you exceed the number in the inventory -- instead the quan-
tity you can purchase will default to the actual number of remaining units. For
instance, if you have Tracking Inventory = Yes, and Inventory Status = Dis-
abled/Ignored, then the available quantity will be monitored, but it will not limit the
number of units that can be checked out. If you only have a quantity of 5 and you
order 6 items, the checkout will still complete and the inventory number will become
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Fied __________[Descripon |

-1.

In Stock You can enter the quantity of a particular product available for sale.
The quantity you set here allows you to reserve a specified number of inventory "In
Reserved Stock" and prevent them from being used. So for instance, if you set the In Stock =

10 and Reserved = 5, then the In Stock count will not go below 5.

If the inventory falls below the value specified here, then this item will appear in the
"Low Stock Report" in the Dashboard or Reporting system.

Allow Pre- Yes or No; you need to set Allow Preorder/Backorder status to Yes to turn either of
order/Backorder these features On.

Reorder Min Qty

When you turn on either of the two and specify a quantity, the count will begin to
decrease after the In Stock count reaches its limit. For example, if you set In Stock =

:l"’eac;lrder/Backorder 10, Reserved =3, and Backorder =10, then the Backorder qty will start to decrease
after In Stock count reaches 3. So if you place an order for 10 units, then the final
count will be In Stock = 3, Reserved =3, and Backorder=7.

Backorder Qty The quantity you set here will determine the backorders that can be made by cus-

tomers even when the item is out of stock.

Sale Type - you can select All Customers, a single Customer or a Customer Price
Group (the Customer Price Group gives you the ability to create tiered pricing).
Sale Code - This is an optional setting. The Sale Code field is used for assigning a
price to a specific group of customers. For instance, when you add a new price and
select "Customer Price Group" as the Sale Type, you need to put the name of the
customer group in the Sale Code field. The name of the group that you putin the
Sale Code field needs to match one of the group names found under Customer
Pricing Management > Contacts > (Name of Contact). If your entry into the Sale Code
field matches one of the Customer Groups, any member of that group will receive
the specified price.

Unit Price - discounted price per unit “*Currency * enter currency using the correct
currency code (i.e. USD); you can create different prices depending on the currency
thatis selected.

Min. Quantity - minimum number of units you must purchase to get the discounted
bulk rate.

SEO Tab

Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area.

URL - this is what gets displayed in the browser URL window.

Description - this is the meta description that is used for SEO purposes by search engines.
Keywords - keywords used for SEO purposes by search engines.

O If the Url field is left empty, it will be automatically filled in with a generated url (which depends
on the entry name). If the Url field is not empty (you entered some url), it will be saved as itis,
and will not be changed automatically even if you change an entry name. If you need the url to
change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Variation/SKU. Follow these steps to create
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.
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4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.

6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a productis linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

Creating a Package

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.

3. Click on Create New pull-down menu located in the upper left part of the main window.

4. On the drop-down menu, select New Product Package. The Product Package Edit page appears.

Overview Tab
This is where you enter basic information about the Product Package.

Name - a name for the Product Package
Available from - the date to which the Product Package is activated

e Expires on - the date on which the Product Package expires; once the expiration date passes, the
Product Package will no longer appear on the public site

e Display Template - choose a display template used to show the Product Package in the public
site from this dropdown box; by default, the only available catalog display template is "Digital Cam-
era". To create your custom template, you will need some technical skills with html templates.
Code - enter a Product Package code here (e.g. DIGICAM).
Sort Order - determines the order to which the Product Package is sorted in the Node List page.

e Available - select Yes to make the Product Package appear on the public site; select No to hide
the product from the public site
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Meta Class - the choice made here dictates which the meta-fields or Product Package attributes
will appear on the public site or Commerce Manager site

Pricing/Inventory Tab

Display Price - the price that will be displayed in public site

Min Quantity - this forces your customer to purchase a minimum number of items as set here (this
number gets displayed as the lower range in the dropdown during the checkout process)

Max Quantity - this is the maximum allowable number of items that can be purchased at one time
(this number gets displayed as the upper range in the dropdown during the checkout process)
Merchant - (optional) if you use many merchants on your site, this provides another way to add
more information for a product; this can only be added/edited directly in the database so please
contact your site administratior/developer to make any changes

Weight - based on your shipping configuration, the weight you enter here will affect the total ship-
ping cost

Package - this value is based on width/length/height dimensions; the options for this dropdown
are configured in the Administration area

Tax Category - this separation of taxes by category allows you to charge a different rate of taxes
depending on whatis being purchased; for example, you can have one rate for "General Sales"
items and another rate for "Luxury Sales" items

Warehouse - the details on the available selections are maintained in the Administration Sub-
system

Track Inventory - Yes/No. If this is set to "Yes," then the quantity value of In Stock, Preorder, and
Backorder fields will be deducted each time a purchase is made. [fthis is setto "No," then those
values will not change.

Inventory Status - Enable/Disable. If this is Enabled, then the number of units of a product being
purchased cannot exceed the inventory value. In other words, the check out procedure cannot be
completed if you exceed the number in the inventory -- instead the quantity you can purchase will
default to the actual number of remaining units. For instance, if you have Tracking Inventory = Yes,
and Inventory Status = Disabled/Ignored, then the available quantity will be monitored, but it will
not limit the number of units that can be checked out. If you only have a quantity of 5 and you order
6 items, the checkout will still complete and the inventory number will become -1.

In Stock - you can enter the quantity of a particular product available for sale

Reserved - The quantity you set here allows you to reserve a specified number of inventory "In
Stock" and prevent them from being used. So for instance, if you set the In Stock = 10 and
Reserved = 5, then the In Stock count will not go below 5.

Reorder Min Qty - If the inventory falls below the value specified here, then this item will appearin
the "Low Stock Report" in the Dashboard or Reporting subsystem.

Allow Preorder/Backorder - Yes or No; you need to set Allow Preorder/Backorder status to Yes to
turn either of these features On.

Preorder/Backorder Avail - When you turn on either of the two and specify a quantity, the count
will begin to decrease after the In Stock count reaches its limit. For example, if you set In Stock =
10, Reserved =3, and Backorder =10, then the Backorder qty will start to decrease after In Stock
countreaches 3. So if you place an order for 10 units, then the final count will be In Stock = 3,
Reserved =3, and Backorder = 7.

Backorder Qty - The quantity you set here will determine the backorders that can be made by cus-
tomers even when the item is out of stock.

Pricing .

e Sale Type - you can select All Customers, a single Customer or a Customer Price
Group (the Customer Price Group gives you the ability to create tiered pricing).

e Sale Code - (optional) enter code to give special pricing for a group of Customers
(i.e. Dealers).

e Unit Price - discounted price per unit.

e Currency - enter currency using the correct currency code (i.e. USD); you can
create different prices depending on the currency thatis selected.

e Min. Quantity - minimum number of units you must purchase to get the discounted
bulk rate.

For more information regarding Sales Type, Sales Code and tiered pricing, please read
Creating a Contact.
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Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Package
by clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO Tab
Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window

Description - this is the meta description that is used for SEO purposes by search engines
Keywords - keywords used for SEO purposes by search engines

O If the Url field is left empty, it will be automatically filled in with a generated url (which depends
on the entry name). If the Url field is not empty (you entered some url), it will be saved as itis,
and w will not be changed automatically even if you change an entry name. If you need the url
to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Product Package. Follow these steps to create
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.

6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.
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Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a product is linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

Creating a Bundle

1. Click on Catalogs. The Catalog List appears on the main window.

2. Click on an existing catalog name highlighted in blue. The Node List window appears.
3. Click on Create New pull-down menu located in the upper left part of the main window.
4. On the drop-down menu, select New Bundle. The Bundle Edit page appears.

Overview Tab
This is where you enter basic information about the Product Package.

e Name - a name for the Bundle

e Available from - the date to which the Bundle is activated
Expires on - the date on which the Bundle expires; once the expiration date passes, the Bundle
will no longer appear on the public site

o Display Template - choose a display template used to show the Bundle in the public site from this
dropdown box; by default, the only available catalog display template is "Digital Camera". To
create your custom template, you will need some technical skills with html templates.
Code - enter a Bundle code here (e.g. DIGICAM).
Sort Order - determines the order to which the Bundle is sorted in the Node List page.

e Available - select Yes to make the Bundle appear on the public site; select No to hide the product
from the public site

e Meta Class - the choice made here dictates which the meta-fields or Bundle attributes will appear
on the public site or Commerce Manager site

Bundle Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Bundle by
clicking Add Item. Clicking the Edit icon beside the item you just added will allow you to specify the
Quantity, the Group Name and the Sort Order.

SEO Tab
Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window

Description - this is the meta description that is used for SEO purposes by search engines
Keywords - keywords used for SEO purposes by search engines

If the URL field is left empty, it will be automatically filled in with a generated URL (which
depends on the entry name). If the URL field is not empty (you entered some URL), it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.

e

Associations Tab

Different products or variations/SKUs can be linked to this Bundle. Follow these steps to create asso-
ciations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.
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4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.

6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.
2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page

3. Once an asset is added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a productis linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

Creating a Dynamic Package

Click on Catalogs. The Catalog List appears on the main window.

Click on an existing catalog name highlighted in blue. The Node List window appears.

Click on Create New pull-down menu located in the upper left part of the main window.

On the drop-down menu, select New Dynamic Package. The Product Dynamic Package Edit
page appears.

Pobd=

Overview Tab
This is where you enter basic information about the Product Package.

e Name - a name for the Dynamic Package

e Available from - the date to which the Dynamic Package is activated
Expires on - the date on which the Dynamic Package expires; once the expiration date passes,
the Product Package will no longer appear on the public site

e Display Template - choose a display template used to show the Dynamic Package in the public
site from this dropdown box; by default, the only available catalog display template is "Digital Cam-
era". To create your custom template, you will need some technical skills with html templates.
Code - enter a Dynamic Package code here (e.g. DIGICAM).
Sort Order - determines the order to which the Dynamic Package is sorted in the Node List page.
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e Available - select Yes to make the Dynamic Package appear on the public site; select No to hide
the product from the public site

e Meta Class - the choice made here dictates which the meta-fields or Dynamic Package attributes
will appear on the public site or Commerce Manager site

Package Items Tab

In the dropdown, you can search through your entire inventory and select items to add to your Dynamic
Package by clicking Add Item. Clicking the Editicon beside the item you just added will allow you to
specify the Quantity, the Group Name and the Sort Order.

SEO Tab
Search Engine Optimization can be achieved by entering the following information for the product.

Title - this is the friendly name that appears in your browser's title area

URL - this is what gets displayed in the browser URL window

Description - this is the meta description thatis used for SEO purposes by search engines
Keywords - keywords used for SEO purposes by search engines

O If the URL field is left empty, it will be automatically filled in with a generated URL (which
depends on the entry name). If the URL field is not empty (you entered some URL), it will be
saved as itis, and will not be changed automatically even if you change an entry name. If you
need the URL to change, leave it blank.

Associations Tab

Different products or variations/SKUs can be linked to this Dynamic Package. Follow these steps to create
associations:

1. Click on Add an Association. A pop-up window will appear that says Edit Association Infor-
mation.

2. When the pop-up appears, enter an Association Name, Description, and define the Sort Order.
Once you're done, click on Save Changes.

3. The new association will appear in the drop-down list.

4. You can also choose to Edit Details, which will allow you to edit associated items. The Pick ltem
drop-down appears below Modify Existing Association.

5. Click on Modify Association and you can edit the name, description, and sort order of an existing
association.

You can also Delete an association if needed.

6. Pick anitem or items to add to the association. Click Add Item to do so.

7. Once you click on Add Item, the item will appear in a list just below. You can have more than one
item tied to an association.

You can Edit an item on the list. You can change the Sort Order and the Type. Once you're done mod-
ifying the values, click on Update to save your changes. Otherwise select Cancel to navigate away with-
out saving.

Assets Tab

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management subsystem.

1. Under Find Assets, select from the drop-down list and click Add Asset.

2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated assets to be
correctly displayed on the product details page of the public site.

e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product details page
e Downloads - a "Downloads" tab will appear towards the bottom of the details page
e Specifications - a "Specifications" tab will appear towards the bottom of the details page
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3. Once an assetis added to the list below, you can choose to edit specific assets, such as their Group
name and Sort Order.

4. Once done, click OK and the new category/node will be created. You will be redirected to the Node
List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Relations Tab

Here the relations for a product will be displayed, and you can manage the categories a productis linked
to. This is useful in order to get an overview of all the different categories (nodes) where a product will
occur. A product can for instance appear in the "French Market" category, as well as under "Daily Spe-
cials" and "Digital Cameras". Browse to a product and open it for editing. The relations for the product will
be displayed under the Relations tab.

Creating Product Associations

Product Associations help you to highlight certain products in your public site. For example, one or more
products can be related to or associated to another product so that these associated products can be dis-
played or advertised on the public site as a product accessory, or as an up-selling/cross-selling item.
Associations can be made from any of the individual products (Product Entries, SKUs, Bundles, Pack-
ages, and Dynamic Packages). (Product Entries, Variations/SKUs, Bundles, Packages, and Dynamic
Packages).

To create Product Associations go to the edit screen of any type of product entry listed above and select
the Associations tab. Out of the box, you can associate related products or accessories or cross-sell dif-
ferent kinds of products ("You May Also Like").

CrossSelling Other Products - "What You May Like"

1. Click on the Add an association button to enter the name "CrossSell" (without the quotes), an
optional description and sort order number. Click Save Changes to save and exit the screen.
CrossSell should appear in the dropdown menu.

2. Nextselect the new association that you just created from the drop-down menu and click on Edit
Details.

3. Use the drop-down menu to add one or more products and select Add Item to save the asso-
ciation. The items you have added to this association will render on the product detail page under
"You May Also Like" on the default template.

Associating Related Products and Accessories

1. Click on the Add an association button to enter the name "Accessories" (without the quotes), an
optional description and sort order number. Click Save Changes to save and exit the screen.
Accessories should appear in the drop-down menu.

2. Nextselect the Accessories product association that you just created from the drop-down menu
and click on Edit Details.

3. Use the drop-down menu to add one or more products and select Add Item to save the asso-
ciation. The items you have added to this association will render on the product detail page under
"Related Products and Accessories" on the default template.

Managing Assets

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system and then these
Assets can be associated with Catalog entries..

In order for the Asset files to correctly display in catalogs, you'll need to configure your Internet Information
Services (lIS). Find out more Displaying Assets section of the Developer Guide for EPiServer Commerce.

Associating Additional Digital Materials with Catalog Entries

Assets are downloadable contents such as documents, links, videos, and images that can be linked to
specific products. Assets are uploaded and managed in the Asset Management system.
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1. Under Find Assets, select from the drop-down list and click Add Asset.

EPISERVER COMMERCE Variation/SKU Edit

Welcome ¥ Change Language About ™

]
Caimon Mansocmen, = ‘ Overview || Pricing/Inventory || SEQ || Associations H Assets Relations
™= Catalog Management
|, Caralog Entry Search Find Assets: | Root/Images/phonejpg * | |Add Asset
@ Catalog Batch Update Croup Name: default
=5 Catalogs
= Everythin,
=23 LTI Edit Command [a] Type Name Croup
=15 Mobile Phones & Plans
1+ [_]Plans
+ Phones
| 50
1 Dinital Downloads

2. Enter a Group Name.

By default Commerce Manager offers three options with names that will allow the associated
assets to be correctly displayed on the product details page of the public site.
e Image - (type as "image," all lowercase) thumbnail icon(s) will appear on the product
details page.
Downloads - a "Downloads" tab will appear towards the bottom of the details page.
Specifications - a "Specifications" tab will appear towards the bottom of the details page.

Overview || Pricing /Inventory || SEQ || Associations || Assets || Relations |

Find Assets: Root/Images/phone jpg T | |Add Asset

Croup Name: image

Edit Command [} Type Name Croup Sort Order

Page 1 of 0 (0 items)

| QK || Cancel |

3. Once an assetis added to the list below, you can choose to edit specific assets, such as their
Group name and Sort Order.

Overview || Pricing/Inventory || SEO || Associations || Assets || Relations |

Find Assets: Root/Images/phone jpg T | |Add Asset

Croup Name: |image

Edit Command [n] Type Mame Croup Sort Order
)( 2 file Root/lmages /p... image o

1 Page 1 of 1 (1 items)

| (o184 || Cancel |

4. Once done, click OK and the new category/node will be created. You will be redirected to the
Node List. Otherwise, select Cancel to go back to the Node List without saving any changes.

Searching for Entries in Your Catalog
The Catalog Search function enables you look for specific sales items stored in the Commerce Manager.

1. Click on Catalog Management and then Catalog Entry Search.
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Catalog Management ;::1‘
_\, Catalog Entry Search {bj
@ Catalog Batch Update
=+ Catalogs
[ ] Everything
[ Brands

2. To do a basic search for catalog entries, enter a one keyword or more into the Search by Keywords(s)
field, such as "canon digital cameras". The search will return entries that match either of those keywords.

3. Ifyou input keywords around quotation marks ("canon digital cameras"), then search will only fetch
entries that have those exact three keywords.

Entry Search

Search By Keyword(s): canon digital cameras | search
Additional Filters

Filter By Language: English (United States) ]
Filter By Catalog(s): all catalogs IE'

Search By Code/Id:

IERCE Entry Search

Search By Keyword(s): “canon digital cameras” | Search |
Additional Filters

Filter By Language: English (United States) =

Filter By Catalog(s): all catalogs E

Search By Code/Id:

Catalog Search Filters

To narrow entry search results, there are Additional Filters available. Click search once those filters are
set.

o Filter by language: Pull-down menu will show the available language choices
o Filter by catalog(s): Pull-down menu will show the available catalog choices
e Search by codelid: Instead of text, you can search by code or ID

Search By Keyword(s): | Search [
Additional Filters

Filter By Language: English (United States) [~]
Filter By Catalog(s): all catalogs |E|
Search By Code/Id: 395 R

Deleting and Cloning Entries

Users can Delete and Clone entries. To delete or clone an entry:
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1. Selectan entry or entries by checkmarking the box next to it.
2. Click on More Actions.
3. Click on Delete Selected or Clone Selected .

The entry will either be deleted or a clone (copy) of it appears.

Entry Search

Search By Keyword(s): | Search
Additional Filters

Filter By Language: English (United States) (]
Filter By Catalog(s): all catalogs |E|

Search By Code/Id:

;EI Maore Actions

#  Delete Selected D
53 Clone Selected ro.fi 150 Noise Isclating Earphones (Black) 1
" 510 Headset Charger 2
M plap ronics Voyager 510 - Bluetocoth Headset Carrying Case 3
[ [ Adapter Car Lighter Explorer | Voyager 4

Paging and Sorting Results

Users can sort results by clicking on Name, ID, Available From, Expires, and Status in either ascending
or descending order.

i More Actions

[ mame & Auailable from Expires Status
[E [ Apple 1phone PDA Premium Reusable LCD Screen Protector with Lint Cleaning Cloth 8/18/2008 2:49:48 PM 5/19/2018 2:49:48 PM  True
B Apple iPhone Soft Polycarbonate Slim fit Case- Silver - Cozip Brand (Made in Korea) 6 8/18/2008 2:49:49 PM 8/19/2018 2:49:49 PM True
O (i Apple iPhone 1G Soft Polycarbonate Slim fit Case -BlackiCozip Brand) Made in Korea 7 8/18/2008 2:49:49 PM 8/19/2018 2:459:49 PM True

Users can also change the Page Size ranging from 10 entries to All entries.
D ﬂ':"' Apple Ipod 3rd Generation Nano 4gb 8gb Tran

I:l ,l_":"l Apple iPod Armband for iPod nano 1G (Pink)

Page Size: 20 E

To page through multiple entry results, users can click on the paging controls on the lower-right corner of
the main window.

(125 items) | Page 41 2345 ... »

Updating Multiple Catalog Entries at Once

This area gives you the ability to quickly make mass changes to your catalog. You can sort by Entry
Type, Meta Class, Field, Language, Catalog and Keyword(s). Once you apply one or more of these
filters, the search results will appear in the bottom half of the screen.

If you make changes to the entry, click Save All to save all of your catalog updates.
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Clicking on a result, such as the example below, will direct you to the entry's edit page.

ERCE Batch Update

Main Adjustment iti Filters

Entry Type: Variation /Sku lz‘ Language: English {United States) E

Meta Class: Digital Cameras lz‘ Catalog/Category: all catalogs E

Field Entry : Name lz‘ Keyword(s):
Iy save An

Marme Entry : Mame

i ) . L
U Canan Powershot Pro Series 55 IS 8.0MP Digital Camera |canon powershot Pro Series S5 15 8.0MF|Digital Camera with 12x Optical Image sta
with 12x Optical Image Stabilized Zoom

un . .
U Cancn PowerShot SX10015 8MP Digital Camera with 10% [c2non PowerShot SX1001S 8MP Digital Camera with 10x Optical Image Stabilized Z{
Optical Image Stabilized Zoom (Silver)

i ; . .
" Canon PawerShot AS701S 7.1MP Digital Camera with X [cnon Powershot AS701S 7.1MP Digital Camera with 4x Optical Imags Stabilized Zd
Optical Image Stabilized Zoom

Order Management

The Order Management System provides shopping carts, order capture, order fulfillment, and payment
function support. Features and functionality include return merchandise authorization (RMA), support for
item exchanges, and Ul enhancements.

The Order Management System, in most respects, works much differently compared to previous versions
of EPiServer Commerce. The overall order management workflow involves the Customer Management
System, as orders are now directly attached to individual contacts.

Order Workflow

The order workflow is described in the topics of this section.

Creating a New Order

Option 1: Creating an Order Within a Contact

1. Go to Customer Management > Contacts and create or click on an existing contact. The contact
details appear.
2. Click on New Order.

EPISERVER COMMERCE View

Welcome ¥ Change Language About 7

-
AR DAL S Edit ¥ Delete Contact ﬂ Contacts D New (Qirde
= m Customer Management
o Full Name: admin ' arent Organization:
@ Organizations
[g Contacts Infor i Information
& Roles Information | — Contact
Addresses Full Name: admin Cus
Credit Cards
Security First Name: admin Pref
Roles Middle Name: Pref
Orders Last Name: Regi
Order History
Shopping Lists Parent Organization: Last
Wish Lists
Shopping Carts Preferred Shipping
Address:
Preferred Billing
Address:
1)
s Account ————— Edit Account |

3. The New Order pop-up window appears. Select the site to apply the order to and click OK. The
Purchase Order New form appears, allowing users to enter basic information about the order.
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Filling Out the New Purchase Order

1. Enter Basic Order Information.

—Basic Order Info

Customer: admin

Currency: |US dollar E

Coupon Code: 1234567 |  « Apply |

Field _[Description |

Customer This is the name of the contact.
Currency Select from the drop-down list the currency to associate with the Purchase Order.

Coupon codes created with a promotions can be applied here to associate with the Pur-

Coupon chase Order. Click Apply once code is entered.

Advanced Search

You can apply three filters to refine your item search results.

MNew Lineltern

Advanced Search

Select catalog |E| Select language IE‘ Select entry type E

Field Description

Select catalog  Select which specific catalog to search

Select language Select a specific language (such as German) for items described in German
Select entry type Select a specific type of entry, such as variation/sku or bundle
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Configuring the Selected Entry

1. Before you add the item to the order, you can configure the actual price, the quantity, and apply a per-
centage or discount based discount.

LNew Lineltem

)

Selected Entry: Nextware iPhone Screen Protector 2-ph.

Display Price: $19.99

Price: |19.99
Quantity: |1
Discount: |enter descr here 0 Percentage Basedlz‘

Discount description  amount

Total: $19.99

Back | | Add itemn to the order

Required Fields

e Price
e Quantity

Fied ___|Descripon |

E:iscp;ay This is the price seen on the public website. This is set at the catalog entry level.
Price This is the actual cost of the item that will be charged when the item is added to the order.

Quantity Set how many of the item to add to the order.
Discount  You can apply a discount to the item, either Value or Percentage based.

Total The total is automatically calculated, factoring in the actual price, quantity, and any dis-
counts applied

2. Once the item is configured, click Add item to the order. The item will appear on the Purchase Order
form.

= New ltem | % Delete
D [[s] Name

Quantity  List Price Total Discount

D ELCBOOOSOVTFSe MNextvare iPhone Screen Protector 2-phk. 1

&

£19.95 $19.99 £0.00

Page Size:| 20 Iz‘ (1 items) | |

Completing the Rest of the Purchase Order Form

1. Enter a Billing and a Shipping Address.

When entering the Shipping or Billing Address, you can select an existing address associated
with the contact, if any.
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~Billing Addre: /~Shipping Addre:
Address Add new address A Address: |Add new address A
DSamE as Billing Address
Name:
Name:
First Name:
First Name:
Last Name.
Last Name:
Line 1:
Line 1
Line 2:
Line 2.
City:
R City
Country Name: United States
v [=] Country Name: United States [=]
State: Alabama E State: Alabama
Postal Code Postal Code:
Day Phone Day Phone:
Evening Phone Evening Phone:
Email Email:
[ Add to customer’s address book [7] Add to customer's address book

Checkmark Add to customer's address book if you want to save the address to the contact.

If the Shipping Address is the same as the Billing Address, click on Same as Billing Address. The
Shipping Address form is autopopulated with the information entered in the Billing Address form.
2. Selectthe kind of shipping to use for the order under Shipment Details. Select from the drop-
down the shipping methods (add link) available.
3. Click on Recalculate to generate the cost summary.

~—Shipment Details -

Shipping method: |Fixed Shipping Rate |E|

~Summary -

Item Subtotal: 315.99
Shipping Cost:  £10.00

Less Shipment Discount:  £0.00
Total Before Tax: 315.95

ltermn Taxes: 50.00

Shipment Total: %2999

4. Click OK.

Option 2: Creating an Order from Purchase Order List

1. Go to Order Management > Purchase Orders.

2. Click on New Order. A pop-up appears, allowing you to select the site and contact to apply the new
order to.
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EPISERVER COMMERCE Order List

Welcome ¥ Change Language About ™

Order Management )

j'g Order Management
(2}, Order Search
D[] Purchase Orders
@ Today

New Order =

@ This Week Site: | [No sites available]
@ This Month

Customer: NotSet ﬂ
@ All
=[] Purchase Orders By Status
(] Carts

=[] Payment Plans (recurring) E 0K ﬂ Cancel

#l[] Shipping/Receiving

ﬁ Dashboard
m Customer Management

=
Catalog Management

‘@ Order Management

3. Click OK.

4. Follow the steps above to complete the Purchase Order.
Fulfilling an Order

Once the Purchase Order form is completed, the order fulfillment process begins. The order form con-
sists of five sections:

Displays an overview of the order, including the customer information,
Summary billing address, and other data. From here you can cancel orders, edit

information, and place an order on hold.

Displays the shipment details, including shipment status, items to be
Details shipped, and a list of applied discounts/coupons. Returns/Exchanges

are also created here.

You can create and assign payments to the order here. Payments are

Payments
y automatically processed when saved.

Returns Displays the details of a return, if made.

Displays the notes attached to the order. Notes are automatically
Notes logged when certain events occur within the order (e.g. the shipment
status changed)

Processing the Order, Submitting a Payment, and Releasing to Shipping

The basic workflow from purchase order to shipping is done this way.
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1. Add a paymentto the order.

RCE Order

[ Add Note §-)Send Notifications = Add Order Address

Order No: POOS50 Customer: Mary Smith

Order Total: 559.93 Status: InProgress

| Summary | | Details | | Payments | | Returns | | Motes
Create Pavmﬁ:j

|:| r\~lart$\-_—lI| Transaction Type Amount Status
[

Page Size: | 1q0p El

Enter the amount of the payment. The Amount field auto-populates the value of the total order,
including shipping costs. However, you can change the value of the payment (useful for splitting

payments between two or more payment methods at the request of the customer).
3. Selectthe Payment Method from the drop-down list.

4. Click OK. The order goes into Edit Mode.

The Order is in the Edit Mode. Save changes before exit. | n Save | | Cancel

i A Add Note [ Send Notifications = Add Order Address

Order No: POOBS0 Customer: Mary Smith
Order Total: 35993 Status: InProgress

| Summary | | Details | | Payments | | Returns | | Notes
Creat& Payment

|:| MName Transaction Type Amount Status
[C] % PayByPhone 59.98 Pending
Page Size: | 100 El

Note: When in Edit Mode, you can add more payments to the order. However, once you click
Save, you finalize the payment. This means that you cannot further add or delete payments.
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5. Once you have finished adding one or more payments, click Save to exit Edit Mode and save your
changes. The payment gets automatically processed for the amount specified.

[ AAdd Note [ Send Notifications = Add Order Address

Order No: PO0330 Customer: Mary Smith
Order Total: 55598 Status: InProgress
| summary | | Details | | Payments | | Returns | | Notes
|:| Name Transaction Type Amount Status
|:| Pay By Phone Sale 59.9800 Processed

Page 5ize: | 100 El

6. Check the Details tab. You will see that the Shipment Status has changed to "Awaiting Inven-
tory." Once the availability of the item has been determined, click on Release Shipment to release
the order to your shipping department.

Summary Details | | Payments | | Returns ‘ | MNotes |

Shipment ¥ 1

B New Item | 7 Delete

|:| D MName Quantity List Price Tatal
D ELCEOOOTGOHAWE Apple Iphone PDA Premium Reusable LCD Screen Protector with Lint Cle...  1.00 £9.99 £9.99
I:‘ ELCEOO104U1346 Apple iPhone Soft Polycarbonate Slim fit Case- Silver - Cozip Brand (Mad_.. 1.00 $39.99 £39.99

Page Size: 100 El

«— Shipping Infor

Shipping Address:

1 Main Street, Santa Monica, California, 81823, United States Edit Shipping Address

Shipping Method:

Fixed Shipping Rate Edit Shipping Method

~— Shiij S vy i) Status Returns/Exchanges
Item Subtortal: %4998 Status: Awaiting Inventory ( ‘ ‘
Shipping cost: $10.00

Release shipment L\\

| Cancel shipment |

Shipment Total: $59.98

7. By clicking on Release shipment, the status changes to "Released." For further processing of the
order, your shipping department will go to Order Management > Shipment.

O If you click Cancel shipment, you will end up canceling the entire order. (At the moment, there
is no way to undo the cancellation, so you must be careful.)
Canceling an Order

Under the Summary tab, click on Cancel Order. This will completely cancel the order. The status of the
order changes to "Canceled."

The cancellation of the order will be logged under the Notes tab.
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Order No: POO0350 Customer: Mary Smith
Order Total: 359938 Status: Cancelled
| Summary | | Details | | Payments | | Returns | | Notes
New Itemn
|:| Originated By Date/ Time Maote Text
D 5 admin 2/21/2011 94943 AM MNew order placed by admin in ConsaoleManager
|:| & admin 2/21/2011 100116 AM MNew Other payment in the amount of $59.98 added to order
|:| 7 admin 2/21/2011 10810 AM Shipment 10 status changes to Released
|:| 3 admin 2/21/2001 111:21 AM Order status changed to Cancelled
< | - m
Page Size: ]DDl_;F

Splitting Shipments

lIf there are two or more items within an order, they can be split into separate shipments. This is useful for
expediting items within the order that are immediately ready for shipment, while other items have extra

shipping lead time.

1. Go to an existing purchase order or create a new one. The order must have two or more items.
2. Go to the Details tab in the order form. Look for Shipment # 1.

Order No: PO10728 Customer: LisaPrescott
Order Total: 5151.92 Status: InProgress

Iﬂu Details | | Payments | Returns | ‘ Notes

Shipment # 1
NEW ltem | ¥ Delete
|:| [} Name Quantity List Price Total Disc
|:| Ea' ELCEOOOFOMBBAR Plantronics Voyager 510 - Bluetooth Headset Carrying Case 1.00 £19.99 50.00
|:| E$ ELCEOOOWKSBQGCE Headphone Adapter for Apple iPhone Recessed Jack, 3.3mm Male Female... 1.00 514.95 £0.00
= Ea' ELCBOOOB1A2D06 Koss SPARKPLUG - Stereo In Ear Ear Plugs 1.00 514.99 50.00
D E$' ELCEQDOVILY426 Samsung WEPZ00 World Smallest” Bluetooth Headset (White)™ 1.00 £99.99 30.00
4 | i
Page Size: ng'

3. Select the item you want to move by clicking on the Move icon.

Shipment # 1

Ne_w Item }( Delete

0 D

1 =& ELCBODOFOMGEAG

[ % ELCBOOOTGOHAWE

] Mowe
Page Size:

4. The pop-up appears, which allows you to choose to move the item(s) to an existing shipment or
create a new shipment. You can also select the quantity of the item to move. Each new shipment
within the order can have its own separate shipping address and shipping method. Select a ship-
ping address and shipping method from their respective drop-down lists. Click OK to save your
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Cluantity to mowve:

i@ Create new shipment

T1Movwve to existing shipment

Address;

States

111 Palm 5treet, Sun City, Florida, 333445, United

Shipping Method: Croynd Shipping

[=]

" OK | | A Cancel

After splitting the shipments, the order form goes into Edit Mode. The Details page shows the new
shipment, which can be processed completely separate from one another, but tied to a single pur-

chase order.

Shipment £ 1

=/ New ltem | ¥ Delete |

Item Subtotal: $49.93

Shipping cost: $2.00

Shipment Total: $51.93

Status: Inventory Assigned

= D Name Quantity List Price Tot
(=]} ELCBOOOFOMBEAGR Plantronics Voyager 510 - Bluetooth Headset Carrying Case 1.00 $19.99 30
= ELCBOOOWEKSSQGE Headphone Adapter for Apple iPhone Recessed Jack, 3.5mm Male Female... 1.00 £14.95 50.
] ELCBOOOB1 AZDQG Koss SPARKPLUG - Stereo In Ear Ear Plugs 1.00 £14.99 50.
q .
Page Size: WDDEl

— Shippi Infor

Shipping Address:
111 Palm Street, Sun City, Florida, 333445, United States

Shipping Method:

Cround Shipping

~— Shij Si ¥ Shi Status Returns/Exchanges

| Complete shipment

| Release shipment

[ Cancel shipment
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Shipment # 2

=/ New item | ¥ Delete

(] D

Name

Quantity

List Price Total Discount

D ELCEOOOVILY426 Samsung WEP200 World Smallest” Eluetooth Headset (White)™

1.00

$99.99 £0.00

4| I

Page Size: | 100 Iz‘

~— Shi Infor

Shipping Address:

111 Palm Street, Sun City, Florida, 333445, United States Edit Shipping Address
Shipping Method:
Ground Shipping Edit Shipping Method

Release shipment
Cancel shipment

6. Click Save to save your changes made to the order form.

Viewing Purchase Orders by Date or Status

— Shi S ry Shi Status Returns/Exchanges
Item Subtotal: £99.99 Status: Inventory Assigned ( |:|
SnIPpIng cost: 5200 [—complerzshipment. ]
Shipment Total: $101.99

On the left navigation menu, you can click on the nodes below Purchase Orders and Purchase Orders
by Status. For example, clicking on Purchase Orders > Today will show the orders created today only

on the right window.

EPISERVER COMMERCE

Welcome ™ Change Language About ™

Order List

Order Management ,,%" D New Order )( Delete Selected
j.g Order Management E o Customer Total Status Last Modified
o EIEAEETED ] PoD48S Mary Smith £39.98 In Pragress Today, 11:48 AM
=[] Purchase Orders
] Po08s0 Mary Smith $59.93 Cancelled Today, 10143 AM

@ Today
= This Week [F] PO7657 Hiep Khue £495.58 In Progress Today, 10:26 AM
@ This Month
= All

Moreover, you can view orders within the Order List by status. For example, click on Purchase Orders

by Status > InProgress to view orders with that status.

EPISERVER COMMERCE Orders by Status

Order Management Eg D Mew Order >( Delete Selected
j'g Order Management | ) Customer Total Status Last Modified
R [[] Pooass Mary Smith $39.98 1n Progress Today, 11:46 AM
@[] Purchase Orders
[ Po7657 Hiep Khuc $433.98 In Progress Today, 10:26 AM
=3 Purchase Orders By Status
1 OnHold [ Po3asl Hiep Khuc $967.44 In Prograss 2/18/2011 11:48:36 AM
i Hiep Khuc £451.93 In Brogress 2/18/2011 5:58:27 AM
(] PartiallyShipped PO1537 p Kh 9 118/

(=] InProgress

(] Completed

(] Cancelled

(] AwaitingExchange

Viewing and Searching for Orders

Using Order Search to Find Existing Purchase Orders

Order Search allows you to find existing orders, giving you six different search filters to help refine your

search results. You can click on the ID number of the order to view it.
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EPISERVER COMMERCE Order Search

Welcome ¥ Change Language About ™

Order Management .fE‘ Class Type: | Purchase Order lz‘ Return #
j‘g Order Management Status [Any] lz‘ 1D
(), Order Search Date Range: | All [+] Customer

=I[Z] Purchase Orders
@ Today

F |ib Customer Total Status Last Modified

o This Week [[] PO0485  Mary Smith $35.98  InProgress  Today, 11:45 AM

@ This Month [F] POO8SD  Mary Smith $55.98 Cancellad Today, 10:49 AM

Filter Name Description

Select "Purchase Orders" on the drop-down list. Otherwise, if you want to

Class Type
yp search for a specific shopping cart or payment plan, select those.

You can filter results by their statuses. For example, if you want to find only
completed purchase orders, select from the drop-down list "Completed".

Available status options are:

OnHold
PartiallyShipped
InProgress
Completed
Cancelled
AwaitingExchange

Status

Date Range You can select from date ranges from "today," "last week," or "this month."
Enter in the return number of a purchase order if a return was created for that

Return # particular order.

D You can specify the order ID. Orders created out of the box with EPiServer
Commerce are typically numbered as PO####.

Customer Enter in a customer name and the search results will return only orders fil-

tered by the specified name.

Click on Search to being your search query. The desired results appear below. The results are broken
down by five column fields:

ID

Customer (name)
Total (cost of order)
Status

Modified (date)

You can sortresults by ID, Customer, Total, or Status.

Shipping and Receiving Workflow
The Shipping and receiving workflow is described in the topics of this section.
Processing Shipments and Creating Picklists

Once an order has been released for shipment, the order then goes through shipment processing, where
you can add the shipment to a Picklist and select the warehouse where the item will be packed and
shipped from.

1. Go to Order Management > Shipping/Receiving > Shipments > Released for Shipping. This
shows the Released Shipments screen.
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ePiSERVER COMMERCE Released Shipments

Welcome ™ Change Language About ¥

Order Management ) Warehouse:  Default Warehouse |Z|
j'g Order Management

5% Add Shipment to Picklist

() Order Search

[ Order Created Last Modified #
# [F] Purchase Orders
@[] Purchase Orders By Status [ ) 2/12/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
] Carts [ ) Today. 11:45 AM Today, 11:46 AM POD485-11

@[] Payment Plans (recurring)
=15 Shipping/Receiving
=[P Shipments {l“"'J

| B Released for Shipping

@ Pick Lists

i, Returns

Select a Warehouse from the drop-down list to determine where the item ship be packed and
shipped from.
Checkmark which orders you want to add to the Picklist and click Add Shipment to Picklist.

ePiSERVER COMMERCE Released Shipments

Welcome T Change Language About ¥

Order Management @ || Warehouse: | Default Warehouse [=]
:l.g Order Management quhdd Shipment to PickI['Ed
(7 Order Search
- |:| Order Create&"r Last Modified -
el @ Purchase Orders
iID Purchase Orders By Status D o 2/18/2011 9:58:27 AM 2/18/2011 9:58:27 AM PO1537-2
=[] Carts ) Today, 11:46 AM Today, 11:46 AM PO0485-11

# [ Payment Plans (recurring)
=15 Shipping/Receiving
= Shipments
| = Released for Shipping
= Pick Lists

i Returns

The Add Shipments to Pick List pop-up appears. You can choose to create a New Pick List (by
default, the List Name shows the date and time the Pick List was generated) or add the chosen
shipment(s) to an existing Pick List you can select from the List Name drop-down list. Click OK to
save your changes.

Add Shipments to Pick List *

@ Create New Pick List

List Name: |2011-06-16 16:36
()Add to Pick List

List Name: IE‘

| " OK | | A Cancel

O Note thatitis currently not possible to change the pick list name. It defaults to date and time.

Printing Picklists and Printing Packing Slips

Go to Order Management > Pick Lists. You can see existing Pick lists; you can filter the view by
choosing which warehouse the pick list was generated in.
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EPISERVER COMMERCE Pick Lists

Welcome ¥ Change Language About 7

Order Management & Warehouse: DefaultWarehouselz‘
j‘g Order I‘v1ana|§\gment

X Delete Selected

:J Order Search
ﬂg Purchase Orders
(] Purchase Orders By Status [ 2011-02-21 12:35 1 Default Warehouse admin
=[] Carts
# ] Payment Plans (recurring)

D Name Packing Shipments Warehouse Created By

(=7 Shipping/Receiving
QP Shipments
B Released for Shipping
| & Pick Lists

E:'q Returns

You can also sort existing pick lists by Name, Packing Shipments, Warehouse, and Created By.

2. Click on an existing pick list. The Packing Shipments window appears. You can choose to printa
packing slip and/or a picklist. Checkmark one or more purchase orders. Click on Print Picklist to
generated a printable and exportable (Excel or PDF) pick list.

4 4 of1 b Pl 100% [=] Select a format || Export =
Shipment Id: 4
Customer Name  Product Code Product Name Qty
Carlos Nevada ELCBO0OTGQHAWE  Apple Iphone PDA Premium Reusable LCD 1.00

Screen Protector with Lint Cleaning Cloth

Shipment Id: 6

Customer Name Product Code Product Name Qty

Jennifer Browne ELCBODOWHKIVZE Apple iIPhone 1G Soft Polycarbonate Slim fit - 1.00
Case -Black(Cozip Brand) Made in Korea

ELCBO0OOWKSBQGE  Headphone Adapter for Apple iPhone 1.00
Recessed Jack, 3.5mm Male Female
Extension Plug - Black

Shipment Id: 9
Customer Name Product Code Product Name Qty
Lisa Prescott ELCBOO0OFOMBBAS Plantronics Voyager 510 - Bluetooth Headset  1.00
Carrying Case
ELCBODOWKSBQGE  Headphone Adapter for Apple iPhone 1.00

Recessed Jack, 3.5mm Male Female
Extension Plug - Black

ELCBO00S1AZDAQ6 Koss SPARKPLUG - Stereo In Ear Ear Plugs  1.00

To generate a packing slip, checkmark one or more purchase orders to include in the packing slip
and then click on Print Packing Slip.

Finalizing a Package for Shipment

There are two ways to complete a shipment.
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Method 1

1.

Check mark the box next to the shipment and then click Complete:

Packing Shipments

;EiCI:umpIEtE %Print Picklist EZIPrint Packing Slip X Remove from Picklist

|:| Last Modified # Customer Shipping Method
0 ;H 6/16/2011 12:09:52 PM PO4563-4 Carlos Nevada Fixed Shipping Rate
O 6 3—'&1 6/16/2011 12:14:41 PM POGS0E-6 Jennifer Browne Fixed Shipping Rate
i ] 3—'&1 Today, 1:40 PM PO10728-9 Lisa Prescott Ground Shipping

2. The Complete shipment pop-up appears. The default shipment number is based on the number

3. Click on Validate. Once validated, you will see the customer name, shipping address, shipping
method, and a field to enter in the tracking number provided by the shipping provider. Enterin a

after the purchase order number. For example, in the screenshot above, the PO number is
PO7884-7. The last number after the dash is the number you want to enter into the text field.

Packing Shipments

Complete shipment

Shipment : g

| i | | # Cancel |

tracking number and click OK. The shipment is sent out and completed. The purchase order status

will change to "Completed."

Complete shipment *
Shipment £: 3
Customer: Lisa Prescott

Shipping Address: 111 Palm Street, Sun City, Florida, 333445, United States
Shipping Method: Cround Shipping

Tracking Number: 1234567

| " OK | | # Cancel

Currently, the Complete shipment pop-up is rendered over the purchase order number. So to
reference the shipment number without closing the pop-up, you can move and drag the pop-
up so you can see the PO number by hovering your mouse cursor over the Complete ship-
ment title bar.
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Method 2

1. To complete a shipment, click on the complete shipmenticon highlighted in the screenshot below:

Packing Shipments

;ﬁComplete L%Print Picklist Print Packing Slip X Remawe from Picklist

|:| Last Madified z Customer Shipping Method
= o ;‘d &6/16/2011 12:09:52 PM PO4563-4 Carlos Nevada Fixed Shipping Rate
= o %6_116_12011 12:14:41 PM POGI0E-6 Jennifer Brovne Fixxed Shipping Rate

2. The Complete shipment pop-up appears. The shipment# is already validated with the last
number of the PO number.

Complete shipment b4
Shipmlnt # B
Customer: Jennifer Browne

Shipping Address: 75 Sun Street, Sunshine Valley, South Wales, 333567, Australia
Shipping Methad: Fixed Shipping Rate
Tracking Number: |1 234566

| o DK | | * Cancel |

3. Enter a tracking number provided by the shipping provider and then click OK to complete the ship-
ment and complete the order.

Processing Returns and Exchanges
Initiating a Return

Once a package has been finalized and shipped out, EPiServer Commerce enables you to process
returns and exchanges directly in the order. Returns and exchanges can only be processed once a pur-
chase order status is tagged as "Completed."

1. Go to purchase order that has been finalized and shipped. Go to the Details tab and you will see
that the Create Return is available under Returns/Exchanges. Click on it to begin the return
and/or exchange process.

Shipment Summary ~— Shipment Status - Returns [

Item Subtotal: $54.94 Status: Shipped I:

Shipping cost: 510.00 | |

Shipment Total: $64.94

2. The Create/Edit Return form appears. Click on New Item to add associate the items to be
returned.

3. The Lineltem drop-down menu defaults to the items that were in the original purchase order. You
can set the Return Quantity and the Return Reason from the drop-down list (Faulty, Unwanted
Gift, Incorrect ltem). Click OK to save your changes.
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Create/Edit Return X
New Lineltem *
Linefrem: Apple iPhone 1G Soft Polycarbonate Slim fit Case ’B‘B
1D ELCBODOWHK3VZ6
Display Name: Apple iPhone 1C Soft Polycarbonate Slim fit Case -Black
(Cozip Brand) Made in Korea
List Price 39.99
Quantity: 1.00
Return Quantity: 1.00
Return Reason: Faulty El

‘ ' OK | | ¥ Cancel

4. The purchase order will go into Edit Mode. Click Save to continue the return process. Otherwise,
click Cancel to cancel the return.

Return Actions

1. Click on the Returns tab to process the return further. Once you get notice from the shipping
department, for example, that they received the returned item, click on Acknowledge Receipt
Items.

Order

o (Episerver)
i@ Get Help For This Page %

[‘AAdd Note §3Send Notifications =f Add Order Address
Order No: PO6308 Customer: Jennifer Browne
Order Total: 564.94 Status: Completad
Summary H Details ‘ ‘ Payments ‘ ‘ Returns ‘ ‘ Notes
Return # RMA7696
Date/ Time Initiated: Today, 2:39 PM Notes: Returns actions Exchange actions
Created By: admin This must be replaced I Eai Retorn | [eiswEschanse
Status: Awaiting Stock Return
Cancel Return Create Exchange
Return Total: $39.99
Acknowledge Receipt
I Items [
il
L] Name Quantity ~ ListPrice  Total Reason
ELCBOOOWHK3V26 Apple iPhone 1G Soft Palycarbonate Slim fit Case -Black(Cozip Brand) Ma... 1.00 39.99 39.9900 faulty
Page Size:| 100 =]

You can also choose to edit the return or cancel the return completely.
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2. Once you click on Acknowledge Receipt ltems, the Complete Return becomes available.

— Returns actions — Ex

| Cancel Return |

| Complete Return D?J

3. Click on the button to open the Create Refund form.

Create Refund =
Amount: L} 39 9900
Existing payments: i@ Pay By Phone (Sale) - 564.94
i Mew Credit
Payment Method: Pay By Phone
| " OK | | # Cancel

1. The Amount value defaults to the invoice cost of the item (notincluding the shipping costs).
For example, if the item cost $49.99 and the shipping cost was $2, then the Amount text
box will show $49.99.

However, you can specify a different amount to refund to the customer, including the full
cost of the order, item(s) + shipping cost. By default, the refund will be deposited based on
the payment method the customer used to make the order.

2. Ifthe customer wants the refund processed and deposited to a different credit card or pay-
ment method (such as cash, money order, or electronic transfer), click on the New Credit
radio button and you can enter their alternate credit card information or other refund pay-
mentinformation.

4. Once done, click OK to create and process the refund. The status of the purchase order changes
to Completed.

Order No: POB308 Customer: Jennifer Browne

Order Total: 564.94 Status: Completed
Summary ‘ | Details || Payments ‘ ‘ Returns ‘ ‘ Notes
Return # RMA7696
Date/Time Initiated- Today, 2:39 PM Notes: Returns actions Exchange actions ———,
Created By- admin This must be replaced ‘ | ( ‘ |
Status: Complete ‘ ‘ ‘ ‘
Return Total: $39.99

[Complete Return.....|

Lo ]

D Name Quantity List Price Total Reason

ELCBOOOWHK3VZE Apple iPhone 1C Soft Polycarbonate Slim fit Case -Black(Cozip Brand) Ma... 1.00 39.99 39.9900 faulty

Page Size: | 100 =]
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Initiating an Exchange Order

Generating an exchange creates a separate Exchange Order (denoted by "EQ", instead of "PQ") tied to
the original Purchase Order. An Exchange Order is similar to processing a Purchase Order, as it involves
payment processing and releasing packages for shipment.

1.
2.
3

Go to a Purchase Order, click on the Details tab, and then click on Create Return.

Add the items for exchange.

Click on the Returns tab and click on Acknowledge Receipt Items. Click Create Exchange to
open the Create Exchange Order form.

Click on New Item and then select the item to be exchanged by clicking Configure Selected
Entry. You can adjust the price, quantity, and applicable discounts before you add the item to the
Exchange Order by clicking Add items to the order.

Mew Lineltem
Advanced Search
Picture Mame Catalog Type Price In
- ‘ ; |:_||tII'I'IE|tE Ears-Matro.fi 150 Noise Isolating Earphones Phona . Variation £45.99
(Black] Accessories
4 Phone
¢ S8 510 Headset Charger . Variation £29.88
Accessories
Plantronics Woyager 510 - Bluetooth Headset Carrying  Phone . Variation £13.05
Case Accessories
&  Adapter Car Lighter Explorer / Voyager Phone Variation $23.25
! Accessories
Apple Iphone PDA Premium Reusable LCD Screen Phone .
E Protector with Lint Cleaning Cloth Accessories Variation $2.99
Apple iPhone Soft Polycarbonate Slim fit Case- Silver - Phone .
[ — / Cnzin Arand (Made in Knreal Arressnries Variation 533.33
Page Size: 20 |E| {1315 items) | Page 4 1 !
Cancel | | Configure Selecte
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New Lineltermn ®

Selected Entry: Ultimate Ears-Metro.fi 150 Naoise |solating Earphones (Black)
Display Price: $49.99
Price: |49.99
Quantity: |1

Discount: enter descr here 0 Percentage Basedlz‘
Discount description  amount

Total: $49.99

| Back || Add item to the order |

5. Enter a shipping and billing address. Select the shipping method to use for the Exchange Order.
Click on Recalculate to adjust the Summary total.
6. Click OK once done.

Viewing an Exchange

1. Once an Exchange Order has been created, click on View Exchange to view the details of the EO.
An EOQ is similar to how a Purchase Order is set up.

" Exchange actions

| View Exchange d?

R
wn ] | |
tewrn ]

2. Click on the Payments tab to add a payment to the Exchange Order. Select a payment method for
processing the EO. You can adjust the amount if needed (the amount default value is based the
item cost + shipping).
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The Order is in the Edit Mode. Save changes before exit. | " Sawve | | X Cancel |

[JAdd Note (-)Send Natifications [ Add Order Address

Order No: ECO731 Customer: Jennifer Browne Original Order: POGS308
Order Total: £51.99 Status: AwaitingExchange
| summary | | Details | | Payments | | Returns | | Notes

Create Payment

|:| Name Transaction Type Amount Status

[ % PayByPhone 51.99 Pending

Page Size: | 100 El

3. The Exchange Order goes into Edit Mode. Click on Save to process the payment and the order.
The payment Transaction Type changes to "Authorization."

4. Go back to the Purchase Order and click on the Returns tab. Click on Complete Return to enable
the Customer Service Representative (CSR) to release the EO shipment. Optionally, you can can-
cel the shipment to cancel the Exchange Order. Once you release shipment, the CSR repeats the
same process as he would when shipping a Purchase Order.

Shopping Cart

Registered and anonymous customer carts can be viewed in detail and converted to a Purchase Order
manually.

Converting a Shopping Cart to a Purchase Order

Customer shopping carts can be manually converted over to Purchase Orders, rather than have them
process the order via the front-end site.

1. Go to Order Management > Carts. You will see the Shopping Carts List. You can also click on
"Today," "This Week," or "This Month" to filter by date range.

EPISERVER COMMERCE Shopping Carts List

Welcome ” Change Language About ~

Order Management @ || [INew Order X Delete Selected
2 Order Management ~E Customer Total Status Last Modified
) BrEEeEr 0 14 Carlos $418.99 [undefined] Today, 3:27 BM

=[5 Purchase Orders
@ Today
@ This Week D 2
@ This Month

F e Jennifer Browmne $32.41 [undsfined] 6/16/2011 4:25:13 PM

Anonymous $0.00 [undafinad] 6/16/2011 12:07:01 PM

a Al
5[] Purchase Orders By Status
=3 Carts
Today
This Waek
This Month

m

o
@
@
a

All

2. Click on the ID number of the shopping cart you want to convert over to a Purchase Order.
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3. You will see the Cart View window and details of the customer's shopping cart.

{2] More Actions =

— Overview

Cart#: 14
Created Date: 6£/23/2011 1:27:46 PM
Cart Total: 413.99
Currency: USD

Customer: Carlos

Customer ID: fied5deB-5f95-43f6-abd2-e4348cca%d2e Open Customer Profile

Email Address: carlos®@somemail.com

[C]  ELCBOODJNYWEGE

J Line Items | | Notes
B o Name Quantity  List Price Total
[ EeLceocowmzvals 1.00 51999 51999
1.00 3399.00 3399.00

Page Size: | 100 [~

An anonymous user Cart View will look like this:

i]Mu{}"fuctionsv

~— Owverview

Cart#: 3
Created Date: &/16/2011 10:07:01 AM
Cart Total: 0.00
Currency: USD
Customer: Anonymaous

Email Address:

J Line Items | | Notes

]

Name

Quantity List Price Total

]

ELCEOOOTCOHAWS

1.00 59.99 59.99

Page Size: | 10p v

-

4.

4. Click on More Actions and click on Convert to Purchase Order.

Edit Information - You can change the currency to be used for the Purchase Order.
Open Customer Profile - You can view the profile of the registered customer (this option is

not available for anonymous shopping carts).

Line ltems - This is the list of items currently in the customer's shopping cart, displaying the

Quantity of each item, List Price, and Total.

Notes - You can add, edit, or delete notes about the shopping cart.
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Cart View
i/l More Actions~
Convert to Purchase %r%
Create Payment Plan Edit Information

Cart#: 14

Created Date: 6/23/2011 1:27:46 PM
Cart Total: 418.99
Currency: USD

Customer: Carlas

Customer ID: f3ed5ded-5795-43f6-abd2-e4348cca%dze | Open Custamer Profile |

Email Address: carlos@somemail.com

The page refreshes and shows the Order view page for further processing of the purchase order.

Payment Plans

This section describes how to work with payment plans and recurring payment plans in EPiServer Com-

merce.

Setting up a Payment Plan

Payment plans can be setup by the CSR to generate recurring payments. An example recurring payment
would be for magazine or grocery subscriptions.

Payment plans are handled in the background by a scheduled Quartz job which should be configured by
your IT team based on your business needs. Ideally, the payment plan job should run once per day.

Creating a Payment Plan

1.

Go to Order Management > Payment Plans (recurring). You will open up the Payment Plans
List. To create a new payment plan, click on New Payment Plan.

Select a customer contact to attach the payment plan to.

The Payment Plan New page appears. Complete the form as you would when creating a new
order.

Under Payment Plan Details, you will set the cycles and parameters of the payment plan.
Once the payment plan is configured, click OK.

Fied _______JDescripon |

You can choose from the following plan cycles, which determine how often the customer is
charged.

- No Cycle: No recurring payment is created. The customer is charged once when the initial pur-
chase order is created.

- Daily Cycle: recurring payment happens daily from start date.

Plan Cycle
- Weekly Cycle: recurring payment happens weekly from start date.
- Monthly Cycle: recurring payment happens monthly from start date.
- Custom1/Custom2: these are placeholders for developers to create custom cycles within the
Mediachase.Commerce.Orders.PaymentPlanCycle class.
Determines how many times to run a cycle runs. For example, the cycle length of "2" for a
Cycle Length weekly cycle means the cycle will run twice after two weeks from start date. Setting a cycle
length of "0" means the cycle will run an unlimited number of times.
Determines the maximum number of cycles to run for this payment plan. The max cycles value
is typically set to the same value as the cycle length. For example, if the cycle length is 12, you
Max Cycles typically Y/ 9 p Yy 9 Y/

will set the max cycle length to 12 as well. If the cycle length is set to 0 (for unlimited) then the
max cycles length should also be setto 0.
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Fied _______JDescripon |

This tallies the number of completed cycles so far after the payment plan was created. When ini-

Completed Cycles
P y tially creating the payment plan, set this field to 0.
Set the start date and time to determine when the payment plan should begin (beginning recur-
Start Date . .
ring transactions).
End Date Set the end date and time when the payment plan should end (ending recurring transactions).
s Plan Active S\c/e(;t True" to enable the payment plan. Set "False" to create the payment plan but keep itinac-

Last Transaction  Logs the last transaction date. The date and time already in those two fields when first creating
Date the payment plan should be kept as is.

Payment Plan Order Detail Page Explained

The payment plan begins once the first purchase order is generated. The purchase order can be created
manually (by clicking on Create First Purchase Order) or automatically by the payment plans quartz job.

After creating a new payment plan, a new Order page appears. This is slightly altered from the original
Order detail page that appears after creating a new order. The changes include:

Inability to manage shipments (i.e. release shipments for further processing)

e An Orders tab that shows a history of processed purchase orders from this payment plan

e A"Create First Purchase Order" button thata CSR can manually click on to create the first pur-
chase order related to this payment plan. The button disappears after creating the first purchase
order manually or when the payment plan quartz job runs and generates the first purchase order.
Once that first purchase is generated, the payment plan goes into effect.

e The purchase order number that is generated includes the parent ID of the payment plan. For
example, if the payment plan parent ID is 35, the subsequent purchase orders are numbered as
"PO35XXX."

e When a paymentis added to a payment plan, the customer is not charged. The customer is
charged once the purchase order is generated for the first ime (and through subsequent pur-
chase orders). The payment plan simply collects the payment information until converted to a pur-
chase order.

Editing and Canceling a Payment Plan

1. To editan existing payment plan, go to Order Management > Payment Plans (Recurring) or
Today/This Week/This Month/All. Click on the payment plan ID number to open the payment
plans order details page and make edits.

2. To cancel a payment plan, when editing a payment plan, click on the Summary tab and then click
on Cancel Payment Plan.

Creating a Recurring Payment Plan Using Authorize.Net

Out of the box, EPiServer Commerce supports Authorize.net as a recurring payment plan gateway.

For more information on how to setup payment methods, refer to the Payment Gateways section.

1. Go to Administration > Order System > Payments > (Language) and create a new payment
method or click on an existing payment method (such as "Pay by Credit Card").
2. When setting up the parameters of the payment method, select this class name:

Class Mame: Mediachase.Commerce.Plugins. Payment. Authorize AuthorizePaymentGateway -

Select "Yes" for Supports Recurring.
Click OK.
Click on the name of the payment method again and click on the Parameters tab.

akw
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6. Configure your Authorize.net account for both regular payments and recurring payments.

Ohverview Parameters

Configure Authorize Net Account

Cet an Authorize Net account at www.authorizenet.com.

APl Userld: AySBfUWTjm

Transaction Key:  4cAmW927n8ulfs)8

Regular Payments

Processing Url: https:  /test.authorize.net/gateway /transact.dll

Payment Options: L
¥ H @ Authorization

Sale

Recurring Payments

Processing Url: https:/ /apitest.authorize.net/xml/v1 [request.api
Recurring Method:  |ntarnal -

Cancel Status: OnHold -

| a] 4 || Cancel

Marketing

The Commerce Manager Marketing system consists of the following components:

e Campaigns - a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied
to Customer Segments for targeted marketing purposes.

e For example, you can create a seasonal campaign that will include different Pro-
motions targeted for the Spring season.

e Promotions - a way to apply various discounts to the products, order totals or shipping. A Pro-
motion is a marketing tool used to increase sales of certain products or product lines. Various
incentives such as lowered pricing and other discounts can be employed as part of a Promotion.

e Promotions are always tied to Campaigns.

e Promotions can be classified into two types: 1) either you can create a Promotion
that s visible prior to checkout or 2) you can configure the Promotion to be dis-
played during the checkout process.

e The most powerful aspect of the Marketing system is the Expression Engine which
allows variable conditions to be applied when creating a Promotion. These con-
ditions vary from the number of items, the percentage discount, shipping rates and

many others.

e Customer Segments - these determine the target audience for the Promotions. Customer Seg-
ments determine the target audience for the Promotions. Within a Campaign, all Promotions will
be applied to whatever Customer Segments associated with the same Campaign. Members of
the Customer Segments can be pre-defined in static groups or you can use the Expressions
Engine to create dynamic groups whenever Promotions are run.
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e For example, you can have a Customer Segment that targets all users from the Los
Angeles area. You can create an Expression that will include all the customers
whose home city is Los Angeles. Thus, when a user registers on the site he imme-
diately becomes part of the target Customer Segment.

e Expressions - these are customizable Conditions which allow users to extend different aspects of
the Marketing system -- Promotions, Customer Segments and Policies all rely on Expressions.
There is an Expressions Engine which is a core technology behind the Marketing system.

e For example, you want to set a Promotion for "40% off Item X." The Expression or
Condition to enable this Promotion would include: Catalog ID for ltem X and
Reward of 40%.

e Policies - rules that are always executed when Promotions are applied. This allows a Marketing
manager to declare rules just once for the whole site.

e An example of a rule is as follows: Do not allow negative orders.

Campaigns

Campaigns provide a way to organize marketing activities. Campaigns must be associated with Pro-
motions in order to provide customer discounts. Optionally, Campaigns can also be tied to Customer Seg-
ments for targeted marketing purposes. For example, you can create a seasonal Campaign that will
include different Promotions targeted for the spring season.

Browsing Campaigns

To browse Campaigns, go to Marketing > Campaigns to open the Campaign List.

Marketing .,{,3‘
w# Campaigns

@ Promaotions

gl Customer Segments
=[] Policies
] Expressions

From the Campaign List, you can create a New Campaign or edit existing ones.

ERCE Campaign List

D New Campaign ﬁ More Actions~

D Marme Starts Ends Is Active Last Modified Created

|:| Digital Cameras 10/7/2008 2:00:00 AM 11/7/2020 1:00:00 AM True 10/8/2008 12:14:13 AM

Creating a Marketing Campaign

Sales promotions are tied to specific Campaigns. A Campaign could be related to seasonal sales, such
as Easter or Christmas. Campaigns are the first step to deploying targeted marketing efforts.

To create a new Campaign, click on New Campaign on the Campaign List page.

IERCE Campaign List

D Mew Campaign ii Maore Actions

|:| Marme U Starts

[[] Dpigital cameras 10/7/2008 2
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This opens up the Campaign Edit page.

1. Enterin a Campaign Name, such as "Christmas Campaign" or "Back to School Sale."

2. Enterin any Comments as notes about the Campaign.

3. Enterin a date directly (or click on the Calendar icon to select a date) and time into the Available
From field. This will indicate when the Campaign is expected to start.

4. Enterin a date and time in the Expires On field.

5. Selectthe Target Segments from the list. Target segments are created under the Customer Seg-
ments section

6. Indicate whether or not the Campaign is Active, "Yes" or "No."

7. Indicate whether or not to Archive the Campaign, "Yes" or "No. NOTE This feature has not been
implemented and switching its status from "No" to "Yes" will not change anything.

8. Once done, click on OK.

Campaign Edit

Owverview

Campaign Name: |craduation 2010

enter campaign name

Comments: Sale on graduation items -
Available from:  [g:1 /2010 EH [10:23 AM
Expires on: 201/2010 EH 10:23 AM

Target Segments:

Active: @ Yes ™ No
Archived: m1Yes i@ No
| oK || Cancel
Promotions

Promotions provide a way to apply various discounts to the products, order totals or shipping. A Pro-
motion is a marketing tool used to increase sales of certain products or product lines. Various incentives
such as lowered pricing and other discounts can be employed as part of a Promotion.

Promotions are always tied to Campaigns. In addition, Promotions can be classified into two types: 1)
either you can create a promotion that is visible prior to checkout or 2) you can configure the promotion to
be displayed during the checkout process. The most powerful aspect of the Marketing system is the
Expressions Engine which allows variable conditions to be applied when creating a Promotion. These
conditions vary from the number of items, the percentage discount, shipping rates and many others.
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Browsing Promotions

To view and browse Promotions, click on Promotions on the left navigation bar.

Marketing 1,%"
w4 Campaigns

ﬁ Promations

Bl Customer Segments
[ Policies
=[O Expressions

The Promotion List page opens, displaying a list of existing Promotions.

ERCE Promotion List

D New Promotion ﬁ More Actions~

D Marme Croup Priority  Starts Ends Status

[[] z0% Off Canon Powershot Pro Series entry 1 10/7/2008 2:00:00 AM 11/7/2014 1:00:00 AM active

You can click through the name of a Promotion to view its properties.

|[ERCE Promotion List

D New Promotion ﬁ More Actions -

|:| Marne Croup Priority  Starts Ends Status

[[] 203 off Canon Powershot Pro Szr{'% antry 1 10/7/2008 2:00:00 AM 11/7/2014 1:00:00 AM active

ERCE Promotion Edit
Overview
Promation Type: Catalog Entry: Buy X Get $ Off Discount
Promotion Name: 20% Off Canon Powershot Pro Series
enter promotion name
Display Name:
English (United States)
Cerman (Germany)
Spanish (Spain)
French (France)
Promotion Properties:
Campaign: Digital Cameras o
Promotion Croup: ent

Deleting a Promotion

On the Promotion List page, checkmark the box next to the name of the Promotion and then click on
More Actions > Delete Selected on the menu bar.
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Promotion List

DNEW Promaotion iil'hh:ure Actions ¥

] Mame |>< Delete Selected Group  Prior

20% Off Canon F Flip Status (active/inactive) entry 1

Creating an Entry Level Promotion
Out of the box, users can build these Catalog Entry Promotion Types:

Catalog Entry: Build Your Own Discount

Catalog Entry: Buy Catalog entry X, get catalog entry Y at a discount
Catalog Entry: Buy X Get $ Off Discount

Catalog Entry: Buy X, get N quantity of Y at a Discount

The following are examples of how to create each type of Promotion.

Example: Build Your Own Discount - "40% Off Canon PowerShot S5"

Once you have selected "Build Your Own Discount" from the Promotion Type drop-down menu, enter in
a Promotion Name, such as "40 % Off Canon PowerShot S5"

Under the Display Name section, enter in the display name for each language type.

Promation Name: 40 % Off Canon Powershot 55
enter promotion name
Display Name:

English (United States) 40 % Off Canon Powershot 55

Cerman (Cermany)
Spanish (Spain) I

French (France)

Promotion Properties:

Under the Campaign drop-down, select an existing Campaign created earlier
Promotion Group is grayed out because the Promotion Type is specified
From the Combination with other promotions drop-down, select the degree to which multiple Pro-
motions can be combined. There are three options: "Combine with other promotions", "Exclusive
within select groups”, and "Exclusive within all groups.”
e Combine with other Promotions - The selected promotion will be combined with all other
promotion types that may be in use
e Exclusive within Selected Groups - If the selected promotion is applied, no other pro-
motions within that group will be applied (but other promotions in other groups may be

applied)
e Exclusive within all Groups - If the selected promotion is applied, no other promotions will
be applied.
e Enter a numerical value into the Priority field (Promotions with a higher priority will be evaluated

first)

e Optionally, enter in a Coupon Code that customers can redeem from the front-end public site to
getreceive the discount. Otherwise, leave the field blank.

e Setthe Status of the Promotion either as "Active", "Inactive," "Suspended," or "Deleted" from the
drop-down menu. Select Active to enable the Promotion.
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Promotion Properties:

Campaign: Digital Cameras =

Promotion Group:

Combination with other promotions: | Combine with other promotions |Z|
select the degree to which multiple promotions can be combined

Priority: ]
promotions with higher priority will be evalvared first

Coupon Code: Test
will require code ifentered

Status: Active |Z|
status of the promotion

Purchase Condition and Reward:

Here you can set your own Purchase Condition to receive the discount Rewards. To apply a 40% dis-
count for Canon digital cameras, use the following settings in the screenshot.

Purchase Condition and Reward:

This type of promotion allows you o create your own custom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

TargetLinelterm.CatalogEntryld Equals (Text)

Use the actions below to assign rewards.
Rewards:

> and

get % off item reward 4

Redemption Limits:

Under this section, you can specify the redemption limits of this Promotion.

o Nextto Max. Total Redemption, enter in the maximum number of times the Promotion can be

redeemed.
e Next to Max. Redemptions Per Order, enter in the maximum number of times the Promotion can

be redeemed per customer order.
e Nextto Max. Redemptions Per Customer, enter in the number of times a Promotion can be by a

single customer.

Redemption Limits:

Max. Total Redemptions: 300 (Redeemed:)

number of times the promotion can be used by all customers, enter O for uniimited

Max. Redemptions Per Order: 1

number of times the promotion can be used in a single order, enter 0 for unlimited

Max. Redemptions Per Customer: 1
number of times the promaotion can be used by a single customer, enter O for unlimited

Schedule:
Enter the date and time when the Promotion is Available and when it Expires.

Click OK to save the Promotion. The Promotion will appear in the Promotion List.
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Promotion List

DNEW Promaotion i‘IMDrE Actions ™

|:| Marne Croup Priority  Starts

[[] =20% Off Canon Powershot Pro 5@&5 antry 1 10/7/2008 Z:00:00 AM

When the Promotion is applied, the price on the front-end should change.

Action Desription

Each aty

Move to wishlist . Canon PowerShot Pro Series S5 1S 8.0MP Digital Camera with $440.98 $359.99 1 |Z|
Remove 12x Optical Image Stabilized Zoom You save: $90.00

item & 01380307961€

20% Off Canon Powershot Pro Seriez

Buy catalog entry X, get catalog entry Y at a discount

The steps to create this discount are similar to creating a custom discount. The difference is the Purchase
Condition and Reward.

1. Under the Select catalog entry X drop-down menu, select a specific catalog entry.

2. Under the Select catalog entry Y drop-down menu, select another specific catalog entry.

3. Enterin a value for the Quantity of "X" needed to qualify for the promotion. For example, the cus-
tomer must purchase 2 of Catalog Entry X as a prerequisite for the discount.

4. Enterin a value for the Quantity of "Y" needed to quality for the promotion. For example, the cus-
tomer must purchase 3 of Catalog Entry Y as a prerequisite for the discount.

5. Inthe Amountfield, enter in a number and select from the drop-down to indicate that the Pro-
motion is Percentage Based or Value Based. For example, if you enter 40 and select Percentage
Based, the Promotion will take off 40%. If Value based, it will be 40 off the total price.

Purchase Ci iti and Reward:

This type of promotion makes additional SKUs available at a percentage discount when an order includes some reguired amount of the specified SKU.

Select catalog entry X: 510 Headset Charger [ELCEODOGKLGX46] -

Select catalog entry Y. Plantronics Voyager 510 - Bluetooth Headset Carrying Casg =

Quantity of X' needed to qualify for the promotion: 2
CQuantity of " needed to qualify for the promaotion: 1

Amount: 20 Percentage BasedIZ‘

Buy X Get $ Off Discount

This type of Promotion gives a discount per item by purchasing the minimum quantity specified under
these Purchase Conditions.

1. Enterin a Minimum quantity that the customer needs to purchase in order to receive the discount.

2. Enterin the Amount of the Promotional discount, whether Percentage Based or Value Based.

3. Select any number of Variations from the drop-down menu and click on "add variation." Repeat to
add more Variations to this Promotion. Click on the red X button next to the Variation to delete it.
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Purchase Condition and Reward:

This type of promaoation gives % off discount per item for the minimum quantity.
Minirmum quantity: | g

Amount: 0 Percentage Based

Variations: 510 Headset Charger [ELCBODOGKLGX46]

add variation
x Apple Iphone PDA Premium Reusable LCD Screen Protector with Lint Cleaning Cloth [ELCEQOO0TCOHAWE]

x Apple iPhone 1C Soft Polycarbaonate Slim fit Case -Black(Cozip Brand) Made in Korea [ELCBOOOWHK3V2E]
x 510 Headset Charger [ELCBOOOCKLGCX46]

Buy X, get N quantity of Y at a discount

This type of Promotion allows a customer to be eligible to buy a designated number of items at a reduced
price.

1. Selectan Entry X variation from the drop-down menu and click on "add variation." (What does
"Exclude" do?)

2. Select catalog entry Y from the drop-down menu. A certain number of "Y" entries will be dis-
counted based on the Purchase Conditions.

3. Enterin a Max quantity Y for the maximum number of Y entries eligible for a discount.

4. Enterin the Amount of the Promotional discount, whether Percentage or Value based.

Purchase Condition and Reward:

This type of promaotion eligible to buy designated number of item at a reduced price.

Entry X variation:
v Ultimate Ears-Metro.fi 150 Noise Isolating Earphones (Black - Exclude

add variation
x Apple Iphone PDA Premium Reusable LCD Screen Protector with Lint Cleaning Cloth [ELCBOOOTGOHAWE]

x Ultimate Ears-Metro.fi 150 Moise [solating Earphones (Black) [ELCEOOOPBOWNKE]

select cataleg entry Y. |y b Headser Charger [ELCBODDGKLGX46] -

Max guantity Y: 2

Amount: 20 Percentage Basedlz‘

Creating an Order Level Promotion

Order Level Promotions are discounts applied if the overall Order satisfies the conditions specified by the
Promotion.

There are two types of Order Level Promotions available to the user:

e Order Sub Total Volume Discount - if the order subtotal minimum is met, then the customer
receives the discount

e Build Your Own Discount - can create a custom Order Level promotion based on a range of Pur-
chase Conditions and Rewards (similar to creating a custom catalog entry discount)

Order Sub Total Volume Discount
Enter in the Minimum order amount into the field. For example, if the order amount was set to $200, then
the customer must have $200 or more in his shopping cart to qualify for the discount.

Enter in the Amount of the discount. It can either be "Percentage Based" or "Value Based." If Percentage

Based, then the customer gets a percentage off the price. If Value Based, the customer gets a fixed
amount discounted off.

Purchase Condition and Reward:

This type of promaotion discounts the order subtotal if minimum order amount is met.

Minimum order amount: 0

Amount: 0 Percentage Basedlz‘
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Example: Build Your Own Discount - "20% Off for a Shopping Cart Subtotal of $100 or More"

Like a custom Catalog Entry discount (add link here), users can create their own custom Order Level dis-
count based on a list of Purchase Conditions and Rewards. This means that there is a wide range of
Order Level discount possibilities.

The follow Condition and Reward example shows how to create a Promotion that gives 20% off for a
shopping cart subtotal of $100 or more.

Purchase Condition and Reward:

This fype of promotion allows you [0 createé your own cusiom promotion.

Use the condition below to restrict how the promaotion will be applied.
Purchase Condition:

And
E - ShoppingCart.5ubTotal Equals

Use the actions below to assign rewards.
Rewards:

- And

get % off whole order reward

The discount should reflect on the shopping cart on front-end public site.

Creating a Shipping Level Promotion

Shipping Level Promotions are promotions that give discounts based on the overall shipment. The dis-
count will appear on the order page just before you submit the order.

O Currently, creating a "Free Shipping" promotion based on a certain order amount (e.g. free
shipping for an order of $50 or more) is not available out of the box and requires cus-
tomization. Refer to the EPiServer Commerce Developer Guide for preliminary guidance on
how to create such a promotion and other custom promotions.

There are two types of Shipping Level Promotions available to the user:

e Buy X Get $ Off Shipment Discount
e Buy X GetY Free

Buy X Get $ Off Shipment Discount

This Promotion type applies shipping discount if the specified Variations total the Minimum Quantity set
or more.

1. Enter in a Minimum Quantity.
2. Enterin an Amount of the discount Reward, and select from the drop-down whether itis "Per-

centage Based" or "Value Based."
3. Select the Variations from the drop-down list that qualify for the discount. Click on Add Variation

to add the Variation to the list.
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Purchase Condition and Reward:

This type of promotion gives ® off discount per item for the minimum quantity per shipment.
Minimum quantity: 5pg

Amount: 100 Percentage E.asedIE'

Variations: Adapter Car Lighter Explorer |/ Voyager [ELCEODOCHSMZME o
add variation

¥ 510 Headset Charger [ELCBOOOGKLGX46]

x Adapter Car Lighter Explorer / Voyager [ELCEODOCHSM2ZME]

Buy X GetY Free

This shipping discount allows a user to set two Catalog entries for X and Y. If X is in their shopping cart,
then the customer receives the Y item at no cost.

Purchase Condition and Reward:

Customer adds an eligible item (X) to their Shopping Bag, and receives another item (Y) at no cost.

select catalog entry X. Plantronics Voyager 510 - Bluetooth Headset Carrying Caseg

select catalog entry Y. || 4 qanter Car Lighter Explorer / Voyager [ELCBODOCHSM2M{

Creating Custom Promotions

You can create custom promotions instead of using the built-in ones. Itis possible to create custom pro-
motions on a catalog, order, or shipping level.

How to Use "Or" When Building Your Own Promotions

EPiServer Commerce has a powerful discounting engine and can be used to build all types of promotions
without writing custom code. In most cases these discounts can be built using one of the built in "Build
Your Own Discount" options.

Building the Discount

In this case we want to build a promotion that will give a $10 discount on certain items in our catalog. We
want products with "Canon" OR "Vista" in the display name to receive $10 off the item. In this case we are
using a Promotion Type of "Catalog Entry:Build Your Own Discount”. Constructing the purchase con-
dition can be a confusing when using the Or operator. The firstitem we must add to the condition is the Or
operator since And is the default. The Or will have the effect we desire if added first which is And (Or (Dis-
playName = Canon, DisplayName = Vista)) which is translated by the rules engine to And (DisplayName
= Canon Or DisplayName = Vista). If the Or is not added first the results will not be as desired as the Dis-
playName would have to contain Canon And Vista.

The Reward is set to $10 Off.
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Purchase Condition and Reward:

This type of promotion alfows you to create your own custom promotion.

Use the condition below to restrict how the promotion will be applied.

Purchase Condition:

.

And
: TargetLineltem.DisplayMame Contains Canon

TargetLineltem.DisplayMame Contains Vista

Use the actions below to assign rewards.
Rewards:

F-

_And

get & off item reward 10.00

Seeing the Discount Applied

We have added three items to our shopping cart. As you can see two of the items (containing "Canon"
and "Vista") have been given the $10 off discount and the name of the promotion is shown with the item.
The third item in our cart did not meet the criteria we set so no discount was applied.

Digital Cameras Mobile Phones Phone Accessories Daily Specials Camera Accessories

Shopping Cart

Coupan Apply Coupon
Descriptan Ench o Ttsl

$440.50 $430.99 1w

You save: 510,00

S & OMP Digital Camera wit

L3 1 89.00
Q'
i
Fa
i
Subtotal: $4,478.98
Update Cart Contnue Shopping Proceed to checkout

Review Store Policies  Return and Exchange Policy  Privacy Policy

Customer Segments

Customer Segments determine the target audience for the Promotions or Campaigns. Customer Seg-
ments determine the target audience for the Promotions. Within a Campaign, all Promotions will be
applied to whatever Customer Segments associated with the same Campaign. Members of the Customer
Segments can be pre-defined in static groups or you can use the Expressions Engine to create dynamic
groups whenever Promotions are run.
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For example you can have a Customer Segment that targets all users from the Los Angeles area. You
can create an Expression that will include all the customers whose home city is Los Angeles. Thus, when
a user registers on the site he immediately becomes part of the target Customer Segment.

Creating a Customer Segment

Customer segments specify which group of Customers a user wants to specifically target with their Cam-
paigns.

Creating a Customer Segment Assigned to Contacts

Go to Marketing > Customer Segments.

Marketing 1:';?‘

% Campaigns
@ Promations

@ Customer Segments
+ [ ] Policies
# ] Expressions

Click on New Segment on the menu bar to open the Segment Edit page.

= @l= Customer Segment List

_HNEW SE_gmjgp‘ul: 21 Maore Actions

[ Mame
|:| livesinume

[[] stockholmskunder

I:' Grads
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=@= Segment Edit

Overview
Segment Name:
enter Seqiment name

Display Name:

Description: -

Members: -
[(]Exclude member

add member

Conditions:

The above conditions will be evaluated in runtime and if any are true, |

Ok || Cancel |

Enter in a Segment Name, such as "Company X Team."

Enter in a Display Name, which will appear to users when associating this Customer Segment

when Creating a Marketing Campaign.

3. Enterin a Description.

4. Selectfrom a list of contacts from the Members drop-down to assign them to this Customer Seg-
ment. Select the name from the drop-down and then click add member. You can choose to
Exclude member by clicking on the checkbox and then clicking add member.

5. Once done, click OK to save the Customer Segment.

N =
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Segment Edit

Owverview

Segment Name: Company X
enter seqiment name

Display Mame: Company X

Description: Discounts for Company X employees -

Members: .
Mats Hellstrdm w7
[¥]Exclude member

add member
K Mats Hellstrém

K Mary Smith
x Peter Sunna

The above conditions will be evalvared in runtime and if any are truve, tF

OK || Cancel |

Creating a Customer Segment with Conditions

Instead of assigning members manually to a Customer Segment, you can use Conditions to apply rules.
If a customer satisfies the Conditions, then the customer is part of the Customer Segment.

To add Conditions to the Customer Segment, click on New Condition on the Segment Edit page. This
example will show how to specify Company X or Techarts emails as part of this Customer Segment.

Enter in an Expression Name, such as "Company X or Email Addresses."

Setup the Conditions based on the screenshot below.

Condition Dialog

Expression Name: |Campany ¥ or Techarts Email
ENtEr eXpression name

Expression Xml: , and
-
- Email Equals {Text) Company X
b Email Equals (Text) Techarts

Click OK to save the Conditions.
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Conditions: New Condition

x Company ¥ or Techarts Email

The above conditions will be evaluated in runtime and if any are true, the customer will be part of this segiment.

| 0K || Cancel |

Woorking with Expressions

Expressions are customizable Conditions which allow users to extend different aspects of the Marketing
system -- Promotions, Customer Segments and Policies all rely on Expressions. There is an Expressions
Engine which is a core technology behind the Marketing system.

Users can create Expressions under Promotion, Segment, or Policy.

To access and create Expressions, click on Marketing > Expand Expressions > Either Pro-
motions/Segment/Policy to view the Expression List page.

Marketing e

ﬁ Campaigns
@ Promations

| Fgl Customer Segments |
] Policies
=+ Ewxpressions

a |
[T Promaotion U

[ ] 5egment
[ Policy

ERCE Expression List

DNEW Expression ﬁMore Actions~

|:| Marne Description Modified Created

This type of promotion gives $ off discount

D BuyXGetOffDiscount per item for the minimum guantity.

10/8/2008 4:21:58 AM

To create a new Expression, click on New Expression. The Expression Edit page appears.

O In order to create an Expression, knowledge of XML is required. Non-technical users may
want to skip this section.

Enter in an Expression Name, such as "ShippingCustomDiscount."
Enter in a Description of the Expression.
Enter in the Expression XML.

Under Category, select from the drop-down whether this Expression is for a "Promotion," "Segment," or
"Policy." Depending on your selection, the Expression will appear under those respective folders. Click
OK to save changes.

To create a new Expression, click on New Expression. The Expression Edit page appears.

O In order to create an Expression, knowledge of XML is required. Non-technical users may
want to skip this section.

Enter in an Expression Name, such as "ShippingCustomDiscount."

© EPiServer AB



Commerce Manager | 149

Enter in a Description of the Expression.
Enter in the Expression Xml.

Under Category, select from the drop-down whether this Expression is for a "Promotion," "Segment," or
"Policy." Depending on your selection, the Expression will appear under those respective folders. Click
OK to save changes.

ERCE Expression Edit

Overview

Expression Name: |p o CetOffDiscount
enter expression name

Description This type of promotion gives $ off discount per item for the minimum quantity. -

enter expression description

Expression Xml: | <RuleSet Name="RuleSet0” ChainingBehavior="one " Description="{p :Null}" xmins:p1="http: /fschemas. microsaft.com winf 2006 fxaml™
xmins ="htip://schemas. microsoft. com fwinfx/2006 xaml fworkflow™ = <RuleSet. Rules = <Rule Name ="SetupConstants” ReevaluationBehavior =Mever”
Priority="2" Description="{p1:Null}"
Active="True"> <Rule. ThenActions > <RuleStatementAction> <RuleStatementAction. CodeDomStatement > <ns0: Code AssignStatement
LinePragma="{p1:Null}" xmins:nsl ="dr-namespace:System, CodeDom;Assembly =System, Version=2.0.0.0, Culture=neutral,
PublickeyToken=b77a5c561934e089 "> <ns0:CodeAssignStatement. Left> <ns0:CodeIndexerExpression = <ns0:CodeIndexerExpression. Indices > <ns0:Cod
ePrimitiveExpression > <ns0: CodePrimitiveExpression. Value =<ns 1:5tring xmins:ns 1="dr-namespace:System; Assembly=mscorlib, version=2.0.0.0,
Culture=neutral,
PublickeyToken=b77a5c561934e08%">RuleSkuSet< ns1:5tring > < fns0:CodePrimitiveExpression. Value > < /ns0:CodePrimitiveExpression > </ns0:Codelndexe
rExpression.Indices > <ns0:CodelndexerExpression, TargetObject » <ns0: CodePropertyReferenceExpression
PropertyName ="RuntimeContext™=<ns0:CodePropertyReferenceExpression. TargetObject = <ns0: CodeThisReferenceExpression [=</ns0:CodePropertyRe
ferenceExpression, TargetObject > < fnsD:CodePropertyReferenceExpression = < /nsl: CodelndexerExpression, TargetObject » < fnsl:CodelndexerExpression
»<fns0:CodeAssignStatement.Left><ns0: CodeAssignStatement.Right > <ns0:CodeMe thodInvokeExpression = <ns0: CodeMethodInvokeExpression. Parame
ters > <ns0:CodeMethodInvokeExpression > <nsl: CodeMethodInvokeExpression. Parameters > <ns0: CodeMethodInvokeExpression > <ns0:CodeMethodinvo
keExpression,Parameters > <ns0:CodePrimitiveExpression > <ns0:CodePrimitiveExpression, Value » <ns 1:String xmins:ns1="cIr-
namespace:System; Assembly =mscorlib, Version=2.0.0.0, Culture=neutral,
PublickeyToken=b77a5c56 1934089 >; < fns 1:5tring > < /nsD:CodePrimitiveExpression, Value = < fns0: CodePrimitiveExpression > < /ns0:CodeMethodInvokeEx
pression.Parameters > <ns0:CodeMethodInvokeExpression.Method = <ns0:CodeMethodReferenceExpression
MethodName="Parse" > <ns0; CodeMethodR eferenceExpression, TargetObject > <ns0: CodeTypeReferenceExpression Type="System.Char, mscorlib,
Version=2.0.0.0, Culture=neutral, 2
enter expression xml

m| »

Woorking with Policies

Policies are rules that are always executed when Promotions are applied. Promotion policies determine
whether a conflict situation will arise when a particular promotion is applied in addition to any previously
applied promotions. If no conflictis detected, this promotion is added to the list of applicable promotions;
otherwise itis eliminated and will not be applied to the order.

Policies are the business rules on how to eliminate similar promotions for the same order or same prod-
uct. Policies are pre-configured for each store. Policies can be optionally associated with one or more pro-
motion groups.

e Local Policy - If a policy is associated with a promotion group, itis considered a local policy, and
applies only to those promotions in the group to which this policy is associated. If a policy is not
associated with a promotion group, itis considered a global policy which applies to all pro-
motions.

This allows a Marketing manager to declare rules just once for the whole site. For example, you can
create a Policy such as this: Do not allow negative orders.

O Creating Policies, like creating Expressions, is meant for advanced users. Most non-technical
users will want to skip this section.

To create a new Policy, go to Marketing > Policies to open the Policy List.
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Policy List

DNEW Palicy _\'EII"-'IDrE Actions

[ mMame

Click on New Policy to open the Policy Edit page.

ERCE Policy Edit

Overview
Policy Name:

enter Policy name
Status:

enter Folicy status
Is Local: ™ Yes @ Ma

Expression: IE'

select policy expression

Croups: Order
Catalog Entry
Shipping

seflect policy group, alfows you to logically group policies

| )4 | | Cancel

O Policy Status and Policy Is Local has not been fully implemented. Therefore, all policies will be
global (meaning it cannot be limited to a Promotion Group) until this feature becomes avail-
able in a future release.

Enter in a Policy Name.
Enter the Status of the policy.

Select"Yes" or "No" to set the Policy Is Local.

e Policy Is Local is No - this is the default behavior. This means that this Policy is not part of a Pro-
motion Group and is available for all Promotions.

e Policy Is Local is Yes - this means this Policy is part of a Promotion Group and is applicable only
for that Promotion Group

Select an existing Policy Expression from the drop-down menu.
Select from the Groups list to place the Policy under.

Click OK when done.

Asset Management

The Asset Management system allows for assets including images, MP3s, PDFs, software packages and
other downloadable files to be centrally stored, displayed on either the front-end site or the Commerce
Manager site and ultimately to be shared or purchased.
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Please refer also to the File Management section in this documentation to find out more about file man-
agementin EPiServer Commerce.

Browsing, Editing, and Deleting Folders and Assets

The Asset List page categorizes and manages downloadable Asset files. The default list of Asset folders
are: Video, Presentations, Specifications, Software, Downloads, User Guides, and Images. These
folder names can be changed.

To access the Asset List, click on Asset Management > Root or any other folder below Root.

Asset Management e
=+ Root b
[ Video AW

[ 7] Presentations

[~7] Specifications
7] 5oftware

[ Downloads
[ User Cuides

[ JImages

The Asset List shows folders and assets. The Asset List shows the total Size of the Assets and the
Created date.

ERCE Asset List

D Create New~ ﬁ More Actions~

|:| Mame Size Created

D E'Viden 5/11/2010 3:34:57 PM K
D = E' Presentations 5/11/2010 2:34:57 PM

] = Specifications 5/11/2010 3:34:57 BM

D E' Software 5/11/2010 3:34:57 PM

D E' Downloads 5/11/2010 2:34:57 PM

D E'Us!r Cuides 5/11/2010 3:34:57 PM

D El Images % 5/11/2010 3:34:57 PM

Folder and Asset names can be edited by clicking on the Edit icon next to the Name.
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DCraate MNew ;ZIMn-rEActiuns'

Marme
D video
E' Presentations
= Specifications
(= Software
2D pownloads
E' User Guides
2 images

D Eeooooo’

Folder Itemn

Name |Specifications

oK || Cancel

If you are editing an Asset such as an image, the File Item page appears, allowing you to edit the name
as well.

ERCE File Item

File Item

ImageFolderElement

Name: calculator.png

OK || Cancel

Copying/Moving and Deleting Folders and Assets
Users can also copy/move and delete Folders and Assets.

To copy or move an Asset or Folder to another location, place a check mark in the box next to the Folder
or Asset name and then click on More Actions > Move/Copy.
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ERCE Asset List

DCreate Mew ;EII"-'II:urE Actions ™

[ Mame | % Delete Selected
[] [} Move/Copy

[Elf_'alculatur

The Move/Copy to Folder pop-up appears. You can select to "move" or "copy to folder." From the drop-
down menu, select the destination. Click on OK to confirm.

Move/Copy to Folder 4

@ move or [~ copy to folder: Ru:u:ut,."Presentatiu:un5| v|

To delete a Folder or Asset, place a check mark in the box and click on More Actions > Delete Selected.

ERCE Asset List

DCreate Mew ;EII".-'IDrE Actions

[l Marne || % Delete Selected {9}
[.] 3 Move/Copy

EI1.'.'EL|1:uIELt1:rr

Creating Folders and Uploading Files (Assets)
Users can create their own Folders and upload files.
Creating Folders

To create a new Folder, go to the Asset List by clicking Asset Management > Root (or any Folder under-
neath Root). Then click on Create New > New Folder.
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Asset List

DCreate Mew é]MureActiunsv

|D MNew Folder E

MNew File

Upload Multiple Files

=,

=k [EI Specifications
=¥ IE' Software
= IE' Downloads

= IE' User Guides

O 000 0|0

= = Images

Enter in a name for the Folder and click Create.

New Folder 4

Mame Audio Create|

The Folder will be created in whichever folder you are currently in. In this example, the Folder "Audio”
was created underneath Root.

[ create New~ | [ More Actions ™

Marme Size Created

B D video 5/11/2010 3:34:57 BM
B/ [ presentations 5/11/2010 3:34:57 PM
& 12 specifications 5/11/2010 3:34:57 BM
D software 5/11/2010 3:34:57 BM
= D E{bnluads 5/11/2010 2:34:57 BM
B D User Guides 5/11/2010 3:34:57 BM

B 15 images 5/11/2010 3:34:57 PM

Dooooooao D
Al

& audio Today, 3:15 PM

To see the Folder in the left navigation frame, click on the Refresh icon and the new Folder "Audio” will
appear. You can create additional subfolders underneath Audio (or any other existing Folder).

© EPiServer AB



Commerce Manager | 155

Asset Management %

=] Root
[ Video
[~7] Presentations
[ Specifications
7] Software
[ Downloads
[[JUser Guides

+ [ lmages

[ Audio

Uploading Individual Files

To upload a single File, navigate to the Folder you want to upload the File to and then click on Create
New > New File.

ERCE Asset List

D Create Mew 21 Mare Actions

[ Mew Folder

| ] NewFile

[ ] upload Multiple Files

Click on Browse or enter in the file path into the field. Once done, click on Upload.

Welcome, admin

ERCE File Item

License: ECF G5

) cet Help For This Page %

File Item
Click Browse and select file, or type file path:
C:\Usersh\anfi\Documents\Images'phone.jpg
Upload k
| 0K || Cancel |

A progress bar appears below. Once the upload is complete, the FolderElement form appears, allowing
you to edit the name of the File, if you wish. Once done, click OK.
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ERCE File Item

File Item

ImageFolderElement

Name: phone.jpg

OK || Cancel |

The File is now visible on the Asset List of the destination folder.

Asset Management L%‘ D Create Mew __‘T}:] More Actions
=<5 Root O Marne
[T Videao L]

|~7] Presentations H @ Shone.ipa
[ 7] Specifications
[ Software
[ Downloads
"] User Guides
+ [ ]lmages
[~ Audio

Uploading Multiple Files at One Time

To upload multiple Files to a Folder, click on Create New > Upload Multiple Files.

ERCE Asset List

D Create Mew ;2] Mare Actions~

[y Mew Folder

] NewFile

] Upload Multiple Files

,.‘

The Add Files pop-up window appears. Click on Browse to add Files. An additional field will appear
below, allowing you to add more. You can upload up to five Files at one time. One done adding Files,
click Upload.
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Add Files o
C:\Users'anfi\ Documents) Images' calculator.jpg
C:\Users|anfii Documents| Images| computer_cable jpg
Upload

A progress bar window will pop-up, showing you the progress of the uploads. Once complete, the Files
will appear in the Asset List.

Asset Management .-:*E' D Create New~ il More Actions
=15 Root O Mame
[ Video = L]
[ Presentations
[ = @ calculator jpg

[ 5pecifications
[~ 5oftware I:l =¥ @ computer_cable jpg
[ Downloads [l @ phone.jpg
[ User Cuides
+ ] lmages
| [JAudio

Reporting
Various reports are included out-of-the-box to help management and other personnel to make informed
decisions. The default reports include:

e Sales Report - this report provides an overview of a site's sales performance over a period of time

o Shipping Report - this report provides the shipping method, number of orders and total shipping
costover a period of time

o Best Sellers Report this reportis used to determine which products sold the most in terms of
quantity and total revenue over a period of time

e Low Stock Report - this report is used to determine which products are running low in inventory.
If a product's inventory is less than its reorder minimum quantity, it will be included in this report.

The display of these reports can be generated by Start and End date/time and filtered by
Day/Month/Year. In addition, they can be exported to Excel or PDF format, or printed.

SQL Reporting Services

Since the Commerce Manager utilizes SQL databases, custom reports can be created using Microsoft
SQL Server Reporting Services. Reporting Services provides a complete, server-based platform
designed to support a wide variety of reporting needs enabling organizations to deliver relevantinfor-
mation where needed across the entire enterprise. Read through the resources below to get familiarized
with Reporting Services and how you can create custom SQL reports to display data from your EPiServer
Commerce site.

e Reporting Services Features
e Using SQL 2008 Reporting Services and Report Builder 2.0 to Create Custom SQL Reports
e Download Report Builder 2.0
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e Reporting Services and ReportViewer Controls in Visual Studio
e Reporting Services Components and Tools
e Reporting Services Configuration How-To Topics

Generating and Customizing Reports

By default, users can generate Sales, Shipping, Best Sellers, and Low Stock Reports about the site.
Reports can be customized/filtered and exported to suit the needs of the user.

To generate a report, click on Reporting > Sales > Sales Report/Shipping Report or Reporting > Prod-
ucts > Best Sellers Report/Low Stock Report.

MERCE Sales Report
out T
Start Date:[5/7,2010 EHl[12:48pm | End Date:5/7/2010 ##[12:45pM |GroupBy: Day  [~|[ Apply Filter |
4 4 I of1 [ Pl 100% [+] Select a format  [w| Export & =]
Sales Report (05/08/2010 - 06/07/2010)
Period Num. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders
05/08/2010 0 0 0 0 0 0 0 0
05/09/2010 0 0 0 0 0 0 0 0
05/10/2010 0 0 0 0 0 0 0 0
05/11/2010 0 0 0 0 0 0 0 0
05/12/2010 0 0 0 0 0 0 0 0
05/13/2010 0 0 0 0 0 0 0 0
[os/1472010 0 0 0 0 0 0 0 0

Customizing/Filtering and Exporting Reports

Users can select the Start Date and End Date ranges and time as well as group the Report data by "Day,
"Month" or "Year." Once done, click on Apply Filter.

An example Sales Report with a date range from 5/1/2010 at 6am to 6/7/2010 at 12pm Grouped By
Month is in the screenshow below.

MERCE Sales Report
ut T
Start Date: 5 /1/2010 [ lo5:00 AM | End Date: 5/7,2010 #12:00 Pm | Group By:| Month [+ ]
4 4 1 of1 P Pl 100% [+] Select a format  [w] Export [# =
Sales Report (May, 2010 - June, 2010)
Period Hum. Of Items Ordered Sub Total Tax Shipping Discounts Total Invoiced
Orders
May, 2010 0 0 0 0 0 0 0 0
une, 2010 5 10 41,318.61 0.00 52.00 0.00 41,370.61 41,370.61
5 10 41,318.61 0.00 52.00 0.00 41,370.61 41,370.61

Users can also change the zoom size of the report by clicking on the drop-down menu with "100%." Also,
paging controls are available next to the zoom drop-down menu. Users can also reload the report by click-
ing on the Refresh icon.

To Export a report to a file format for sharing with others, click on the drop-down that says "Select a for-
mat." Select a format from the drop-down menu, such as Excel or PDF. Click on Export and Open or Save
the file once the prompt appears.
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System Administration

This guide includes various configuration tasks such as setting up Shipping and Payment Gateways, your
default language, currency, units, tax configuration, licensing, and search settings. Often, these settings
are not configured by users. Most of these configuration tasks are achieved in the Commerce Manager
Administration area.

System Settings

This sections covers how to setup EPiServer Commerce with payment methods using built-in Payment
Gateways and setup the default Language, Currency, and Units.

Business Foundation

Itis a new generation of Meta Data Engine that allows no-code customization of the Data Model. We
enhanced our Meta Model in this new version. In the previous version you could only add fields to the
existing meta objects and now you can define new objects and relations between them.

The form is fully customizable so you can define layout and specify which fields you want to display. You
can also work with system fields which was previously impossible.

The current implementation of Business Foundation only supports the Customer Management and Asset
Management systems. Support for other Commerce Manager systems is planned for the future.

Customizing Existing Business Objects

Out of the box, Commerce Manager includes Business Objects that can edited and customized. Cus-
tomizing existing business objects is a good starting point for end users to model business objects for
their needs. However, pre-existing business objects such as "Address" and "Organization" cannot be
deleted, only edited.

O The current implementation of Business Foundation only supports the Customer and Asset

Management subsystems. Support for other subsystems such as Order and Catalog are
planned for future releases.

Fields in the Business Foundation

This section covers how to add or edit different types of data fields within an existing business object.

© EPiServer AB



160 | User Guide for EPiServer Commerce 1 R2

Adding Fields to Business Objects

Existing Business Foundation Objects can be customized to have additional data entry fields. For exam-
ple, you can add fields to the New Credit Card form built-in to Commerce Manager.

To add new fields to Business Object, click on Administration, expand System Settings, and click on Busi-
ness Foundation to access the list of Business Foundation Objects.

Administration L{?

=I5 System Settings

H ] Sites
+ ] Dictionaries

] Logs
=B Common Settings

Business Foundation

|
= Search Index
= Left Menu

+ [ Catalog System

+ [ Order System

In this example, the CreditCard Business Object is used.

ERCE Configuration 1: 5.1 (build: 24)
C _F G5 Deployment (EpiServer)
T {0 Get Help For This Page %

Dcreahe New » ﬁExporfﬂmportv
Show: |All [=]

System Name Friendly Name Plural Name Type
{3 Address Address Address Infa
3 Contact Contact Contact Infa
3 CreditCard Credit Card CreditCard Infa
£ Customizationitem Customization ltem Customization Items Info
-;;g CustomizationltemArgument Customization ltem Argument Customization tem Arguments Info
'33 CustomPage Custom Page Custom Pages Info
4§ Folder Folder Folder Info
4§ FolderElement FolderElement FolderElement Info
8 ImageFolderElement ImageFalderElement ImageFolderElement Card
&3 Member Member Member Infa
“ NewObject NewObject NewObject Info =
-;;g Organization Organization QOrganization Info
&5l PdfFolderElement PdfFolderElement PdfFolderElement Card
JgRecentReferenceH\stnry User Recent Reference User Recent References Info

If you want to add a new field to this CreditCard Business Object (or any other Business Object), click on
New Field.

Object C i i ¥|§_§| MNew FiEIPL E¢ Edit E;ﬂJJ Publi:
System Name: 33 CreditCard Friendly Name: Crng\,l Card
Type: Business Object Plural Name: CreditCard
| Fields || 1:N Relations || MN:1 Relations || M:M Relations || Forms || System Views
Systern Name Friendly Name Type

2% Address Address Text (ReferencedField)

The New Field form allows you to specify the type of data field you want created for the Business Object.
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Friendly Name:

Description:

CustoemerServicePhoneNumber

Maximum Length:

New Field B Back
Business Object: Credit Card Field Type: String El
Field Name: CustomerServicePhoneNumber Format: Text El

100

D Unique value

« Save ‘ | X Cancel

[ aniow Nunis |

Edit Form
View Form
Short Info Form

Add Field To:

1. Enterin a Field Name, which is the system ID or name of the field. The Field Name thatis entered
autopopulates the Friendly Name field.

2. Since the Friendly Name is autopopulated based on the Field Name, you can either keep the
name the same or change it. The Friendly Name is what appears on a form (such as the Credit
Card form)

3. You can optionally enter in a Description that appears below the data entry field to explain the

field to the user.

Checkmark on or off to Allow Nulls for this field

You can choose to Add Field To an existing Form. Checkmark all that apply.

Enter in a Field Type. For further explanation of each Field Type, refer to the Reference Section on

the bottom of this page. In this example, a String field type is used.

a. The Format drop down menu and options depend on your Field Type selection. In this exam-

ple, Text is selected as the field format, with a Maximum Length of 100. Unique value is left

unchecked.

7. Once done, click Save. The new field appears on the list of fields.

ook

¥ CreditCardid Id Guid

¥ CreditCardNumber Card Number Text

W CustomerServicePhoneNumber Customer Service Phone Number Text =

av ExpirationMonth I}, Expiration Month Integer

To verify if the new field appears, check the form associated with that new field. Since this example cus-
tomized the New Credit Card form, you will see that the new field appears.

New Credit Card X

~— Overview

Type: Visa [=] 5
Last Four Digits: Expiration Month: [Novalue]l [+]
Card Number: Expiration Year: [Novalue]l [+]
Security Code:
Customer Service
Phone Number:

+ DK || A Cancel
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Editing Fields of Business Objects

Fields created by the user can be edited. To edit a field, click on the Edit icon.

O Fields that are locked cannot be edited.

4" CreditCardNumber Card Number Text

¥ CustomerServicePhoneNumber Customer Service Phone Number Text ?'ﬁ *
av ExpirationMonth Expiration Month Integer
av ExpirationYear Expiration Year Integer

The only attributes that can be changed are Friendly Names and Descriptions. Once those changes are
made, click Save.

Edit Field EJ Back
Business Object: Credit Card Field Type: String
Field Name: Format: Text
Friendly Name:- Customer Service Phone Number @ Maximum Length:-
Description: Phone # found on back of card

 Save RA [ % cancel

Relations in the Business Foundation

In order to track and record relevant data, business objects must be related to other objects, whether they
are "1 to many," "many to 1","many to many." Currently, business objects only affect the customer and
asset management systems.

e 1 to Many Relationship - 1 object can be associated or related with multiple object-related data.
For example, one organization can be associated with multiple contracts.

¢ Many to 1 Relationship - Multiple object-related data can be associated or related with a single
object. For example, multiple contacts can be related to a single organization.

e Many to Many Relationship - Multiple object-related data can be associated or related with mul-
tiple objects. For example, different SKUs can be associated with one or more Warehouses for
tracking and storage.
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Adding a | to Many Relation

Business Foundation objects allow a user to specify "1 to many" relationships. For example, if you have
one organization, you can relate many types of data to that organization, such as multiple contacts,
addresses, or organizational units or divisions within an organization. Within a 1:N relationship, the busi-
ness object you selected will be "1."

In the example below, 1 = Organization and N = related objects such as Address, Contact, CreditCard,
etc.

To add a 1 to many relationship to a business object, you will need to create a new business object or
use an existing one. On the Business Object Customization page, click on 1:N Relations.

ERCE Configuration
B & Get Help For This Page ©
Busi; Object C izati E MNew Field Edit | 2 Publish EJ Back To List
System Name: jg CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name: CreditCard
| Fields || 1M Relatlorw;L || N:1 Relations || M:M Relations H Forms H System Views
System Name Friendly Name Type
:,v Address Address Text (ReferencedField)
@ Addressld Address Reference
&¥ CardType Type CreditCardType
3\4 Contact Contact Text (ReferencedField)
g4 Contactld Contact Reference
8" Created Created DateTime

Click on New Relation "one to many" to create a new relation.

Busi Object C izati: 5] New Field Edit | 2 Publish EJ Back To List
System Name: 33 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
‘ Fields || 1:N i H MN:1 Relations || N:N Relations || Forms || System Views

E New R@t\on “one to many”

Name Primary Object Related Object
g,t\ Address Organization Address
= Contact Organization Contact
G CreditCard Organization Credit Card =
g Organization Qrganization Organization =

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Select a Related Object to relate an the Organization object in the dropdown.

2. The Object section below General Info will have a different title based on Related Object you
selected. For example, if you selected "Address," the title would be "Object 'Address™.

3. Enterin a Field Name and Friendly Name. They are autopopulated already using the system
name of the business object.

Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

4. Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

5. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).

6. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

7. Once all the relevant information is entered, click on Save.
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Relation 1:N

— General Info

Primary Object: Organization

Related Object: Address El

~— Object "Address”

Field Name: Organization
Friendly Name: Organization

Allow Nulls
Add Field To: Edit Form

View Form
Short Info Form

~— Object "Orgamnization™

Display Region: [ Not Set ] El

| + Save | | ¥ Cancel

O The Related Object will have the Primary Object appear under the opposite relationship (N:1)
on its configuration form. For instance, if organization is the Primary Object and the Related
Objectis Address, the relationship is automatically generated under the N:1 tab in Address.

Configuration

(bl
ECF G5 Deployment (EpiServer)

@ Cet Help For This Page %

Business Object Customization 2 New Field | (= Edit | 22 Publish | £ Back To List
System Name: 4 Address Friendly Name: Address

Type: Business Object Plural Name: Address
[ Fields || 1:N Relations || N1 Relations || N-NRelations || Forms || System Views

*E New Relation “ane to many’

Name Primary Object Related Object

@ Contact Address Contact =
@ Contact Address Contact =
- CreditCard Address Cradit Card =
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Adding a Many to | Relation

Users can also relate business objects via a "Many to 1" relationship. For example, you can relate mul-
tiple contacts to a single organization or unit.

In the example below, N = Organization and 1 = related objects such as Parentld, PrimaryContactld etc.

To create Many to 1 relationships, click on a business object and click on the N:1 Relations tab.

me, Manager

ERCE Configuration oduct Version: 5.1 (build: 24)
cense: ECF G5 Deployment (EpiServer)
v @) Cet Help For This Page %
Object C izati = New Field Edit | &3 Publish | [£J Back To List
System Name: _;3 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
| Fields || 1:N Relations H N:1 Relations || N:N Relations || Forms || System Views
System Mame Friendly Name Type
&Y BusinessCategory Business Category BusinessCategory
#"¥ Created Created DateTime
5" Creatorld Creator Cuid

Click on New Relation "Many to one" to create a new relationship.

Busi Object C izati = New Field Edit | 2 Publish B3 Back To List
System Name: ;3 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
| Fields H 1:N Relations || N:1 {1 || N:N Relations || Forms || System Views

)El New Relatjon “many to one”|
System Name Name Primary Object Related Object @

;-p Parentld Parent Organization Organization &

= PrimaryContactld Primary Contact Contact Organization =

The Relation N:1 form is very similar to the Relation 1:N form, except you can select the Primary Object
from the dropdown, whereas the Related Object defaults to the name of the Business Object.

Under General Info, the Primary Object Organization is automatically set to Organization.

1. Selecta Primary Object to relate an the Organization object in the dropdown.The Object section
below General Info will have a different titte based on the Related Object name.

2. Enterin a Field Name and Friendly Name. They are autopopulated already using the system
name of the business object.

Both names must be unique and not be the same as an existing field. The Field Name cannot con-
tact spaces or special characters, only letters, numbers, and underscores.

3. Checkmark the box Allow Nulls if you do not want this to be a required field the user fill in while
editing a form. Otherwise, uncheck the box to make it a required field.

4. Under Add Field To, checkmark the Forms you want the field to render in, such as the Edit Form
(to enter and submit information) or View Form (read information only).

5. Under the Object "Name of Primary Object" section, select a Display region in the dropdown box.
Additional options such as Display Text and Display Order will appear based on your dropdown
menu selection.

6. Once all the relevant information is entered, click on Save.
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Relation MN:1

~— General Info

Primary Object: Address El

Related Object: Organization

— Object "Organization”

Field Name: Address

Friendly Name: Address
Allaw Nulls

Add Field To: Edit Form

View Form
Short Info Form
System View (All organizations)

~— Object "Address”

Display Region: [ Mot Set ] E|

| " Save | | % Cancel

.: Like an 1:N relationship, if you create a N:1 relationship with a Primary and Related Object, a
1:N relationship is automatically generated for the Primary Object under the 1:N tab.
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Adding a Many to Many Relation

Users can also create Many to Many relationships with business objects. For example, many to many rela-
tionships help to track different SKUs and their inventory levels with different warehouse locations.
Another example is multiple contacts a part of multiple organizations. A Many to Many relationship
between two objects is also referred to as a Bridge.

In the example both Organization and Organization_Contact = N.
To create a Many to Many relationship, click on a business object and then click on the N:N Relations
tab.

Welcome, Manager

CDI"Iﬁg uration Pro ersion: 5.1 (build: 24)
License: ECF G5 Deployment (EpiServer)

@ Cet Help For This Page ‘7

Object C izati 5 New Field Edit | 23] Publish | [£J Back To List

System Name: _;3 Organization Friendly Name: Organization
Type: Business Object Plural Name: Organization
‘ Fields H 1:M Relations || N:1 Relations || MN:N Relatmnsnh” Forms H System Views

System Name :'\eﬂ\en-l Name Type
¥ BusinessCategory Business Category BusinessCategory
2" Created Created DateTime
57 Creatorld Creator Guid
5* Description Description LongText
=" Modified Modified DateTime

Click on New Relation "many to many" to create a new N:N relationship.

Object C izati =) New Field Edit | 23 Publish | [ Back To List
System Name: _{3 Organization Friendly Name: Organization
Type: Business Object Plural Name:- Organization
Fields H 1:N Relations || N:1 Relations H N:N {{ || Forms || System Views
E New Relation “many to many”|
L

The Relation N:N is much different compared to the Relation 1:N/N:1 forms.

1. The Current Object defaults to the name of the Business Object you are editing

2. Select a Related Object from the dropdown menu

3. The Relation Name is autopopulated by (Current Object Name_Related Object Name). Change
this name if you wish, but you cannot have spaces or special characters, only letters, numbers,
and underscores.

4. Enterin a Friendly Name, which can have special characters and spaces. Make sure both Rela-
tion and Friendly Names are unique do not already exist.

5. Under Current Object, select a Display Region where the field will appear.

6. Under Related Object, select a Display Region where the field will appear.

Once all the relevant information is entered, click on Save.
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Relation N:M

General Info

Current Object: SKUs

Related Object: SKU_Warehouse El
Relatiom Name: SKUs_Warehouse

Friendly Name: SkKUsS5KU= Warehouses

Current Object (SKUs)

Display Region: Information El
Display Text: SkUs Warehouses
Display Order: 10000

Related Object (SKU_Warehouse)

Display Region: Information E|
Display Text: SKU=s
Display Order: 10000

| " Save | | ¥ Cancel

O A many to many relationship is automatically generated for the related object when you click
on its N:N tab under its configuration form.

Forms in the Business Foundation

Forms dictate how fields are presented to the user when view and editing information. This section shows
you can customize forms for viewing and editing by end users.
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Customizing an Existing Form

Every field is associated with a Form. Each Business Object is associated with one or more types of
forms. The common types of forms found in Commerce Manager are the Edit Forms, Short Info Forms,
and View Forms. For example, the New Credit Card form looks like this:

New Credit Card *

— Overview
Type: isa El ﬁf'

Last Four Digits: Expiration Month: [ No value ] [=]
Card Number: Expiration Year: [ No walue ] [=]

Security Code:

Customer Service
Phone Number:

| n Ok | | ﬂ Cancel

By editing the form, you can change the layout, add new fields and sections, and more.

To edit an existing form, click on a Business Object and click on the Forms tab to see the list of asso-
ciated forms.

Object C izati = New Field | &= Edit | 23) Publish | [ Back To List
System Name: 33 CreditCard Friendly Name: Credit Card
Type: Business Object Plural Name: CreditCard
Fields || 1:M Relations H N:1 Relations H N:N Relations H Forms || System Views

Name

Edit Form

Short Info Form

View Form

Click on the Edit icon next to the form you want to make changes to. The form customization window pops
up.
Common Tasks faReaeate Form | it Form | [Esave v

Table: Credit Card Form: Edit Form

Addv | ft 4 4@ o | @fEdt | XK Remove ‘

Overview
Type:
Last Four Digits. Expiration Month
Card Number: Expiration Year:
Security Code

Customer Service
Phone Number:

There are various functions available to edit and customize a form.

Editing the Layout of a Form

You can change the layout and the fields that appear on the form.
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1.

2.

Click on Edit Form.

a. Select a View Type (or the layout of the form). You have a choice between a Two Column (1:1,
1:2,2:1), or Three Column (1:1:1) layout.

b. Enter in a pixel value for the Cell Padding, or spaces between each cell.

Click Save to confirm your changes.

This example uses a Two Column (1:1) layout.

Common Tasks ‘Z|Recreate Form pEdit Form Hsave ~

Table:

,
- - Wi —
Credit Card & eCommerceFramework - Windows Intern... e S

Add ~

— Owerview

T+ 3 = =2 E|§‘ http:--ch.episer\.rer.mm-;ppz-l'.leteDeteBeze-l'.lete'JI-Pegez-| |

Edit Form

‘You can edit form.
Type:
Last Four Digits: Table: Credit Card
Card Number:

Form: Edit Form
Security Code:
Customer Service View Type:
Phone Number:

° Two Columns (1:1)

©) Two Columns (1:2)

©) Two Columns (2:1)

(©) Three Columns (1:1:1)

Cell Padding: 5

Save Cancel

@ Internet | Protected Mode: On dy v H100% ~

Adding Sections and Fields

Once your layout is set, you can add additional sections and/or additional fields.

1.

2.
3.

Click on Add --> Add Section to add a new section. Adding sections allows you to separate and
divide groups of fields on a form with their own header and border.

Enter in a Title for the section.

Checkmark the box next to "Show border line for this section" if you want to show the border
around section. Otherwise, uncheck the box to hide the border.

Checkmark "Show the name of this section on the form" if you want to show the title of the section
on the form. Otherwise, uncheck the box to hide the title.

Select a View Type or layout of the section: One Column, Two Columns (1:1), Two Columns (1:2),
Two Columns (2:1)

Enter a numeric pixel value for Cell Padding or amount of space between each cell in the section.
Click Save to save your changes.

© EPiServer AB



Customizing an Existing Form | 171

Common Tasks ] Recreate Form | [#&Edit Form Hsave «
i
& eCommerceFramework - Windows Intern... L= -: X

Table: Credit Card

e &+ 3 & o et | Xeem |§, http://ecf.episerver.com/Apps/MetaDataBase/Metall/Pages;

Add Section Add Section
‘% Add Field S Add a new section to the form
Last Four Digits: Title: Credit Card 2|

Card Number:

Security Code: Show border line for this section.

Customer Service
Phone Number:

Show the name of this section on the form.

View Type: S x|

@ One Column = =| I | SESCEEEECEELEEEELLEEE :

) Two Columns (1:1) | °

) Two Columns (1:2) _'

) Two Columns (2:1

Cell Padding: ¢

Save Cancel
0 Internet | Protected Mode: On v ®100%

You can edit a section by clicking on a section and click on Edit.

Common Tasks ‘e Recreate Form |ZEdit Form Hsave -
Table: Credit Card Form: Edit Form

Add ~ T+ F = = m ¥ Remove |

________________________________

Type:
Last Four Digits: Expiration Maonth:
Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number:

( Credit Card 2

Within each section are fields. You can add new fields to a specific section by highlighting the section and
then by clicking Add --> Edit.
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Commeon Tasks E Recreate Form &dit Form u Save w

Table: Credit Card Form: Edit Form

4+ 4 & = | =edt | X Remove |
g Addsecon |

| % Add Field \D_',)t

Last Four Digits Expiration Month:

Card Number: Expiration Year:
Security Code:

Customer Service
Phone Number:

Last Four Digits

: ( Credit Card 2

Select an existing associated field in the dropdown menu.
a. Checkmark the "Field is Read Only" box if you want the field to be unavailable for edit. When you see
the rendered form, the field will be grayed out.

1. Selectthe "ltem label showing on the form."
2. e Hide Label: No label appears next to the text box
e System Label: Shows the system name next text box
o Custom Label: Enter in a custom label
Enter in a Label Width numerical value. Defaultis 120px.
Tab Index: enter an index for the tab.
Select a View Type, either a One Column or Two Column. In the dropdown, enter in the number of
text box rows, up to 3.
6. Click Save to add the field to the section.

ok w

Common Tasks ‘f5Recreate Form [FéfEdit Form EHsave ~
i Y
Table: Credit Card @ eCommerceFramework - Windows Intern... EI_IQ
Add ¥ 4 4 &= = | Zedt | ¥ Remo |@, http:_-'_-'ecf.episen.rer.(om_-';i\pps_-'MetaDataBa:&,-'MetaUL'Pages_-|
| — Overview Add Field
| Add a new form item to the form.
Type
Last Four Digits: Field: Organization -
SR RITESE [ Field Is Read Only
Security Code:
Customer Service EEem label showing on the form.
Phone Number: ) Hide Label
B —1 System Label —
: ( T o :
Label Width: 120 px E ]
3 Tab Index: 0
View Type:

==
@ One Column | —

[ ) —
) [ C 3
) Two Column | &

——

Rows: 1 -

Save Cancel

0 Internet | Protected Mode: On a3 v H10% ~

B

© EPiServer AB



Customizing an Existing Form | 173

To edit a field, click and highlight the field and click on Edit to change your previous settings.

Common Tasks ‘5 Recreate Form [#pEdit Form EHsave ~

Table: Credit Card Form: Edit Form

Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number:

1 Credit Card 2
: (Drganization:

You can re-arrange fields on a form but using the arrow controls on menu bar. Highlight the field and then
click on the directional arrow you want the field to move to.

Common Tasks ‘= Recreate Form [&Edit Form Hsave ~
Table: Credit Card Form: Edit Form

Add~ | ¢ 4 4= = | =edit | X Remove |

Overview
Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:
Security Codp:

Customer Service
Phone Number:

| — Credit Card 2
E (Organizatmn:

In this example, the "Security Code" field is moved to the right where the "Customer Service Phone
Number" field is placed by clicking on the right directional arrow. Fields are moved from cell to cell within
a section.

Common Tasks ’if_E| Receate Form | [#Edit Form m Save -
Table: Credit Card Form: Edit Form
add~ | ¢ 4 4= EEdit | 3 Remove |
Overview

Type:

Last Four Digits: Expiration Month:

Card Number: Expiration Year:

Security Code:

Customer Service
Phone Number.

|~ Credit Card 2
(Organizat\on.
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Deleting Sections and Fields

To delete a section or field, highlight either one and click on Remove. A popup will appear. Click OK to
confirm deletion. Otherwise, click Cancel.

Commen Tasks )i% Recreate Form | [#Edit Form m Save

Table: Credit Card Form: Edit Form

addv | ¢ 4 = = | et )(_Ramgua |
Overview
Type:

Last Four Digits: Expiration Month:

Card Mumber: Expiration Year:
Security Code:

Customer Service
Phone Number:

' Credit Card 2
E (Drganization:

[ ok || Concel

Recreating a Form

Recreating a form allows a user to create a form from scratch with a single field rather than customize a
form with all fields already in place. Click on Recreate Form on the upper right corner of the window.

Common Tasks t! Recreate Form| | &Edit Form Hsave +
Table: Credit Card Form: ‘h

Edit Form

add~ | 4 4 & = | SEdt | ¥ Remove ‘

Type

Last Four Digits: Expiration Month

Card Number: Expiration Year:

Security Code

Customer Service
Phone Number:

A popup will appear. Click on OK to recreate the form. Otherwise, click Cancel. Once you confirm, the
fields will clear from the form except for the required field.
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Common Tasks yF’_§| Recreate Form ingdit Form n Save ¥
Table: Credit Card Form: Edit Form
Add~ | 4§ § 4= = | FEdit | P Remove ‘
Credit Card
(Card Numbner:: w

Saving a Customized Form

Once you are done with your changes, click on Save on the upper right corner of the window. To save
and close the window at the same time, click the down-arrow next on the Save button and on the drop-
down click Save and close.

Common Tasks ‘= Recreate Form »_giEdit Form | [l save I -

Table:- Credit Card Form- Edit Form
E, Save and cldze

Ad~ | 4 $ <= = | m5Edt | ¥ Remove

Overview
Type:
Last Four Digits: Expiration Month:
Card Number: Expiration Year:
Security Code:

Customer Service
Phone Number:

Once those changes are saved, the form you edited will render based on your configuration. For exam-
ple, here is the customized Credit Card edit form an end user sees.

New Credit Card st

— Owerview

Type: Wisa [=] 5
Last Four Digits: Expiration Month: [ No walue ] El
Card Number: Expiration Year: [ No walue ] [=]

Customer Service

5 ity Code:
Phone Number: ecurity Code

~— Credit Card 2

Organization:

{Cusramer:CreditCard_mif. Organization_Descriptian}

Creating a New Business Object

Creating new business objects allows users to extend customer and asset forms for tracking and relating
different types of data. Business Objects could be related in a "one to many," "many to one," or "many to
many" relationship.

This section covers an example of how to create and publish a Contract business object using a "many to
one" relationship.
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Scenario - Creating and Publishing a Contract Business Object

This is a basic step-by-step guide on how to create and publish a simple Contract Business Object for
relating multiple contracts to a single organization.
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Creating a New Contract Object

New Business Objects can be created to suits a multitude of business purposes. This example shows you
how to create a Contract business object.

To add new fields to Business Object, click on Administration, expand System Settings, and click on
Business Foundation to access the Business Foundation Configuration page.

Administration =

=] System Settings
H [ Sites
&[] Dictionaries
# (] Logs

=@ Common Settings

Business Foundation

o]
@ Search Index
@ Left Menu

#|_] Catalog 5ystem

H ] Order S5ystem

Click on Create New and on the dropdown click on New Business Object. The New Business Object
form page appears. Enter all relevantinformation.

come, admin

Configuration oduct Version: 5.2 (build: 243)
ce : ECF G5 Deployment (EpiServer)
wt T @ Get Help For This Page ¥
Mew Business Object ﬂ Back To L\st|
Base Info Field Info |
System Name: Contract System Name: Contract
Friendly Name: Contract Name @ Friendly Name: Contract Name @
Plural Name: Contract @ Maximum Length: 100
D Supports Extensions

+ Save | ‘ * Cancel

Base Info

e System Name: name of the Business Object (once you input a name, the Friendly Name and Plu-
ral Name fields are autopopulated)
Friendly Name: alternative to the System Name
Plural Name: plural version of the system/friendly name (e.g. inventories)

e Supports Extensions: this allows you to extend an existing meta class with extra properties. For
example, you can have a download class and you can extend it with "imagedownload" which con-
tains width and height as extra parameters.

Field Info

o System Name: enter in a system name
e Friendly Name: enter in a friendly, front-end name
e Maximum Length: maximum number of characters allowed in this field

Click Save to save changes.
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Busi Object C = New Field | &= Edit | 23 Publish | [ Back To List
System Name: v?[g Contract Friendly Name: Contract Name
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:N Relations || MN:1 Relations || M:N Relations || Forms || System Views
System Name Friendly Name Type
4" Contract Contract Name Text
2" Contractld Id Cuid

Add fields to the Contract business object as needed. Refer to Adding New Fields to Business Object
section for instructions on how to add new fields to a business object.

Click Save to save changes.
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Connecting a Contract to an Organization
Using a "Many to One" Relationship

The next step is to create a relationship between this contract with an organization. In this example, the
"Many to one" relationship will be used because multiple contracts can be tied to a single organization.

1. To add a relationship, click on the N:1 tab and click New Relation "Many to one" .

Welcome, Manager

ERC E C_Dnﬁg uration Product Version: 5.1 (build: 24)
License: ECF C5 Deployment (EpiServer)
v @ Get Help For This Page %
Business Object Customization E MNew Field Edit E;ﬂJJ Publish ﬂ Back To List
System Name: “I§ Contract Friendly Name: Contract Name
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || N:1 Relationsn || MN:N Relations || Forms || System Views
System Name y Friendly Name Type
&" Contract Contract Name Text
2" Contractld Id Guid

2. 0On the Relation N:1 form, select the primary object as "Organization." The Related Object will be the
Contract object (the friendly name appears as opposed to the system name)

3. Enterin a Field Name, such as "Organization."

4. Enterin a Friendly Name that will render next to the field in a user view.

Checkmark the box next to Allow Nulls if you want the user to be able to submit the form without having to
enter any data into the field. Otherwise, an unchecking this box means that this becomes a required field
that the user must enter data in.

5. Checkmark the boxes you want the field to render in, such as the Edit Form, View Form, and Short Info
Form.

O To learn more about forms, go to Customizing an Existing Form.

6. Lastly, set the Display Region using the dropdown menu. The display region determines which section
the field will appear within the business object--in this case, the Organization object. Note: Depending on
your selection, you may have additional options below the dropdown menu, such as Display Text and
Display Order. An example is below.

7. Click Save to save your changes and go back to the Business Object Customization form.
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Relation N:1

Ceneral Info

Primary Object: Organization El

Related Object: Contract Name

Object "Contract Name”™

Field Name: Organization
Friendly Name: Organization

Allow Nulls
Add Field To: Edit Eorm

View Form
Short Infa Form
System View (Ceneral View)

Object "Organization”

Display Region: Information El
Display Text: Contract
Display Order: 10000

| " Save | | » Cancel |

So now that the Organization business objectis tied to Contract, you will see that Contract now appears
under the Information section or the Organization Info view page.

Organization Info

Edit Organizations

Name: EPiServer Parent:
Information Contract |

Information %’Add Items EExcludesaected

Contacts

Organizations D Contract Name

Addresses [l

Credit Cards

Contract I~ |

L

O Since this example ties many contracts to a single organization, the organization business
object is automatically related to the contracts object as a "1:N" relationship.
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Busi Object C izati 2 New Field | = Edit | 23 Publish | [E Back To List
System Name: 33 Organization Friendly Name: Organization

Type: Business Object Plural Name: Organization
| Fields || 1:N il || M:1 Relations || MN:N Relations || Forms || System Views |

)El Mew Relation "one to many™|

Name Primary Object Related Object
[ Address Organization Address
gk Contact Organization Contact
O+ Contract COrganization Contract Name = }(
gk CreditCard Organization Credit Card =
@\ Organization Organization Organization =
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Publishing a Contract

Another feature of Business Foundation is the ability to publish objects within the left navigation frame as
a node. You can essentially add more functionality to a specific system without modifying code.

Now that the Contract object has been created and related to another object, you can publish itas a

node.

To publish a business object, click on Publish under the Business Object Customization form.

Welcome, Manager

CDnﬁg L I'atiDn Pro Version: 5.1 (build: 24)
. License: ECF G5 Deployment

@ Cet Help For This Page AF

B Object C izati E New Field Edit gﬂJJ Publisrr1| ﬂ Back To List
System Name: “I% Contract Friendly Name: Contract Na{l
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || MN:1 Relations || M:N Relations || Forms || System Views
System Name Friendly Name Type
2" Contract Contract Name Text
& Contractld Id Cuid
:;v Organization Organization Text (ReferencedField)
<3 Organizationld Organization Reference = X

A new window will pop up for publication settings.

@ {a} Dashboard 0 Display Region: < nothing is selected =
ﬂﬁ Customer Management 40
@™ Catalog Management 60 Display Text: Contract
© ¥ Order Management a0 Display Order: 10000
& ™ Marketing 100
1 Asset Management 120 Client Script: CSManagementClient.ChangeBafView('Contract’, 'Lis
ﬂﬂ] Reporting 130 Access . i icsi
— - . P . businessfoundation:contractlistpermission
=R Administration 200 Permissions:
Item Icon:
+" Publish

Select a Display Region from the navigation three on the left. Click on the node you want Contract
to be placed under. For example, Contract will be placed on the root level of Customer Man-
agement.

The Display Text defaults to the system name of the Business Object. You can choose to keep the
name or change it.

The Display Order defaults to 10000. You can keep it at that number or change the value to deter-
mine the position of the node.

The Client Script is autopopulated and can be left as is for most users. However, you can change
Client Script if necessary.

Access Permissions is autopopulated and can also be left as is. If you want to change Access
Permissions, refer to the Permissions section.

An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

Once all relevant information is entered, click on Publish.
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To verify if the object was published, go to the Display Region where you specified the object to be pub-
lished to. Click on the refresh icon on the left navigation frame if you at first do not see the new node.

O Always refresh your browser after publishing a business object.

Customer Management e

@ Crganizations
ﬁa Contacts
&2 Roles

=@ Contract

W

Adding Contracts to an Organization

Now that the contract business object has been published, you can add multiple contracts to a single
organization using a form. Click on the Contract node to bring up the list of contracts. Click on New to add
a new contract.

. Ve ore Manager
EP'SERVER COMMERCE List n: 5.1 (build: 24)
cense: ECF G5 Deployment (EpiServer)
Welcome ¥ Change Language About ¥ @ Get Help For This Page %
Customer Management ' || | |52 view:| Ceneral view [=]
4] Organizations S Printer Version | ¥ Delete
Contacts
'__3 ] %0 contract Name
&2 Roles
@ Contract a

Enter in a Contract Name (friendly name of the contract object) and select an Organization from the drop-
down menu to associate the contract with. This functionality is in harmony with the "N:1" relationship
between contract and organization.

ore Manager

Create o sion: 5.1 (build: 24)

G5 Deployment (EpiServer)

@ Cet Help For This Page %

Contract Name

Contract Name: HP Servers

Organization: | EPiServer

Click OK to save the contract. The View Form appears.

O To learn how to edit forms, go to the Customizing and Existing Form section.
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) Manager
View n: 5.1 (buil
ic G5 Deployment (EpiServer)
v & Get Help For This Page %
= Edit | ¥ Delete Back to list
Contract Name: HP Servers
Organization: EPiServer
Information Details
Details Contract Name
Contract Name: HP Servers
Organization: EPiServer

You can make further edits to the details of the Contract by clicking Edit or delete the entry. Otherwise,
click on Back to list to go back to the list of contracts.

By going to the Organization Info page for the particular organization you assigned multiple contracts to,
you will see the list contracts you assigned.

O You may need to make sure the Display Region is set for the related object (i.e. organization)
or else you will not see the business object in the Edit Form.

Organization Info

B @ Get Help For This Page %

Edit Organizations

Name: EFiServer Parent:
Information Contract |
Information %’Add Iterms EExclude_Selected
Contacts
Organizations D Contract Name

Credit Cards
| Contract |

Addresses ] (_‘] HPSEW@

Publishing Business Objects
A user-created business object can be published as a node anywhere in the left navigation frame to

extend functionality under that particular subsystem.

O You must refresh your browser after a business object has been published.

Permissions

When publishing Business Objects to place on a node on the left Navigation Frame, you can set per-
missions before publishing a Business Object.

Click on Publish on the Business Object Customization page.
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Welcome, Store Manager

ration rsion: 5.1 (build:
i se: ECF G5 Deployment (EpiServer)

€ Get Help For This Page %

Busi Object C izati 2 New Field | = Edit | 23 Publish | (£ Back To List
System Name: J[g Contract Friendly Name: Contract N}rﬁle
Type: Business Object (Public) Plural Name: Contract
| Fields || 1:M Relations || MN:1 Relations || MN:M Relations || Forms || Systemn Views
System Name Friendly Name Type
2" Contract Contract Name Text
2¥ Contractld Id Cuid
:gv Organization Organization Text (ReferencedField)
<3 Organizationld Organization Reference = )(

You can set permissions by customizing Access Permissions. This string is auto-generated. To
change, you can copy and paste string values from other objects.

@a} Dashboard 0 Display Region: < nothing is selected =
ﬂﬁ Customer Management 40
@™ Catalog Management 50 Display Text: Contract
i‘H Order Management 30 Display Order: 10000
= ™™ Marketing 100

__1 Asset Management 120 Client Script: CSManagementClient.ChangeBafView('Contract’, 'Lis|
w3l Reporting 130 Access - i fo

— . . e . businessfoundation:contractlistpermission
@ Administration 200 Permissions:

Item Icon: Ib

+" Publish

Deleting Published Business Objects

Once a business object has been published, you can delete all customized business object by going to
Administration > System Settings > Business Foundation. To remove from the Left Menu, you have to
perform an additional step of going to Administration > System Settings > Left Menu and clicking the
Delete icon.
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Start CcMs EPISERVER @ 7?7 -~ Ladmmn~ Q

Commerce Manager Settings

EPISERVER COMMERCE

Welcome ¥ Change Language About ~

Manager
5.1 (build: 24)
Deployment (EpiServer)

i@ Get Help For This Page +

Left Menu

Administration 2 || Jada
=3 System Settings Title Order
@] Sites Dashboard 0
(] Dictionaries
= Home 10
@] Logs
= Gommon Sentings = Customer Management 40
B Business Foundation Organizations 20
B Search Index Contacts a0
B Left Menu
= Roles s0
(] Catalog System
=
& Order Sysiem = @ Contract 10000
B/ Catalog Management 50
Catalog Entry Search 10
= Catalog Batch Update zo
Catalogs 30
E¥  Order Management 80
Order Search 10
Dashboard
= Purchase Orders 20
Customer Management
Iiﬂ Today 10
=
T E, R -
-ﬁ Order Management This Menth 20
= All 40
E Marketing e
Purchase Orders By Status 30
/ﬂ Asset Management
= = Carts 40
: Reparting
m Administration Page Size: |20 [¥] (78 items) | Page 41234y

Creating Dictionary Values for Adding Languages, Countries and Currencies

This guide walks you through how to add Languages, Countries, and Currencies to EPiServer Com-
merce.

Adding New Languages

By default, you are given several Language options. To add a new Language, login to Commerce Man-
ager and go to Administration --> System Settings --> Dictionaries --> Languages.

Administration ;:E‘

=5 System Settings

H ] Sites
== Dictionaries

| = Languages

g

When you click New Language fill in the following:

=@ Countries

o] Currencies

e Language Code - to obtain code, go to this MSDN site: htfp:/msdn.microsoft.com/en-us/li-
brary/ms533052%28VS.85%29.aspx (you must use the codes that contain dashes "-")
e Friendly Name - this name is displayed in the front-end site language drop-down and various

Commerce Manager admin pages.
e Is Default - Yes/No
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MERCE Language Edit

L

Overview

Code: en-Us
Language code (for example, en-LUs)

Friendly Name: English

|5 Default: 1 Yes @ No

Ok || Cancel

Click OK to save the language.

Adding New Countries

To add a new Country, login to Commerce Manager and go to Administration > System Settings > Dic-
tionaries > Countries.

Administration P

=] System Settings

H [ ] Sites
=I=5 Dictionaries

= Languages
| =@ Countries E
=X Currencies

Click on New Country and fill in the following displayed in the Overview tab:

e Country Name - this is the friendly name that is displayed in the public site during the checkout
process

e Code - to obtain the code, go to this MSDN site http./msdn.microsoft.com/en-us/li-
brary/ee799297%28CS.20%29.aspx (use the ISO Short Code or ISO Long Code as long as you
remain consistent)

e Sort Order - enter a number starting from 0 (the lower number is listed on the top of the drop-
down)

e Visible - Yes/No

ERCE Country Edit

-

Overview Regions

Country Mame:

Code:

Sort Order: 0

Visible: ™1 Yes @ No
Ok || Cancel |

Regions refer to states, provinces or prefectures. In the Region tab, fill in the following:

e Type a Friendly Name (e.g. CA - this will be displayed in the public site during the checkout proc-
ess) and click Add. You can checkmark it either as Visible or not on the public site
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Owverview Regions

New Region Name CA
Regions:
Edit Command Mame Ordering Visible
| X CA o
| QK || Cancel |

When you click the Edit icon, you can change the Ordering of the region. Click Update to save those

changes.

Regions:
Edit Cornrmand  Mame Ordering Visible
Update | Cancel ©CA o

Adding New Currencies

To add a new Currency, login to Commerce Manager and go to Administration > System Settings >
Dictionaries > Currencies.

Administration P

=143 System Settings
o] Sites

== Dictionaries

@ Languages

@ Countries

o] Currencies
H ] Logs

Click on New Currency. Fill in the following displayed in the Overview tab:

e Currency Name - this name is displayed in the front-end public site currency drop-down and var-
ious Commerce Manager admin pages

e Code - this currency code needs to be obtained from this site http./en.wikipedia.org/wiki/ISO _
4217#Active_codes

MERCE Currency Edit

L

Owverview Rates

Currency Name:
Code:

Modified:

] || Cancel

In the Rates tab, you can Add Rates which are the foreign exchange rate when you want to convert from
one currency to another.

COwerview Rates

Add Ra%b

Edit Command  Currency Rate Rate Date Modified

| (o]8 || Cancel
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When the Edit Currency Rate Information popup appears, enter in:

To Currency - select from the drop-down the Currency to convert to from the current currency.
End of Date Rate - enter in the End of Day rate.

Average Rate - enter in the Average rate.

Currency Rate Date - enter in a Currency Rate Date.

Then click on Save Changes.

Edit Currency Rate Information =
From Currency: Australian dollar (AUD)

To Currency: Canadian dollar |z|

End Of Day Rate:  |0.0000

Average Rate: 0.0000

Currency Rate Date5/25,2010 m 11:25 AM

Modified: 5/25/2010 11:25:12 AM

Setting Your Default Language, Currency and Units

To set your default language, currency or unit, login to the Commerce Manager and go to the Admin-
istration --> System Settings --> Common Settings and make appropriate selection.

Administration 1,%‘

(=1 System Settings
[# ] Sites
[+ ] Dictionaries
== Logs
B System Log
= Application Log

@ Common Settings
= Business Foundation \rb_

B Search Index
= Left Menu

Out of the box, you have the following options:

Language - English, German, Spanish, French

Currency - US dollars, Canadian dollars, Euros, Yen, Pound sterlings and many others
Length units - meters, feet

Weight units - kilograms, pounds
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ERCE Common Settings

Owverview

Default Language: | gnglish (United States) [ » |
Language that will be selected By default in drowdowns, etc.

Default Currency: | Us dallar |E|

Currency that will be used is cases where currency s needed but not specified
Default Length Unit: |Faat E‘

Default umit of length

Default Weight Unit: |pgyunds |E|
Default unit of weight

QK || Cancel

Click OK to save your changes.
Customizing Left Menu

Prior to customizing your left menu, we advise you to read the publication section of Business Foundation
to configure Business Objects as individual nodes in the left navigation frame.

Adding a Left Menu Item from the Left Menu Page

To add a Left Menu item, you have two choices. You can either configure the entire menu item first within
Business Foundation or you can add an empty container by clicking the Add button and then go back to
Business Foundation to fill in the page contents (objects).

Start CMS Commerce EPISERVER © 7 ~ X admin~ Q
Welcome ¥ Change Language About ™ @ cet Help For This Page %
Administration = DA
=5 System Settings Title Qrder
H) Shes Dashboard 0 Eul
i+ (] Dictionaries
Home 10
© (] Loas
T (G SRS B Customer Management 40
@ Business Foundation = Organizations 30
@ Search Index Contacts 40
@ Left Menu
Roles s0
4 ] Catalog System
=
@] Order System = Catalog Managament 60 |
k = Catalog Entry Search i0
=
ﬁ Dashboard = Catalog Batch Updats 20
Catslogs 20
m Custamer Management
Crder Management 80
e
Catalog Management = Order Search 10
-ﬁ Order Management = Purchase Orders 20
= . e
E Marketing Today 0
= This Week 20
eﬂ Asset Management
= = This Month 20
Reporting =i all an kv
(7] Administration Page size: |20 [7] (77 items} | Page 41234 )

A new window will pop up for publication settings.

1. Selecta Display Region from the navigation three on the left. Click on the node you want Contract
to be placed under. For example, Contract will be placed on the root level of Customer Man-
agement.

2. The Display Text defaults to the system name of the Business Object. You can choose to keep the
name or change it.
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3. Enterin an ltem Link, an URL to a page. When the object is clicked, a new window will appear on
the right based on the given link.

4. The Display Order defaults to 10000. You can keep it at that number or change the value to deter-
mine the position of the node.

5. Access Permissions is autopopulated only when a menu is created through the Business Foun-
dation. When creating a new left menu from scratch, you may leave this field blank or otherwise
copy in permissions from other existing menus. If you want to change Access Permissions, refer to
the Permissions section.

6. An Item Icon can be uploaded to represent the node. Click Browse to upload an icon.

7. Once all relevantinformation is entered, click on Publish.

Adding %

@72} Dashboard 0 Display Region: Customer Management
=@ Customer Management 40 Display Text: Contracts
= “" Catalog Management 60
1!1'!', Order Management 80 RteminES

= }
@33 Marketing 100 Display Order: 10000

4] Asset Management 120

2l Reportin 3 LRe=s
1‘9 P g 1320 Permissions:
@[ Administration 200

Item Icon: [ Browse... |
+" Add

To verify if the object was published, go to the Display Region where you specified the object to be pub-
lished to. Click on the Refresh icon on the left navigation frame if at first you do not see the new node.

Customer Management s

:ﬂ Organizations
l_‘a Contacts

& Roles

= Contracts

Editing, Ordering, or Deleting a Left Menu Item

To Edit a user-generated node in the left menu, click on the Notepad icon.
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[Jadd
Title Order
=) Dashboard u] i
= Home i0
Customer Management 40
= Organizations 30
= Contacts 40
Raoles 50
Contracts 10000
Catalog Manzgement &0
i Catalog Entry Search 10
p

If the left menu item was created via the Left Menu page, this popup window will appear.

Editing 4
Display Text: Contracts

Item Link: http:/ /world.episerver.com,/ contracts

Display Order: 100

Access Permissions:

Item Icon:

OK | | Cancel |

If the left menu item node was created using Business Foundation, this popup appears.

To change the sort order of the left menu item, adjust the numerical value in Display Order. The lower the
value, the higher the position of the item within the navigation tree relative to items with a higher Display

Order value.
Editing b
Display Text: Contract
Client Script: CSManagementClient.ChangeBafView('Contract', 'Lis|
Display Order: 10000
Access Permissions: businessfoundation contract:list:permission
Item Icon:

OK | | Cancel |

To save changes, click OK.

To delete a left menu item, click on X icon.
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Start CMs Commerce EPISERVER < 7?7 -~ L admin~ Q
Commerce Manager Settings
Welcome ™ Change Language About ™ @ Cet Help For This Page Ai
Administration & || [Jadd
=+ System Settings Title Crder
g3 Sites B Dashbosrd 0
# [ Dictionaries
Home 10
] Logs
0 EETE TS Customer Management 40
@ Business Foundation = Organizations 30
@ Search Index Contacts 40
& Left Menu

Roles 50

Q

¢ [_] Catalog System

&[] Order System E Contracts 100

5

og Management 60
Catzlog Entry Search 10
Catzlog Batch Update 20
| = Catalogs 20
Order Management 20
= Order Search 10
@ Dashboard Purchase Orders 20
m Customer Management Today 10
= = This Week 20
Catalog Management
This Month 20
-ﬁ Order Management
= Al 40
Magketing = Purchase Orders By Status 30
E; ¥
/ﬂ Asset Management = Carts 40
Reporting
m Administration Page Size: |20 [+] (78 items) | Page 41234y

Indexing Your New or Edited Catalog

In order to see products in a new Catalog or changes to an existing catalog, you will need to index your
catalog to reflect those changes in your search results.

There are two types of indexing: Build and Rebuild. Use Build to make a quick re-indexing of an existing
catalog where you made changes to existing products. Build is shorter than a Rebuild because it per-
forms a reindexing of only the items that were changed since the last Build.

If you are using a brand new catalog or you made structural changes to your existing catalog (i.e. moving
categories around, changing a product name, etc.), then you will need to perform a Rebuild. Rebuild
takes longer because it does a complete indexing.

To Build or Rebuild your catalog, go to Administration > System Settings > Search Index.

Once you perform either of these two operations, you will see the changes or additions reflected in your
search results.

If you have the Quartz service installed (this can be installed automatically during the SDK install), then
your catalog is reindexed every five minutes or whatever time interval you decide upon.

Catalog System
This section describes the system administration for the catalog system.
Setting up Meta Fields and Meta Classes

Using meta classes and meta classes, itis possible for end-users to extend the meta data of catalog items
and order forms.

Meta fields are for adding specific data about an item. For instance, if you create a meta class called "Dig-
ital Cameras," you will want to add meta fields that are specific details related to digital cameras (such as
number of megapixels, focal length, red-eye reduction support, etc.).

Adding Meta Fields to a Meta Class

1. Go to Administration > Catalog System > Meta Fields.

2. Click on New Meta Field to create a new meta field.
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Start cMS Commerce EPISERVER @ ? ~ X admin- Q

Commerce Manager Settings

EPISERVER COMMERCE Meta Fields et Version. 52 (cuid: 208)

ECF C5 Deployment (EpiServer)

Welcome ™ Change Language About ™ @ Get Help For This Page %+
Administration = | W New Mera Fiw
o Tf Administration D Natne Type Multi-Language ~ Compare Search  History  Friendly Name
(] System Settings 25 DisplayName ShartString True True True False Display Name
B3 Catalog System 26 Primarylmage ImageFile False False  False  False  Primary Image
B Warehouses
27 Description LongHtmIString  Trus Falza Trus Falzs Dascription
® Tax Categories
28 Catalogimage ImageFile False False  False  False  Catslog Imags
B Meta Classes
29 Erand ShortString True True True False Brand
B Meta Fields
B0 Order System 20 RedEyeReduction goolean True True False  False  Red Eye Reduction
31 MemoryFormFactor ShortString True True True False Memory Form Factor
=z LensType ShertString True True True False Lens Type
33 MinFocalLength ShortString True True True False Min. Focal Length
34 MaxFocallength ShortString True True True False Max. Focal Length
| 35 OpticalSensorResolution ShortString True True True False Optical Sensor Resolution
g
36 OpticalZoom Float True True True False Optical Zoom
27 DisplaySize ShortString True True True False Display Size
@ Dashboard 38 DigitalZoom Float True True True False Digital Zoom
33 ModelNo ShortString True False False False Model No.
m Customer Management
40 Features LongHtmlString True False True False Features
=
Catalog Management 41 Specifications LongHtmIString  True False True False Specifications
E Marketing
‘ﬂ Asset Management

£l Reporting o I D

m Administration Page Size: [20 [+] (17 items) | Page 41

3. The Meta Field Edit page appears. There is a wide variety of parameters you can set for the meta field
depending on the type you select.

Field Description

Enter in a system name without spaces or special characters (e.g. "NumberMegapixels,"

Name
without the quotes).

Friendly Enter in a user-friendly name seen by end-users on the back and front-end (e.g. "Number
Name of Megapixels," without the quotes).

Description Enter in any additional information about the meta field.
Type The drop-down menu shows the field types you can use for the meta field.

Warehouses

Commerce Manager users can add and track a list of Warehouses within EPiServer Commerce. A Ware-
house is a physical place with an address from which items are shipped.

To access Warehouses, navigate to Administration > Expand Catalog System > Warehouses.

Administration EE‘

@[] System Settings
=15 Catalog System
Warehouses .ﬂ'm
o

= Tax Categories

= Meta Classes
Meta Fields

O The important thing to keep in mind is that you can only associate a single warehouse for
every SKU. So when you are creating a new SKU, you will have to specify the Warehouse
where the item is being stored within the Pricing/Inventory tab.

The Warehouse List page appears. An example warehouse called "Default Warehouse" is on the list. To
create a new Warehouse, click on New Warehouse on the menu bar.
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ERCE Warehouse List

DNewWarehnur?'s & More Actions v

|:| Marne \J Istctive  Created Modified Sort Order

D Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:21 PM 0

The Warehouse Edit page has two tabs: Overview and Address.

1. Under the Overview tab enter in a Name and Code. The Name and Code name can have spaces
in between characters.

2. Enterin a value for the Sort Order to determine the Warehouse's position on the Warehouse List.

3. Under Available select "Yes" or "No."

4. Under Is Primary select whether or not this Warehouse is the primary one. You can only have
one primary Warehouse.

ERCE Warehouse Edit

Overview Address

Mame: Mew Warehouse

Code: new warshouse

Sort Order: |1

The sort order for the category entry.

Available: @ Yes ™1 No
Is Primary. 7 Yes @ Mo
OK H Cancel
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5. Under the Address tab, enter all relevant information regarding this Warehouse.
Owverview Address
First Name:

Last Name:
Organization:
Line 1:

Line 2:

City:

State:

Country Code:
Country Name:
Pastal Code:
Region Code:
Region Name:
Day Phone:
Evening Phone:
Fax Number:

Email:

| QK || Cancel |

6. Once you are satisfied with your entries, click on OK to save the Warehouse. Otherwise, click Can-

cel to go back to the Warehouse List page. The new Warehouse will appear on the list.

DNEwWarehnusE z]Mnre Actions ¥

D Marme Ishctive  Created Modified Sort Order
|:| Default Warehouse True 5/11/2010 1:25:45 PM 5/11/2010 1:26:31 PM o
] Mew WEI’!hDI@ True Today, 1:17 PM Today, 1:17 PM 10

To delete a Warehouse, place a check mark on the box next to the name of the Warehouse and the click

on More Actions on the menu bar.

D Mew Warehouse ﬁ Mare Actions ¥

[C] mMame e DeleteSelectM
D Default Warehouse

Mew Warehouse

Confirm deletion by clicking OK on the pop-up window. Otherwise, click Cancel to go back.

Order System

This section describes the system administration for the order system.

Payment Gateways

When creating and configuring payment methods in EPiServer Commerce, there are three components
that need to be created or re-used as well as configured: Payment Types, Payment Gateways and Pay-

ment Methods.
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Payment Types — Payment types are classes which contain the properties of a particular payment type.
For example, a credit card payment type contains credit card number, card expiration date, card type, etc.
All payment types inherit from the abstract class Payment. The most common payment types are already
built-in to EPiServer Commerce:

Credit card
Cash Card
Gift Card
Invoice

In addition, a generic OtherPayment type is included in EPiServer Commerce. Payment types are meta
classes.

Payment Gateways — Payment gateways provide an interface to the system which provides payment
processing. A payment type is passed to the payment gateway and the gateway executes the payment
transaction with the payment system (e.g. PayPal). One payment type is associated with each payment
gateway.

Payment Methods — Payment methods contain information about the way the customer views a payment
option and has a payment gateway associated with it.

Using a Built-In Payment Gateway

To setup payments using a built-in Payment Gateway, go to Administration -> Language (English, Ger-
man, Spanish, etc.)

Administration o]

=i System Settings
=[] Sites
@ ] Dictionaries
] Logs
B Common Settings
B Business Foundation
= 5earch Index
= Left Menu
& ] Catalog System
=5 Order System
B Meta Classes

= Meta Fields

=115 Payments

[~ English (United States)
[ German (Germany)

"1 5panish (Spain)

] French {France)

The Payment Methods window appears. By default, "Payment by Card (DIBS)", "Pay by PayPal Express",
"Pay by Credit Card" and "Pay by Phone" are already setup.
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cMS Commerce EPISERVER & ? -

Start

Commerce Manager

EPISERVER COMMERCE

Welcome T Change Language About ™

Settings

5.2 (build: 243)

Payment Methods on
ce F G5 Deployment (EpiServer)

i@ Get Help For This Page %

Administration el

2 Administration -
4[] System Settings
# (] Catalog System

&5 Order System

m

= Meta Classes
= Meta Fields

=) Payments
£ Emalich fllnitar S5 T
[ 3

o | |
ﬁ' Dashboard

D New ;f] More Actions ¥

Customer Management
=
Catalog Management
.ﬁ Order Management
IE Marketing
«ﬂ Asset Management
Reporting

m Administration

|:| Name IsActive  IsDefault Ordering Created Last Maodified
D = X Pay by credit card (DIES) True False o S5/12/2011 3:57:49 PM 5/13/2011 3:57:49 P
[E] & X Payby PayPal Express True False ] 5/13/2011 3:57:49 PM 5/13/2011 3:57:43 P
[£ ' X PayByPhone True True 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 A
I:l = >( ExchangePayment False False 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 Al
D = >( Pay By Credit Card True False 2 4/20/2010 2:00:00 AM 4/20/2010 2:00:00 Al

<

[

| 3

Page Size: |20 lz‘

(5 items) | Page 41 »

To create a new Payment Method, click on New to open the Payment Method Edit screen.

Payment Method Edit

L
Overview Parameters
o
Name:
Description: -
it

System Keyword:

Language: select language E‘
Class Name: (nane) IZ|
Sart Order: 0
IsActive: ™ Yes @ No
IsDefault: ™ Yes @ MNo
Supports Recurring: 1 Yes @ MNo
Restricted Shipping Methods

Available Shipping Methods Chosen Shipping Methods
Drefault Shipping

Online Download

Add -=
Add All -

QK

|| Cancel
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Here is an explanation of some of the gateway properties:

ID — the system-assigned unique identifier for the payment gateway

Name — the name to be displayed to the user

Description — a description that can be displayed to the user

System Keyword — the unique name for each instance of the gateway; new non-unique key-
words will not save to the database. This is not be editable after a gateway is initially created
Language — allows a specific language to be specified for the payment gateway

Class Name — name of the gateway class to be associated with the payment

Sort Order — specifies the order of the payment method on the list of payment methods page
IsActive — specify whether or not the payment method is active\

IsDefault — specific whether or not the payment method is the default one

Supports Recurring — specify whether this payment methods supports recurring payments, such
as for subscriptions

¢ Restricted Shipping Methods — Restricted shipping methods is not fully imple-
mented out of the box and requires a developer to complete the functionality.

Restricted Shipping Methods

Awvailable Shipping Methods Chosen Shipping Methods

Default Shipping

Online Download

Add -
Add All -=>
Restricted Shipping Methods
Awvailable Shipping Methods Chosen Shipping Methods
Online Download Default Shipping
Add -
Add All -=>

< - Remove
< - Remmreﬁ.| E

Click OK to save the Payment Method. The payment method will appear in the list of Payment Methods.

Payment Methods

@ Get Help For This Page %

[ new | [Z More Actions ™

|:| Marne Ishictive  IsDefault Crdering  Created Last Modified

[ &= % Money Orfler False False 0 Today, 10:45 AM Today, 10:45 AM

B % Payment by card (DIES) True True 0 5/12/2010 6:10:05 AM 5/12/2010 6:10:05 AM
[ &= X Pay By Phone Trus Trus 1 1/1/2006 1:00:00 AM 5/12/2010 6:10:34 AM
[ = % Pay By Credit Card True False 2 1/1/2006 1:00:00 AM 1/1/2007 1:00:00 AM

Setting up Payment Methods using nSoftware Provided Payment Gateways

EPiServer Commerce supports multiple payment gateways out of the box using nSoftware that the end
user can easily setup without the need for a developer.
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To enable nSoftware supported gateways, create a new payment method.

Enter in a Name, such as nSoftware or anything else.

Enter in a Description.

Enter in the System Keyword as "ICharge".

Select a Language from the dropdown menu.

Select the Class Name "Mediachase.Commerce.Plugins.Payment.ICharge.IChargeGateway".
Select "Yes" for IsActive.

Change the Sort Order, IsDefault, Supports Recurring as needed.

Click OK to save changes.

MERCE Payment Method Edit

*

COeNOOAEWN =

Overview Parameters

1D

Name: nSoftware

Description: nSoftware r

System Keyword: ICharge

Language: select language IE‘

Class Name: Mediachase.Commerce.Plugins.Payment.ICharge. lChargeGateway E‘
Sort Order: 0

IsActive: 71 Yes @ No

IsDefault: 71 Yes i@ No

Supports Recurring: (71 Yes @ No

Restricted Shipping Methods

Available Shipping Methods Chosen Shipping Methods

Default Shipping
Online Download

Add -

Add All ->>

Ok || Cancel

Once created, click on the payment gateway again to go back to the Payment Method Edit page. Click on
the Parameters tab.

The Configure IBiz E-Payment Integrator Component appears and you can select from the Gateway
dropdown menu several dozen of the most popular payment gateways will appear. Depending on the
gateway you select, such as Authorize.Net, the Configuration Parameters will change. Enter in your cre-
dentials and other relevant information to activate the gateway and click OK.
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Overview Parameters

Configure IBiz E-Payment Integrator Component

Cateway: Authorize.Net IE‘

Cet [Biz E-Payment Integrator from weaw.nsoftware.com. You will find more documentation on how to configure it there also.

Configuration Parameters
Payment Options: Sale IZ|

“Merchant Login:
Merchant Password:
Transaction Key:
5ecret Hash:

Payment Cateway URL (used for testing):

Ok || Cancel

Editing Payment Methods

To edit an existing payment method, click on the Notepad icon next to the Delete icon.

D MNew il Mare Actions ™

Marme

nSoftware

Money Order

Payment by card (DIBS)

Pay By Phone

Pay By Credit Card

The ID is autogenerated. Every field can be changed except System Keyword. After you are satisfied with
your changes, click on OK.
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MERCE Payment Method Edit

L4

Overview Parameters
In e0fbbeld-053f-4adc-b15c-669374639502
Name: Maoney Order

Description: P

System Keyword: W

Language: English (United States)E

Class Mame: EPiServer Business.Commerce.Payment.DIES.DIESPaymentCateway IE'
sort Order: 0

IsActive: i) Yes i@ Mo

IsDefault: 1 Yes @ Mo

Supports Recurring: () Yes i@ Mo

Restricted Shipping Methods

Available Shipping Methods Chosen Shipping Methods
Online Download Default Shipping
Add -
Add All -=>
<—- Remawve
<< - Remaove All

0K | | Cancel

Deleting Payment Methods

To delete Payment Methods, click on the X icon next to the payment method name and click OK when
the popup appears. To delete multiple payment methods at once, check mark each payment method you
want to delete, then click on More Actions --> Delete on the dropdown menu. Click OK when the popup
appears.

Shipping

This guide will walk you through how to setup Shipping Methods, Shipping Providers and Shipping
Gateways.

Shipping Method - A shipping method manages a set of information and rules that determines the ship-
ping cost and displays it on the front-end site while a customer checks out an item from his/her shopping
basket. The shipping fee is added to the total price of the purchase. A shipping method is mapped to a
shipping provider visible to a back-end administrator in Commerce Manager. This allows the public site
to display friendly names such as "Ground Shipping" to the customer and this is mapped to a provider
such as UPS. Therefore, when a customer picks "Ground Shipping," he/she will be using UPS.

Shipping Providers - A shipping provider is the class(es) that interacts directly with one or more actual
shipping services such as USPS, UPS, or FedEX. It retrieves shipping price information from the shipping
service(s) its associated with. One typical scenario would be to have a provider that represents a par-
ticular service (e.g. USPS). A provider can also represent a particular type of shipping situation. One
example is that you could have a provider for overnight delivery. The provider could retrieve pricing for
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that service to determine the lowest price given the location of the customer. A provider could also rep-
resent other specific scenarios with one or more services such as price by weight or ground shipping.

Shipping Gateways - Under Shipping Providers, a shipping gateway is the specific class that you select
(Generic Gateway or Weight/Jurisdiction Gateway).

There are two options out of the box for shipping gateways: 1) Generic Gateway (flat shipping rate) and 2)
Weight/Jurisdiction Gateway (base price + additional fee depending on weight and shipping location).
You select the shipping gateway in the Shipping Provider screen and then configure the actual values for
that gateway/provider in the Shipping Methods area.

Shipping Jurisdictions - an option which allows you to define values for region-specific shipping rates;
this is only used when you select the Weight/Jurisdiction Gateway (i.e. California)

Shipping Jurisdiction Groups - group of jurisdictions; this is required because this is a required field
when configuring the Shipping Method parameters (i.e. Southwest region)

Shipping Methods

A Shipping Method manages a set of information and rules that determines the shipping cost and dis-
plays it on the front-end site while a customer checks out an item from his/her shopping basket. The ship-
ping fee is added to the total price of the purchase.

A shipping method is mapped to a Shipping Provider visible to a back-end administrator in Commerce
Manager. This allows the public site to display friendly names such as "Ground Shipping" to the customer
and this is mapped to a provider such as UPS. Therefore, when a customer picks "Ground Shipping,"
he/she will be using UPS.

Customizing Shipping Methods
There are two Shipping Methods available out of the box for you to customize: Ground Shipping and
Fixed Shipping.

To customize the Shipping Methods, first go to Administration > Order System > Shipping > Shipping
Methods > English (United States) or any other languages.

o]

i

Administration

= System ettings
M ] Sites
&[] Dictionaries
+ ] Logs
B Commaon Settings
B Business Foundation
B Search Index
® Left Menu
H ] Catalog System
=] Order System
B Meta Classes
m Meta Fields
&[] Payments
="=J Shipping
= Shipping Jurisdiction Groups
= Shipping Jurisdictions
@ Shipping Providers
= Shipping Packages
== Shipping Methods

[_JEnglish {United States)
[ German (Germany) \
[~ 5panish (Spain)

[ French (France)
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At the Shipping Methods List screen, select the editicon for either of the available methods. The Over-
view tab screen for Shipping Method Edit will load with the below fields:

Overview Settings Parameters

10: alcal bca-6fbf-4bef-b01f-bbf3df23a02a
Name:
Friendly Name: Cround Shipping
Description: Calculates shipping based on weight and zone, P
Provider: Weight/Jurisdiction Catewa‘,rE
Language: English (United States)E
Base Price: 2.00
Currency: US dollar E
IsActive: @ Yes Na
IsDefault: @ Yes Mo
Sart Order: )
Ok || Cancel

ID - this is auto-generated after saving the new shipping method

Name - enter in a name without spaces or special character; this name will not be displayed in the
public site, but is only for end users to manage and organize the shipping methods

Friendly Name - enter a friendly name which can have spaces and special character; the friendly
name is the name seen by customers who are purchasing items

Description - enter a description (optional)

Provider - select an available provider from the dropdown menu; the options displayed here are
created in the Shipping Providers screen (Generic Gateway is for a fixed shipping fee specified
below under base price, while Weight/Jurisdiction Gateway is used for a shipping fee depended
on the weight and shipping location)

Language - select a language of your choice from the dropdown menu

Base Price - the base price you specify here will become the fixed shipping fee for the Generic
Gateway option, and part of the Weight/Jurisdiction Gateway option.

IsActive - select Yes or No under IsActive to enable is disable it, respectively

IsDefault - select Yes or No if this shipping method is the default one

Sort Order - enter a number for the sort order to determine its position on the list of shipping meth-
ods

The Settings tab is used to exclude any Countries, Regions, and Payments from a particular shipping
method.

To exclude a selection, highlight the items on the Available boxes on the left and move them to the
Chosen Countries boxes by clicking Add.
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Available Countries Chosen Countries

Afghanistan
Albania

Algeria

American S5amoa
Andorra

Angola

Anguilla

Antarctica

Antigua and Barbuda
Argentina -

m »

Add ->
Add All ->>

Restricted Regions

Available Regions Chosen Regions

Alabama

Alaska

American Samoa

Arizona

Arkansas

Armed Forces Africa

Armed Forces Americas (except (
Armed Forces Canada

Armed Forces Europe

Armed Forces Middle East -

Restricted Payments

Add -
Add All ->>

Available Payments Chosen Payments

Payment by card (DIES)
nSoftware

Pay By Phone
Pay By Credit Card

Add -
Add All ->>

| Ok || Cancel

The Parameters tab is use to set conditions to determine the shipping fee. This screen become available
only when the Weight/Jurisdiction Gateway is selectin the Provider field in the Overview tab (it will be

empty with the Generic Gateway option).

Overview Settings Parameters

Configure Price Per Weight for Jurisdiction Croup

Jé‘:éidp‘_“m” United States [

Weight: or more

Price:

Start Date: 5/25/2010 [ [12:00 AM

End Date: EH 10055 Am

Croup Name

5/25/2011

Weight Price
0 or more 10

Start Date
10/8/2008 12:00:00 AM

End Date Edit
10/8/202012:00:00 AM

United 5tates Modify
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e Jurisdiction Group - select a jurisdiction group to apply the current Shipping Method using the
dropdown menu; the options listed here are set up in the Shipping Jurisdictions and Shipping
Jurisdiction Groups screen.

e Weight - enter a numerical value for the weight; units for the weightis setin the Common Settings
screen

e Price - enter a price to be added to the base price (Overview tab) when the weight and juris-
diction group conditions are met.

Start Date - enter a start date and time for the shipping method to take effect
End Date - enter a end date and time for the shipping method to expire

When finish entering the values above, select Add to save the condition. The condition will appear on
table below. In the above example, if the customer checks out an item that weights anywhere between 0
to 10 weight units (Ibs for example), and the customer's shipping address is in the United States, then the
total shipping fee will equal $10 + the base price you enter in the overview screen.

Click OK to save changes.
Deleting Shipping Methods

1. Check off the box that corresponds to the shipping methods you want to delete.
Click on the More Actions button on the upper left corner of the main window menu bar, and
choose Delete from the pull down menu.

3. Click OK when prompted. The selected methods will be deleted from the list.

ERCE Shipping Methods

D New | | More Actions =

|:| Marme Display Marne
[ ¥ Default Shipping Ground Shipping
I:‘ -b Online Download Fiwed Shipping Rate

Shipping Providers

A Shipping Provider is an actual service such as USPS, UPS, or FedEX. However, a provider can also
be a type of shipping in order to determine shipping price. For example, one can have a "Percentage of
Total Cost" provider or "Fixed Price" provider. In this case, the shipment "types" can be associated to one
of the existing providers (i.e. USPS, UPS, FEDEX).

The Shipping Providers page manages the list of these providers/types. There are two shipping methods
available out of the box for you to customize: 1) Generic Gateway and 2) Weight/Jurisdiction Gateway.

A Generic Gateway is is used for a fixed shipping fee while Weight/Jurisdiction Gateway is used for a ship-
ping fee thatis calculated based on the weight and shipping location.

Customizing Shipping Providers

Go to Administration > Order System > Shipping > Shipping Providers. Edit one of the two providers
listed.
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Administration P

=] System Settings
H ] Sites
&[] Dictionaries
| ] Logs
= Common Settings
@ Business Foundation
B Search Index
B Left Menu
] Catalog System
=] Order System
B Meta Classes
B Meta Fields
] Payments
=li=3 Shipping
B Shipping Jurisdiction Croups

B Shipping Jurisdictions

= Shipping Providers

= Shipping Packages {b_

+ (] Shipping Methods

# [ Tax Configuration

1. EditName, and Description.
System Keyword (no spaces) and Classes are something that your developers need to code
and provide.

3. Click OK to save changes.

The revised shipping provider will appear in the Shipping Providers page.

O The Parameters and Packages tabs are not fully implemented; they serve as a starting point
for developers for full implementation of those features.

Deleting Shipping Providers

1. Go to the Shipping Providers page.

2. Check off the box that corresponds to the shipping providers you want to delete.

3. Click on the More Actions button on the upper left corner of the main window menu bar, and choose
Delete from the pull down menu.

4. Click OK when prompted. The selected providers will be deleted from the list.

ERCE Shipping Providers

D Mew ;ﬁl Mare Actions~

|:| Mame
I:‘ X Ceneric Gateway
D Weight/Jurisdiction Gateway
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Tax Configuration

Introduction

Taxes can be configured in the Administration subsystem so that specified rates are calculated and
added to the total price during the checkout process. Depending on your configuration, itis also possible
to combine and apply multiple taxes (such as federal, state and local tax) to a purchase.

Taxes can be set up and maintained using two methods: 1) creating/editing each tax control manually or
2) importing all data using a CSV file. Here we will discuss both methods and also provide you with a few
examples to demonstrate how this works.

Method 1: Configuring Taxes Manually

To set up your taxes manually, you will need to work with the following areas in the Administration tab of
the Admin Site — Tax Categories, Tax Jurisdiction Groups, Tax Jurisdictions, and Taxes — as well as
the configuration pages for each of the catalog items.

The steps below summarize the process you need to follow to configure taxes.

1. Create and configure Countries and Regions (Go to Administration > System Settings > Dic-
tionaries > Countries): In Countries section create the countries you plan to sell your products in
and set the appropriate country codes. For the country codes, itis important that you use the
ISO Short code provided in the following link (http/msdn.microsoft.com/en-us/li-
brary/ms866171.aspx). Using the ISO Long code or anything else will not correctly calculate taxes
during checkout.

2. Create new Tax Categories (Go to Administration > Catalog System): In this step you will
create tax categories that will be used later to associate your catalog items with the tax rates you
define. For example you may create categories such as "General Sales," "Food," and "Luxury
ltems" depending on the tax regulations for your item types. The categories you create here will
become selectable on the Page Details of your items (i.e., Variations/SKU Edit page) and on the
Tax Edit page.

3. Create and configure Tax Jurisdictions (Go to Administration > Order system > Tax Con-
figuration): In this step you will specify particular Tax Jurisdictions. You can create different Tax
Jurisdictions for a particular region by specifying zip codes, country codes, etc. Tax rates will be
applied to whatever level of information you specify for each Jurisdiction. For example, if you spec-
ify only the country code as US, all shoppers with a US address (regardless of state, county etc.)
will be included in this jurisdiction. Note: Country Code and Region Code you enter in the Juris-
dictions Edit page must match the codes you used in step 1.

4. Create and configure new Tax Jurisdiction Groups (Go to Administration > Order system >
Tax Configuration): New Tax Jurisdiction Groups created here can include multiple Tax Juris-
dictions.

5. Create and configure Taxes (Go to Administration > Order System > Tax Configuration): Here
you will specify tax rates and also associate the Tax Categories and Jurisdiction groups created in
Steps 2 and 4.

6. Associate Catalogs to the Tax Categories created in Step 2 (Go to Order Management > Cat-
alogs): Now you will switch over to the Catalog Management subsystem and link specific catalog
items to the appropriate Tax Categories. This can be done on the Pricing/Inventory page within
each Variation/SKU Edit page.

Method 2: Configuring Taxes Using CSV Import

Using the CSV Tax Import functionality is a convenient way to quickly setup and update tax data in bulk.
Creating a CSV tax file with a specified format (see "Example Scenarios" below) will allow you to com-
plete steps 2 through 5 in one shot (above in Method 1). Step 6 of Method 1 can be done manually, but
you can also use the CSV import functionality in the Catalog Management subsystem to associate cat-
alogs to tax categories. Click here to see how CSV Catalog Import works.

Import your CSV tax file into your Commerce Manager by following the steps:

1. Selectthe Administration tab in the Commerce Manager.
2. Inthe navigation tree drill down to Taxes: Order System > Taxes Configuration > Taxes.
3. Click Import Taxes on the menu bar.
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4. Choose Add New File and then Browse to select and upload your CSV tax file. The path of your
chosen file will appear in the field.

5. Click Upload File and then Save The File icon. The CSV tax file will appear under the Files Avail-
able for Import section.

6. Selectand highlightthe CSV file and click the "Start Import" button.

7. Yourimport should begin and complete successfully in a pop-up dialog box.

8. You will now be able to view your tax setup in the Commerce Manager.

If you want to edit the existing setup, simply repeat steps 1 through 8 with your modified file.
Caution: Re-importing CSV files only edits existing information or adds new data, but nothing gets
deleted. If you delete an entire row of data in the CSV file, you must manually delete those entries in the

Commerce Manager. If in doubt, you can always delete all the tax data and perform the CSV tax import
from scratch.

Sample CSV Files and Example Scenarios

Example 1: Single Tax Per Catalog Item Based on a Single Jurisdiction

For example, if your variable is State, then you can specify the tax rate on a state-level. So let's say CA is
9% and MA is 6%. If you placed an order from California, then 9% sales tax would be applied during
checkout.

Jurisdiction  Jurisdiction Group Tax Rate Tax Category
California CA Tax Group 9% General Sales
Massachusetts MA Tax Group 6% General Sales

A sample tax CSV file called test.csv is available in this directory — [taxcsvsample1.zip ].

Example 2: Two or More Taxes Per Catalog Item Based on More Than One Juridiction

For example, if you have a luxury item that requires State and Federal tax to be applied, then you can
specify tax rates on a state and federal level. So let's say a luxury item purchased in CA has a 9% state
tax rate and a federal tax rate of 3%. Both taxes would be applied during checkout.

Jurisdiction Jurisdiction Group Tax Rate Tax Category
California General CAGS TaxGroup 9% General Sales
Massachusetts General MA GS Tax Group 6% General Sales
California Luxury CALX Tax Group 9% Luxury Sales
Massachusetts Luxury MA LX Tax Group 6% Luxury Sales
US Federal Luxury USLX Tax Group 3% Luxury Sales
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EPiServer Commerce Sample Site

The EPiServer Commerce sample site provides a set of demo templates to illustrate the functionality of
EPiServer Commerce. The sample template package is intended as inspiration when you build your own
e-commerce site based on EPiServer Commerce. In the following the templates included in the package
are described in more detail, explaining the possibilities with EPiServer Commerce to both developers
and end-users.

Login My Account My Cart Wish List English (United States) ¥ US dollar ¥

o CLICK+TALK Your Shopping Basket

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Capture it + Make it Last

The best digital cameras and accessories... just a click away

n

Browse o
Canon PowerShot Pro Series 55 IS

8 0MP Digital Camera with 12x Optical Canon iPhone orPhone
Image Stabilized Zoom
powershot «..a60 Nikon

pentax 70 * track trac rac camera eos 450d och

Commerce Event

Welcome to our semniarl
Posted: 16/06/10

Canon LAH-DC20 Conversion Lens

éﬂcafu‘ers,[:‘;;[rﬁsesgs ?gdsgﬁgl‘[éz]s plantronics veyager disk charger nkon Hardskin for

Hieuw nieuws
Nieuw nieuws

Posted: 14/06/10 Digital Camera 3G Black phonekleen adobe wide adapter page
sony power
Canon PowerShot Pro Series 53 IS 6MP ?
Hews 1 with 12x Image Stabilized Zoom
Donec malesuada ante sed ipsum hendrerit
honcus...
Posted: 27/05/10
mare news
Buyers guide About us Our Services Customer Service Support
Didigtal cameras History How to place an order? New Customer? Download
Mobile Phones Our success ‘Your payment methods Register Help
Site Map Contact Terms and Condttions Forgotten your password
Press Order tracking
Affiliate Program Guaraniee

Display Templates

To be able to display different products on the e-commerce site you need to define the display templates
to be used. These can be different for different language groups on the site. On the EPiServer Commerce
sample site, the display templates will automatically be imported and configured during the installation
procedure. However, when new templates have been created you may want to define their use in the sys-
tem, or modify the use of existing ones. This is done in Commerce Manager in the Catalog Management
sub-system under Templates.
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Commerce EPISERVER ©@ 7?7 ~ Ladmin~ Q

elcome, Store Manager

EPISERVER COMMERCE

Welcome * Change Language About ~

Templates List

rsion: 5.1 (build: 24)
°F G5 Deployment (EpiServer)

@ Cet Help For This Page %

() German (Germany)
|_)Spanish (Spain) E
[ JFrench (France)

@ Workflow

@ ] Dictionaries

Administration @ || [dnew | [ More Actions~
=) System Settings ~({F Name Type Path
9e3 Sites [ Digital Camera antry ~/Commerce Display Templates/DigitalCameraTemplate.ascc
SIS ST TS ] Node Info Template node ~/Templates/Everything/BusinessControls/CatalogBrowseControls/Node1
[ Englsh (United States [ entries Template nods ~/Tamplates/Evarything/BusinessControls/CatalogBrovssControls/Hode1

W] Logs
@ Common Settings
@ Business Foundation

@ Search Index - [«

«
.ﬁ Dashboard

m Customer Management
- = 0o @

=
Caralog Management

Marketing

‘ﬁ Order Management

‘ﬂ Asset Management
{ﬁ Administration

Page Size: |20 [+] (3items) | Page 415

Adding a display template

agrwd-=

6.

Under Catalog Management, select Templates and click New.

In the Name field, enter the name of the display template, for instance "DigitalCameraTemplate".
In the Friendly Name field, enter the display name for the template, for instance "Digital Camera".
In the Type field, enter the type of display template, for instance "entry".

In the Path field, add the path to the display template, for instance:

~/[T-

emplates/Ev-
erything/BusinessControls/CatalogBrowseControls/EntryTemplates/DigitalCameraTemplate.ascx.
Click OK to save your changes.

Updating an existing display template

1.

cokwd

Under Catalog Management, select Templates and the language version and template that you
want to update.

In the Name field, enter the name of the display template.

In the Friendly Name field, enter the display name of the display template.

In the Type field, enter the type of display template.

In the Path field, add the path to the display template.

Click OK to save your changes.

Importing the Sample Catalog

The product catalog contains information regarding brands and sales items. This information will either
be displayed in the public site, or used for pricing and promotions. Product catalogs needs to be imported
into EPiServer Commerce. This will normally be done automatically during the installation procedure for
the EPiServer Commerce sample site.

However, there may be occasions where you need to import a product catalog, and the procedure is
therefore described in the following. There are different ways of doing this, and in this example we
describe how you manually import the sample catalogs (2) of the sample site, using the import/export func-
tion in Commerce Manager. When product catalogs have been imported, they also need to be indexed,

in order for the product search function to incorporate any changes.
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Additional information on how to import product catalogs can be found in the Catalog Management sec-
tion.

Start CMS Commerce EPISERVER & ? -~ XL admin~ Q

Commerce Manager Settings

EPISERVER COMMERCE Catalog List P =

License: ECF G5 Deployment (EpiServer)

Welcome T Change Language About ™ @ Get Help For This Page ‘7
Catalog Management & | |2 New Catalog ;] Import/Export ™ ] More Actions ~
4 Catalog Entry Search D Mame Aovailable from Expires Status
=}
EEEl Ty T Ly | B S Everything 12/18/2007 9:00:00 AM  12/18/2020 9:00:00 AM  True
=13 Catalogs
= 4B Brands 6/24/2008 7:00:00 PM 6/24/2020 7:00:00 PM True
+ [ Everything
& 7] Brands

ﬁ Dashboard

m Customer Management 4]

Catalog Management
-ﬁ Order Management
E Marketing

tﬂ Asset Management

ﬁi Reporting

. 41
m Administration Page Size: 20 T (z items) | Page 41

Import the Sample Catalogs

The sample site includes two product catalogs providing the "everything" and the "brand" view.

1. In Commerce Manager, select Catalog Management and then Catalogs.

2. Click on Import/Export and then Import Catalog, this takes you to the Import Catalog screen.

3. Select the catalog zip file, in this case "CatalogExport-BG2C-Everything.zip" and click Start
Import.

4. When the import has completed, click Close Window.

5. Select "CatalogExport-B2C-Brands.zip" and click Start Import.

6. When the import has completed, click Close Window.

Import
It is strongly recommended that you back up your ECF database before performing import.
To impaort catalog, please pick up an existing file from the grid below or upload a new one. Then click the button "5tart Import' to start impaorting.

_a Add MNew File

Files Awvailable For Import:

File Name Size Created Last Updated
CatalogExport-B2C-Evaerything.zip 9.52 MB 2/10/2010 4:00:45 PM Today. 11:44 AM
CatalogExport-B2C-Brands.zip 185.66 KB 2/10/2010 4:00:45 PM Today, 1i:44 AM
1 Fage 1 of 1 (2 items)

Start Import I

Indexing the Sample Catalog

After importing a product catalog, at also needs to be indexed.

1. In Commerce Manager, select Administration, System Settings and then Search Index.
2. Click Rebuild Index to index the catalog for the first time. The Build Index option is used for future
updates when you import the same catalog again and only want to index the changes.
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Start CMS Commerce EPISERVER & 7 ~ Ladminv Q

Commerce Manager Settings

EPISERVER COMMERCE Search Manager

ment (EpiServer)

Welcome ™ Change Language About ™ @ cet Help For This Page %
Administration e fipd v
=23 System Settings Rebuild the Search Index. This operation will cause complete index rebuild.
# ] Sites
@[] Dictionaries Build the Search Index. This operation will build index for items updated since last build
®(] Logs

B Commaon Settings

Business Foundation

o]
B Search Index
B Left Menu
# ] Catalog System
] Order System

ﬁ Dashboard X
Iiﬂ Customer Management
Catalog Management
.ﬁ Order Management
E Marketing

tﬂ Asset Management
Reporting

m Administration

Page Templates

The EPiServer Commerce product package is based on EPiServer CMS for managing content, and the e-
commerce module Commerce Manager. The EPiServer Commerce package includes a sample website
with a set of display templates. The page templates provide an example of how you can work with EPiS-
erver Commerce to create your own web publishing and online store platform. Use the page templates as
inspiration and adapt them to your own online store environment.
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Logih  MyAccount  MyCat  WishList  English (United States) ¥ US dollar ¥ fl

o CLICK+TALK Your Shopping Basket E

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Capture it + Make it Last

The best digital cameras and accessories... just a click away

n

Browse °
Canon PowerShot Pro Series §5 IS

8.0MP Digital Camera with 12x Optical Canon iPhone orhone
Image Stabilized Zoom

Commerce Event

Welcome to our semniar!
Posted: 16/06/10

powershot s.a60 Nikon
HNieuw nieuws Canon LAH-DC20 Conversion Lens pentax a70 * track frac rac camera eos 450d och
Adapter (LA-DCS8E) and Hood (LH- A . Y "
Nieuw nieuws DC40) Setforthe S515, 53 1S & 5218 plantronics voyager disk charger nkon Hardskin for
Posted: 14/06/10 D\gitai Camera 3G Black phonekleen adobe wide adapter page
sony power
Canon PowerShot Pro Series §3 IS BMP ?
Hews 1 with 12 Image Stabilized Zoom
Donec malesuada ante sed ipsum hendrerit
rhancus
Posted: 27/0510
more news
Buyers guide About us Our Services Customer Service Support
Didigtal cameras History How to place an order? New Customer? Download
Wabile Phones Our success “Your payment methods. Register Help
Site Map Contact Terms and Conditions Forgottan your password
Press Order tracking
Affiliate Program Guarantze

The sample site contains sample product data stored in a product database. The template package in

EPiServer CMS contains a set of templates for displaying content and providing other typical e-commerce
functions.

O The templates, fields and functions described in this documentation refers to a "standard instal-
lation" of an EPiServer Commerce sample site. The standard functions and fields of EPiServer
CMS are not described here. Please refer to the EPiServer CMS documentation for editors
and administrators available on world.episerver.com.

The Page Tree Structure

When installing the EPiServer Commerce package with a sample site, a number of pages will be created
and displayed in a specific structure in the page tree. Some of them will show editorial content. Other

pages are used as containers for other pages These will not display any content of their own and will be
hidden in navigation menus.
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The Start page is built using the Home page type. The Start

page contains numerous settings affecting the entire website, CM5
for instance top menus, search and login. This is also where Edit Mode Admin Mode Reports

ou define pages to be used for shopping carts, payments ]
Y Pag PPing pay O 8 4 EB H (% & |§
and checkout.

Editorial content pages are most often based on the page type J Structure || Favorites || My Tasks |

Standard Page. These are the pages where editors can ﬁ,ﬁ Root folder
create and edit content the usual way in EPiServer CMS. , )
Examples of editorial content are the pages under the sec- 2'@1 Recycle Bin
tions News, Get the Product and More Support. @

The pages under the Products section, are based on a page Products|d

type called Product Listing. These pages will provide the top News |

menu of the website, based on what is listed under the Prod- Buyers guide
ucts page. The sort order of the Products page controls the About us

order in which the menu items will be displayed. Our Services
The [Function Pages] section of the tree holds the display Customer Service
template for a number of typical functions such as My Account, Support

My Cart, Wish List, Payment and Checkout. These have their Affiliate Program
own specific page types linking to functions in the Commerce (Function Pages] [
Manager module.

The [Resources] section resides directly under the root page ST

of the site. This part is used for the actual linking to the product
catalog in Commerce Manager. The pages are based on the
Product Listings page type and do not display any content.

Show page tree:
| English (United States) ||

Start Page

The Start page is based on the Home page type and is normally defined when the website is installed.
The page holds a number of settings with references to other pages on the website. The start page will
most likely not be touched very often after the setup, but occasionally references pointing to pages
defined here may need to be changed.

When you open the Start page for editing in Edit mode, you will find that the Start page itself does not
have an editorial area, since the content displayed is made up of different types of listings. In addition to
the standard tabs of EPiServer CMS, the Start page has a tab containing specific site configuration prop-
erty settings.

Content Tab

Below are the properties that can be changed in Edit mode under the Content tab of the Start page.
Name

The name of the page, as displayed in the page tree.

Fetch News list from

Defines the container page for the news item listing to be displayed in the mid-leftinformation area of the
start page.

Images

The start page has a top banner image. The image area has functionality for altering between a set of two
images which can be defined here. Define images in the fields Image 1/lmage 2 to be displayed in the
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top banner area of the start page. Selectimages in the EPiServer CMS file manager.
Links

In the fields Link 1/Link 2 you can define links for each of the altering top banner images on the start page
using the EPiServer CMS link dialog. The link will take the visitor to the specified URL when clicking on
the top image of the start page.

cMms Commerce EPISERVER @ ? - AL admin- Q

Edit Mode Admin Mode Reports  Visite
O &8 4 3 0|5 % | @ & @ | @& g

anunure e Start Page View | = English (United States) |+

Page Type: [Commerce] Home Status: Published Version Compare With

@ Root folder

4 seeyce e I
@ Hsave klSave and View | Save and Publish | [ Cancel &

Products|[7]

News[3 J Content ” Scheduling ” Site Configuration ” Settings ” Shortcut ” Categories ‘

Buyers guide Name Srart

Apoutus Fetch News list from Q

Our Services

I Image 1 /Global/LogoTypes/main-phone.png E]

S Link 1 /Templates/ClickTalk/Pages /Productlistit ...|

Affiliate Program Image 2 /Global/LogoTypes/main-cameras.png E]

[Function Pages] | Link 2 /Templates/ClickTalk/Pages/ProductListir Q

[Resources] |

Show Page Tree:

E= English (United States) -

Site Configuration Tab

The settings that are available under the Site Configuration tab when you edit the Start page, are com-
mon website configuration items that are defined as properties on the start page and will be inherited to
the sub-pages. Most often these settings are defined when the website is installed but it may be nec-
essary to update them at some point. Note that the function pages must be created first before defining
them on the start page.

OO Commerce EPISERVER @ ? - L admin- Q
Edit Mode Admin Mode Reports Visitc
0O 8 4+ B L : 5 @ e @ B & E
| structure |[ Favorites [[ My Tasks Start Page View
@ Root folder Page Type: [Commerce] Home Stats: Published Version CompareWih [ ]
3 e e
@ bk save klSave and View | Save and Publish | £ Cancel &
Products |

News 3 Content || Scheduling || Site Configuration ” Settings H Shortcut ” Categories

8 d
uyers guide Login page

About us
Display top menus from
Our Services

Customer Service Display menus from

Support Display bottom menus from
Affiliate Program Account page

[Function Pages] [ Address book page

[Resources] i Account edit page
Search page
Product page

Wish list page
Shopping cart page
Check out page
DIBS Payment page

Order history page

DN oEoe

Compare products page
Allow empty column B8

Path to template for display entry without SEOQ info )

(]

Show Page Tree: PayPalPaymentPage @

5 English (United States) -
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Open the Start page for editing in Edit mode, to change the settings for the different properties. Save and
publish the page to update the settings.

Login page

Defines the login page to be used when visitors log in to the website. The login page itself has settings to
define the account register and password recovery pages. Select the login page in the page tree structure
to define it for the website.

Display top menus from

In this field you configure the menu at the very top of the website. In this example the menu contains func-
tions My Account, My Cart and Wish, as well as Log in/out and the language and currency selector.

Log out My Account My Cart Wish List English {United States) ¥ US dollar v

Links to the login page and the language selector will be displayed by default, but the other options are
listed from the container page defined here. In this example, the container page is the page [Function
Pages]. Under this page you create the other function pages such as My Account, Wish list etc.

The order in which they are presented in the menu is set by the sort order of the [Function Pages] con-
tainer page. Pages that are set not to be visible in menus, will not appear. Select the page in the page
tree structure to define it.

ﬁ [Function Pages] [

é My Account[]
- My Account &
- Check out[]

~ My Cart

~ Wish List

- Login[d]

~ Register ]

~ Search page|
- Payment|.

~ Forgot Password [
~ Product Page [

- Compare products [

- PayPal ]

Display menus from

Displays the main navigation menu of the website.

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

In this example, this information is collected from a container page named Products, which itself is not dis-
played in menus. The sub-pages consists of a number of selected product pages based on page type
Product Listing. The order in which the pages are displayed in the menu is controlled by the sort order for
the Product parent page, which in this case is set to be sorted according to sortindex. Select the page in
the page tree structure to define it.
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ﬁﬂ Start

[ YProcucis B

~ Digital Cameras

~ Camera Accessories
~ Maobile Phane

~ Phone Accessories

- Special Offers

Display bottom menus from

Buyers guide About us

Didigtal cameras History

Mobile Phones Our success

Site Map Contact
Press

Affiliate Program

Join our program

Our Services Customer Service Support
How to place an order? Mew Customer? Download
Your payment methods Register Help
Terms and Conditions
Order tracking
Guarantee

Forgotten your password

The start page contains a bottom section listing pages in five columns. The Display bottom menus from
field defines from where the page listing will be fetched. In this example the listing will display pages and
their one-level sub-pages under the start page. All pages will be listed except those that are set notto be

displayed in menus.

ST Y start

Products /]
Mews [

Buyers guide
About us

Our Services
Customer Service
Support

Affiliate Program

[Function Pages] [

In this example, the bottom menu listing will start with "Buyers guide", to be followed by "About us", "Our
services" etc. Note that the listing will go from left to right to fill the columns. The order is controlled by the
sort order of the start page, which is set to be sorted according to sortindex in this case. The number of
columns can be changed programatically in the ColumnCount property, default and maximum value is
five. For additional information on this, please refer to the technical documentation for EPiServer Com-

merce available on world.episerver.com.

In the Display bottom menus from field, select the page in the page tree structure to define it.

Account page

This setting defines the Account Dashboard page to be used. This page displays a snapshot of recent
account activities for a customer, and also provides possibility to update accountinformation. Select the

page in the page tree structure.
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Address book page

This setting defines the address book page to be used when displaying a customers address information.
Select the page in the page tree structure.

Account edit page

This setting defines the account edit page to be used when displaying a customers account details.
Select the page in the page tree structure.

Search page
This setting defines the search page to be used on the website. Select the page in the page tree structure.
Product page

This setting defines the product page to be used when displaying details for a particular product. Select
the page in the page tree structure to define it for the website. If you are using the EPiServer Commerce
catalog page provider, the property setting here can be ignored.

Wish list page

This setting defines the wish list page to be used when displaying a customers wish list. Select the page
in the page tree structure.

Shopping cart page
The page to be used when displaying a shopping cart. Select the page in the page tree structure.
Check out page

The page to be used when displaying the check out page for a customer. Select the page in the page tree
structure.

DIBS Payment page

The page to be used when displaying a DIBS payment page. The page will process a DIBS payment
through the DIBS payment gateway. Select the page in the page tree structure to set the payment page to
be used.

Order history page

The page to be used when displaying the order history page for a customer. Select the page in the page
tree structure.

Compare products page

This setting defines the page to be used when comparing products. This page provides functionality for
displaying selected products next to each other for comparison. Select the page in the page tree struc-
ture.

Allow empty column

Check this field to allow empty columns to be displayed in the footer menu, in case a menu item does not
have any sub-pages.

Path to template for display entry without SEO info

Enter a path for a display template to use for an entry that does not have any information for search
engine optimization (SEO).

PayPalPaymentPage

The page to be used when displaying a PayPal payment page. PayPal is the default payment provider on
the EPiServer Commerce sample site. Select the page in the page tree structure to set the payment page
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to be used

The different pages and page types are described in more detail in other sections of this documentation.

Standard Page

The page type Standard Page in EPiServer Commerce is used for creating an ordinary information page.
The Standard Page in the EPiServer Commerce sample site has some additional fields in comparison
with a standard page in an ordinary EPiServer CMS sample site.

e The Fetch left menu listing fromfield, which allows editors to define which pages should be dis-
played in the left menu listing.

Select a page in the page tree from which to display the left side menu listing. If nothing is
selected here, the left column will be empty.

e The Select Product field allows you to select a product from the product catalogue, to display the
product content for that product.

Secondary body
L = i (O ¥ (D 0 B G| &
B I O

— || Styles = Fem & W Q

Nullam venenatis fermentum elit et volutpat. Aliquam erat volutpat. Cras sollicitudin ligula a neque
scelerisque faucibus. Duis accumsan dictum lorem, ut congue eros facilisis vitae. Phasellus eget felis
id lectus mattis lacinia. Nulla adipiscing adipiscing nulla at vulputate. Vivamus nulla tellus, ornare in
mollis vel, pretium at enim. Fusce iaculis, felis vel posuere auctor, massa magna accumsan felis, et
ullamcorper odio diam et nulla. Nunc posuere est vitae libero elementum vel tempor ipsum tincidunt.
Curabitur non ligula mauris. Vivamus placerat feugiat tortor ac molestie.

Path:
Writer

Fetch main listing from

]

Display number of pages in the main list

Fetch left menu listing from

e

Fetch secondary listing from

Display number of pages in the secandary list

Select Product @

@]

Product Listing

The page type Product Listing is used for listing product information from the product catalog in Com-
merce Manager. The listing will be fetched from the selected product category (node) in the product cat-
alog, for instance digital cameras as in this example. The listing will display a short product description

with price as well as an image, for each of the products. There are four products listed side by side in a
row.

The page functionality will also include a product compare option as well as an Add to Cart button for
each productin the list. The product listings will appear when a visitor clicks on a productin the top menu.
The listing will display 20 products at the time as default, and the listing can be sorted according to prod-
uct name and price. The left column will display related product information, depending on the selected
product category.
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. Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Digital Cameras

Shopping Options Sort By: FeaturedF‘mdudsB 1-2007304 | View Al (304) 1] 2 3| 4] 5

BRAND
Canon (25)
Sany (36)
Pentax (37)
Olympus (13)

Transcend (6)

) v B
Targus (8 ¥ ta
Lexar (7) & S, = r
Kingston (4) Clcompare € ) Dcompsre € y Dcompare  § V" [ compare
Viking (7)
swnetl $449.99 $3,999.00 $3,999.00 $149.99
Simpletech (6
Energizer (6) Canon Davis & Sanford Canon Canon
iff": e Canon PowerShot Pro Series G5 Vista Explorr 607 Lightwsight  Canon LAH.DC20 Conversion  Canon TC-DCSEB Tele Converter
ikon (3)
Epson (5] IS 8.0MP Dighal Camera with 12« Tripod with Tripod Bag Lens for S5 15, 53 15 & 52 15
ncsobe (5) Optical Image Stabiized Zoom Digilal Camera
cha}‘,It 15, 5315 & 5215 Digital Camera
Apple (2)

To define a product listing, create a page based on the page type Product Listing and select the desired
product category (node) in the Catalog node name field. The categories (nodes) available here are col-
lected from the [Resources] section in the page tree structure which is set up atinstallation. This in turn
reflects what is defined in the product catalog in Commerce Manager.

(S 3 Commerce EPISERVER ©@ 7 + AL adminr Q
Edit Mode Admin Mode Reports  Visitc
O & + &3 0 % & @ & @ B @ E
J Structure || Favorites || My Tasks Digital Cameras Bansii e
@ sootrowter Page Type: [Commerce] Product Listing Status- Published Version CompareWith [ |v]
ig‘ Recycle Bin [ Preview || dit || versions || worklow |
@ Start EHsave klSave and View |FLSave and Publish | [ Cancel 74
Products [
DANENET J Content H Scheduling ” Settings H Shorteut ” Categories ‘
Camera Accessories r— Digital Cameras
Mabile Phone
Caralog Node  Digital Cameras (&)
Phone Accessories
Special Offers
News |

Buyers guide
About us

Our Services
Customer Service
Support

Affiliate Program

[Function Pages] [

[Resources] |

Show Page Tree:

=S English (United States) -

Function Pages

Function pages is a collection of pages holding typical e-commerce functionality such as account, shop-
ping cart, check out and payment information. Many of these features are personal and connected to a
specific customer account. The function pages also include general features such as login, search and
registration.

My Account Pages

In the sample site, the account information is gathered under the My Account page under the [Function
Pages] branch of the page tree. The My Account page is a container page holding a number of sub-
pages.
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J Structure ” Fawvorites ” My Tasks

Affiliate Program

[Function Pages] [

My Account[J]
Account Dashboard
Account Information
My Orders
Address Book

These sub-pages are based on specific page types with functionality for extracting personal customer
information from the customer management part of Commerce Manager. The page types hold no editorial
information of their own. After they have been created they will be defined in the site configuration setting
ofthe start page.

Account Dashboard

The Account Dashboard page type provides an overview of the personal accountinformation collected
from various parts of the system. Information about recent orders are displayed, together with billing and
shipping address information. Contact and password information can also be reached from here for edit-
ing. The left column displayes the sub-pages under the My Account container page.

. Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Account Dashboard

Account Dashboard

Hello, Carlos!

From your My Account Dashboard you have the ability to view a snapshot of your recent account activity and update your account
information. Select a link below to view or edit information.

Recent Orders | view al

ORDER ID CREATED SHIF TO TOTAL STATUS
PO4563 June 16, 2011 Carlos Nevada 519.99 InProgress View Order | Reorder
PD14184 June 23, 2011 Carlos $418.99 InProgress View Order | Reorder

Account Information
Contact Information | edit

Carlos Nevada
carlos@somemail.com

Change Password

Address Book | manage addresses

Default Biling Address Default Shipping Address

You have not set a primary billing address. You have not set a primary shipping address.

When created, the Account Dashboard page is defined in the site configuration setting of the start page.

Account Information

From the Account Information page type a customer can update the user name, e-mail address and
password for the account.
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Welcome, Store! Log out My Account My Cart Wish List English {United States) ¥ US dollar ¥

o CLICK+TA|_K Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Account Information

Edit Account Information

Account Information

m

* User Name: admin

*First Name: John @
*Last Name: Smith ©
“Email Address: john.smith@yourcompany.com O

Change Password: B

My Account
Account Dashboard
Account Information
My Orders

Address Book

Buyers guide Aboutus Our Services Customer Service Support

Didigtal cameras History How to place an order? New Customer? Download

Mobile Phones Qur success “Your payment methods Register Help

Site Wap Contact Terms and Conditions Forgotten your password i

When created, the Account Information page is defined in the site configuration setting of the start page.

Account My Orders

The purpose of the Account My Orders page type is to display the order history for an account. The infor-
mation is collected from the customer management part of Commerce Manager.

Welcome, Store Log out My Account My Cart Wish List English (United States) ¥ US dollar ¥

o cLIcK+TAI_K *Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - My Orders

Order History

ORDER ID CREATED SHIP TO TOTAL STATUS E
PO2654 June 02, 2010 Kalle Andersson £8,208.44 Shipped View Order | Reorder
PO13145 June 03, 2010 Manager NewOrder View Order | Reorder
June 07, 2010 Manager Submitted View Order | Reorder
June 08, 2010 NewOrder View Order | Reorder
POZ7522 June 11, 2010 NewOrder View Order | Reorder
PO33568 June 15, 2010 §1,434.44 NewQrder View Order | Reorder
POG0B0S June 16, 2010 Manager $324.99 NewOrder View Order | Reorder
My Account
Account Dashboard
Account Information
My Orders
Address Book
Buyers guide Aboutus Our Services Customer Service Support L

When created, the Account My Orders page is defined in the site configuration setting of the start page.
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Account Address Book

The Account Address Book page type holds functionality for displaying and updating address infor-
mation for an account. The information is collected from the customer management part of Commerce

Manager.
Welcome, Store! Log out Wy Account My Cart Wish List English {United States) ¥ US dollar ¥ =
o cLIcK+TA|_K Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Address Book
Address Book

Add New Address

m

Default Addresses Additional Addresses

Edit Address | Delete Address
Default Billing Address
Kalle
Andersson
StreetRoad 4

You have not set a primary billing address

Default Shipping Address Village

12345

+ +46 8 3456781 &

My Account

Account Dashboard
Account Information
My Orders

Address Book

Buyers guide About us Our Services Customer Service Support

Nidintal rAmeras History How tn nlare an arder? New Clistomar? Nowninad =

When created, the Account Address Book page is defined in the site configuration setting of the start
page.

Check Out

The purpose of the Check Outpage type is to display the steps of the check out procedure when a cus-
tomers wants to finalize a purchase.The check out procedure is initiated when the customer selects the
Proceed to checkout option for instance from the Shopping Cart view. The functionality of the page is
linked to the payment and shipping options defined in Commerce Manager.

The checkout procedure may look different depending on payment and shipping options defined in the

system. In this example the checkout procedure has four steps: Shipping Address, Shipping Options, Pay-
ment Options and Order Confirmation.
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Step |: Shipping Address

Log in My Account My Cart Wish List English (United States) ¥ US dollar ¥

o CL|CK+TA|_K 1 item(s) in your cart

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Check out

Shipping Address 1 Shipping Address 2 | Shipping Options 3 PaymentOptions 4 | Order Confirmation
* FIRST NAME Mary @
= LAST NAME Smith @
* STREET ADDRESS: 1 First Street ©
=CITY: santa Monica @
COUNTRY: United States E‘ (=]
* STATE/PROVINCE: California E‘ @
zZIP 81823 ©
* DAY PHONE 8181234567 @

EVEMING PHOME:

FAX:

Proceed To Shipping Options

The customer enters name, address and contact details, if these are not already registered in the system.
If they are, there will be an option to update the existing information. Clicking on Proceed To Shipping
Options will take the customer to step two in the process.

Step 2: Shipping Options

Login  MyAccount  MyCar  Wish List English (United States) ¥ US dollar

© CLICK+TALK

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Check out

Shipping Opiions 1 | Shipping Address = 2  Shipping Options 3 PaymentOptions 4 | Order Confirmation =
Shipping to Shipping Options
WMary Smith a $10.00 - Fixed Shipping Rate

@ $2.00 - Gro

d Shipping
1First Street

Santa Monica, California 81823 Description

United States 44899 1 of Canon PowerShot Pro Series 55 1S 8.0MP Digital Camera with 12x Optical Image
Stabilized Zoom

8181234567

Proceed to Payment

The customer selects the desired shipping options. The contact details from the previous step are dis-
played in the left column, and there is a possibility to back to the previous step to update any information.
Clicking on Proceed To Payment will take the customer to step three in the process.
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Step 3: Payment Options

Paymem Opﬁons 1 | Shipping Address | 2  Shipping Options =3 Payment Options | 4 | Order Confirmation

Email Address
MNotification about your order will be sent to this email address

= Email Address:

New Billing Address

= FIRST NAME Mary
= LAST NAME: Smith

*STREET ADDRESS: 1 First Street

*CITY: Santa Monica
COUNTRY. United States [+]
* STATEIPROVINCE: California =
P 81823
* DAY PHONE: 8181234567

EVENING PHONE

FAX:
Payment Options

@ Pay by credit card (DIBS)
You will be redirected to DIBS to make payment.

© Data Cash
5] Pay by PayPal Express
© Pay By Credit Card

7) Pay By Phone

Review & Place Order

The customer enters the billing address, if this is not already in the system. The desired payment option is
selected. Here there is a possibility to back to the previous steps. Clicking on Review & Place Order will
take the customer to step four in the process.
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Step 4: Order Confirmation

Order Confirmation 1  Shipping Address 2 Shipping Options | 3  PaymentOptions 4  Order Confirmation
Shipping Address Order Email
1 package via Fixed Shipping Rate mary smith@email2.com
Mary Smith Items Ordered Total
1 of Canon PowerShot Pro Series 55 1S 8.0MP Digital Camera with 12x Optical Image 544099
1 First Street Stabilized Zoom

Santa Monica, California 81823

Discount: $0.00
United States Item(s) Subtotal: 5440 99

8181234567 Shipping & Handling: $10.00
Total for this Shipment:  $459.99

Billing Address

Subtotal: 5440 99
Method: Pay By Phone ?lscaunt: :E EE
axes: $
Mary Smith Shipping & Handling: $10.00
1 First Street TOTAL: $459.99
Santa Monica, California 81823
United States
8181234567
Place Order

Step four provides a possibility to review the order details including pricing information before the order is
submitted. Details from previous steps are displayed with the possibility to back to previous steps. Click-
ing on Place Order will submit the order to the system and initiate the order management procedures.

The Check Out page is created in Edit mode and then defined in the site configuration setting of the start
page.

For more information on different payment providers in EPiServer Commerce, please refer to the Payment
Providers section.

Shopping Cart

The purpose of the Shopping Cart page type is to display product items that a customer have added to
the personal shopping cart. The page also provides functionality for changing the quantity of items as well
as removing items from the list or moving them to the wish list. The Apply coupon option will apply any
discount from a selection of related discount options from the system.

When the shopping cart information has been changed, clicking the Update Cart option will cause the
pricing information to be recalculated based on the new information. Clicking the Continue Shopping
option takes the customer back to the product page last visited.
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Login My Account My Cart Wiish List English {United States) ¥ US dollar ¥

o cLIcK+TAI_K 2 item(s) in your cart m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - My Cart

Shopping Cart

m

Desaription Each Oty Total
Move to wishlist Canon PowerShot Pro Series S5 1S 8.0MP Digital Camera with $440.00 $314.99 1 |z| $314.99
Remove 12x Optical Image Stabilized Zoom You save: $135 00

tem #: 013803079616

Move to wishlist - Vista Explorer 60" Lightweight Tripod with Tripod Bag $3,999.00 1 $3,999.00
Remove A tem 8: 049382208344

Subtotal:  $4,313.99

Update Cart | [ continue shopping Proceed to checkout

Review Store Policies Return and Exchange policy Privacy policy

General information regarding store and privacy policies are also defined on the Shopping Cartpage
type for this sample site. This information will be displayed as default links on the Shopping Cart page, to
be visible before the customer proceeds to checkout.

Open the Shopping Cart page in Edit mode to define the following:

e The Review store page. Page describing the general store policy. Create the page (page type
Standard Page) and select it in the page tree.

e The Return and exchange policy page. Page describing the general return and exchange policy.
Create the page (page type Standard Page) and selectitin the page tree.

e The Privacy page. Page describing the general privacy policy for personal information stored on
the site. Create the page (page type Standard Page) and selectitin the page tree.
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[ sar PCTN Commerce EPISERVER @ 7 - A admin> Q
Edit Mode Admin Mode Reports Visitc

O X 4 B I y & @ @ @ M @B E
| structure || Favorites |[myTasis | | | My Cart Page View

Praducts | - Page Type: [Commerce] Shopping Cart Status: Published Version
o Compare With

N .  F

Buyers guide

| Preview H Edit H Versions ” Workflow ‘

About us =
Our Services K save klsave and View F2Save and Publish | EJ Cancel &

Customer Service
J Content ” Scheduling H Settings H Shortcut ” Categories |

Support
Affiliate Program Name My Cart
[Function Pages] .} Review store page

& wy Accountl] Return and exchange policy page
L My Account &

i

) Privacy page
L Check out[7)

vy Cart]

= Wish List

m

- Login[]

- Register[ ]

I Search page[]

- Payment ]

- Forgot Password ]

- Product Page[.]

- Compare products|.]

- PayPal[}

Show Page Tree:

=5 English (United States) -

When created, the Shopping Cart page is defined in the site configuration setting of the start page.

Wish List

The Wish Listpage functionality displays product items in a personal wish list for a customer. The items
are added to the list when the customer clicks on the Wish List option for a product.

Sont By, Featured Products -

< ) [F] COMPARE

{b S44555 $350.99

You save: $90.00

The wish listitself is accessed when clicking on the Wish List option in the menu on the very top of the
page.
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Welcome, Store! Log out My Account My Cart Wish List English (United States) ¥ US dollar ¥
© CLICK+TALK et our
Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers
Start - Wish List
Wish List
Desaription Each aty
add to cart Pentax K200D 10 2MP Digital SLR Camera with Shake $599.95 1 E Item is in stock
remove Reduction (Body Only)
tem #: 027075138131
added June 16, 2010

add to cart Canon PowerShot Pro Series S5 1S 8.0MP Digital Camera with $449.88 $314.99 1 E Item is in stock
remove 12x Optical Image Stabilized Zoc You save: $135.00
tem #: 01380307961

added June 17

| Update Wishlist ‘| Continu Shopping |

When created, the Wish List page is defined in the site configuration setting of the start page.
Login

The purpose of the Login page is to provide a login possibility for registered customers of the e-com-
merce website. The user provides a user name or e-mail address as well as a password, and then clicks
Log in. When the login details are accepted the user is taken to the Account Dashboard displaying an
overview of the current account information.

The Loginpage also has functionality for password recovery. When clicking on the Forgot your pass-
word? option, the user will be taken to the Forgot Password page of the website.

The Login page is also the entrance for new registration of new customers to the site. Clicking on the
Create a New account will take the user to the Register page of the website, for creation of a new
account.
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Login Wy Account My Cart Wish List English {United States) ¥ US dollar ¥

o CLICK+TAI_K Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Login

Login or Create an Account

Existing customers log in New Customers
Please type your user name and password to login. This will allow you to review your By creating an account with our store, you will be able to move through the checkout
previous orders and access certain other pages. If you do not have an account yet, process faster, store multiple shipping addresses, view and track your orders in your
create 3 new one by clicking create new account account and more £
User Mame iEmail.  Mary Smith @ Create a New Account
Password sessees @

[¥] Remember me next ime

Forgot your password?

Buyers guide Aboutus Our Services Customer Service Support
Didigtal cameras History How lo place an order? New Customer? Download
Mobile Phones Our success our payment methods Register Help
Site Map Contact Terms and Conditions Forgotten your password

Press Order tracking
Affiliate Program Guarantee

Join our program

Copyright @ 2010 EPiServer AB

When opening the Login page in Edit mode, you can define the Password recovery page and the Reg-
ister page page by selecting the appropriate pages in the page tree structure. Naturally these pages
must be created before you can configure them here.

[ stan [NETIN commerce EPISERVER © 7 - A admin- Q
Edit Mode Admin Mode Reports Visitor Gro
O X 4 @ I y 3 @ @ @ M B E
[ Login Page View
Bl Root fekdes ~| | Page Type: [Commerce] Login Status: Published Version CompareWmh [ -]
if‘ Recycle Bin | Preview || Edit || versions || workfow |
@ Start b save Lklsave and View [™Save and Publish | EJ Cancel &
Products[2)
News[3 J Content ” Scheduling H Settings H Shortcut ” Categories |

Buyers guide "

v Name Login
About us
Password recovery page
Qur Services

Do

Register page
Customer Service g pag

m

Support

Affiliate Program
[Function Pages] |
ﬁ My Account.]

L My Account &

L Check out[7]

L My cart

= Wish List
HLooin B

- Register [

- Search page[:]
- Payment ]

- Forgot Password 1 .

Show Page Tree:

=5 English (United States) -

When created, the Login page is defined in the site configuration setting of the start page.
Register

The Register page type provides the possibility to create new customer accounts on the website. Per-
sonal and login information such as name, e-mail and password is entered by the user, and by clicking
Register the accountis created and the account details are saved in the customer database of Com-
merce Manager. Later on additional information such as billing and shipping address can be added.
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Log in My Account My Cart Wish List English (United States) ¥ US dollar ¥

o CLICK+TA|_K ‘Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Register

m

Sign Up for Your New Account

Personal Information

*First Name: Mary (]
= Last Name: Smith (]
* Email Address: mary.smith@company.com @

Login Informaticn

* User Name: Mary @
*Password: sessess @
* Confirm Password: sssssss @

When created in Edit mode, the Register page is defined in the Login page of the website.
Search

The Search pagepage type is used for displaying the results of a product search performed on the web-
site. The matching search hits are shown in a listing with rows of four product items. Product details are
displayed, with the possibility to add items to the shopping cart, or select items for comparison. The
number of matching hits listed on a search result page can be customized. Clicking on an item will dis-
play the full product information page.

Welcome, Store! Log out My Account My Cart Wish List English {United States) ¥ USs dollar v

o CLICK+TALK 1 item(s) in your cart m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start- Search page

Search result
Products (19) || Other

SortBy: | Featured Products =] 1-120f19 View Al (19)| 1|2

R 2

Cconpare O compare O compare O conpare
$79.11 $30.95 $21.95 $14.99
HS-590 Bluetooth Headset Sony Ericsson OEM Original Car HEADSET ANSWER/END BUTTON Nokia HandsFree Headset Earbud
Charger CLA-80 for K750, W200, REMOTE BUTTON with Receive and End Button for
WB00 00i, 7520, Z520a, Nokia Phones
00, Wa10
~ LR~ e - -

In Edit mode, the following properties are setin the Search page page type:

e The Start page for the search. Select a page in the page tree to define where the search should
begin, often this will be the start page of the website.
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e The Number of items in a search result page. Set a number to define the number of matching
hits listed on a search result page.

[ swe PCTON commerce EPISERVER © ? - L admm- Q
O & + 3 L - B @ ¢ Q@ 0D & E
| structure [[ Favorites [ wy Tasks Search page Eaasicy
) ez ~| | Page Type: [Commerce] Search Starus: Published Version Compare With
ifﬂ Recycle Bin | Preview H Edit H Versions ” Workflow ‘
@ start Hsave klsave and View [Save and Publish | £ Cancel &

Products|

- | [ Cantent | [Schaduing | Saings] | Snore] [cxsanes]

Buyers guide
neE Name Search page

About us
Start page for the search (=)
Our Services

Number of items in a search result page
Customer Service pag 12

il

Support
Affiliate Program
[Function Pages] [
ﬁ My Account[]

I My Account &

I Check out[7

I My Cart

[~ Wish List

= Login[s

-~ Register[.]
W5earch page B

I Payment 7

- Forgot Password [ IS

Show Page Tree:

5 English (United States) -

When created, the Search page is defined in the site configuration setting of the start page.
Payment

The purpose of the Payment page is to link to the appropriate payment procedure when finalizing a pur-
chase in the checkout process. There are many different payment methods to use in different markets,
and the payment gateways of e-commerce websites are often parts that are highly customized.

Payment methods are set up under application configuration for payment gateways in Commerce Man-
ager. The Payment page functionality is linked to the corresponding payment method. Other payment
methods may be payment by phone or by credit card.

The Payment page is created in Edit mode and then defined under the site configuration setting of the
start page. Several payment methods may apply on an e-commerce website. The default payment pro-
vider for the EPiServer Commerce sample site is PayPal Express. Find out more in the Payment Pro-
viders section.

Forgot Password

The purpose of the Forgot Password page is to provide possibility for registered users to retrieve lost
passwords. The user will enter the e-mail address that is registered in the system to receive a new pass-
word set by the system.
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Login My Account My Cart Wish List English (United States) ¥ US dollar ¥

o CLICK+TALK Your Shopping Basket m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Forgot Password

Forgot Your Password?

m

Enter your Email to receive your password. The password will be emailed to the address specified during registration

* User Name / Email: mary.smith@company.com @
Buyers guide About us Our Services Customer Service Support
Didigtal cameras History How to place an order? Mews Customer? Download
Mobile Phones Qur success “Your payment methods Register Help
Site Map Contact Terms and Conditions Forgotten your password
Press Order tracking
Affiliate Program Guarantee

Join our program

When created in Edit mode, the Forgot Password page is defined on the Login page of the website.

Product Page

The Product Page is a central page type on this type of site, since this is used for displaying product
details and related information. The page template will display selected product information such as dis-
play name and description and item number, from the product catalog of Commerce Manager. This infor-
mation is shown in the central part of the page.

The rest of the page is built up displaying other information related to the product. The information is
selected based on type of product and meta data available in the product catalog. Stock status infor-
mation for the product item is displayed. From here the customer has the option to add selected numbers
of the item to the shopping cart, or to the wish list.
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Welcome, Store! Log out My Account My Cart Wish List English (United States) ¥ US dollar ¥ —

o cLIcK"‘TAI_K 1 item(s) in your cart m

mera Accessories Mobile Phone Phone Accessories Special Offers

Start - Digital Cameras - Canon PowerShot SX100IS 8MP Digital Camera with 10x Optical Image Stabilized Zoom (Silver)

m

You May Also Like...

Ccanon Canon PowerShot $X100IS 8MP Digital Camera with
10x Optical Image Stabilized Zoom (Silver)

ANOS
o e
{ANOS )

$487.46

ANOS
[ry——
ANGS. )

e T

Item Number:
013802084146

Usually Ships in 24 Hours [ compare $2,999.00

Sony
Compare Products

Sony Quick Battery Charger with
‘You have no items to compare. 4 AA N-MH  Rechargeable

Related Products and Accessories Batteries

DigiPower

DigiPower DP5-3000+ 3-Hour AAJAAA Rechargeable Battery Kit $2,099.00
with 4 AA 2700 mAh Batteries and Car Charger

Canen

Canon ACK-800 AC Adapter for A310, A430, AS20, A530, A540, $4,900.00
AT00, AT10, AT20IS & SX1001S ISDigital Cameras

B { DigiPower
o Digipower DPS-5000 1 Hour AAIAAA Rechargeable Battery Ki §3499.00

g Acc 0 il
with 4 AA 2700 mAh Batteries $1,999.00

Canon

Canon PSC-100 Digital Camera

Case
ltemisinstock  Add to Wishlist 1 [=] Add To Cart

The Product Page page type is linked to the information stored about the productin the product data-
base. For instance, information such as name, code, catalog image, and display price is collected from
the Commerce Manager product catalog.

Commerce Manager Settings

EPISERVER COMMERCE Variation/SKU Edit

Welcome ™ Change Language About ™ ) Get Help For This Page =
Soioniassacment & J Overview || Pricing Inventory || 50 || Associations || assets || Relations
=™ Catalog Management
Name Canon PowerShot SX1001S 8MP Digital Camera 1
_, Catalog Entry Search 1
@ Caralog Batch Update ’;'\r‘éar:ame 8/24/2008 [ 03:31 Pu 1
g Catalogs
Expires on: |g/25,
& BT §/25/2018 [ 03:31 M
& (] Mobile Phones & Plans ?;‘:L:‘;te_ Digital Camera Template | =
(] Digital Downloads .
Code: 013803084146
= Digital Cameras
4[] Camera Accessories Sort Order: |

& () Daily Specials The sort order for the category entry.

& (] Brands
# ] Templates Meta Class: | Digital Cameras |z|

Available: @ Yes () No

Display

Name (en- Canon PowerShot SX10015 8MP Digital Camera with 10x Optical Im
us):

Display

Mame {de- | Canon Powershot SX100 IS (8 Megapixel, 10-fach opt. Zoom, 2,57
de):

Display

ﬁ Dashboard Name (es-
es):
Customer Management Primary o
us): Primary Image
Catalog Management

-ﬁ Order Management
E Marketing
zﬂ Asset Management

Reporting [] Delete Picture

Description :
il | TR | I | RSN P . O 0 (R

< '| n ] r

Administration

When created, the Product page is defined in the site configuration setting of the start page.
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Products Compare

The Products Compare page type holds functionality for displaying selected products for comparison.
The customer selects the desired products by marking the check box next to each product, an then clicks
theCompareoption.

$487.46

The selected products are listed next to each other together with related product features, for easy over-
view and comparison. A product can be removed from the comparison list, or added to the shopping cart
or the wish list.The selected products will remain for display on the compared products page until they are
removed or a new product selection is done by the customer.

Camera Accessories Mobile Phone Phone Accessories

Digital Cameras

Start - Compare products

Compare products

Digital Cameras

® " @ F @ -

Display Name

Canon PowerShot Pro Series
5515 8.0MP Digital Camera
with 12x Optical Image
Stabilized Zoom

$449.99

|-bl n'uliulu -

Addto Wishlist

Canon PowerShot Pro Series
5515 8.0MP Digital Camera

with 12x Optical Image

Stabilized Zoom

Canon Powershot SX10015
8MP Digital Camera with 10x
Optical Image Stabilized Zoom
(Silver)

5487.46

|-bl n'uliulu -

Addto Wishlist

Canon FPowershot 5X10013
8MP Digital Camera with 10x
Optical Image Stabilized Zoom
(Silver)

Canon PowerShot Pro Series
5315 6MP with 12x Image
Stabilized Zoom

$449.99

|-bl n'uliulu -
Add to Wishlist
Canon FowerShot Pro Series

5315 6MP with 12x Image
Stabilized Zoom

The Products Compare page type holds no information of its own so it has no editor field. When the prod-
uct compare page has been created, it will be defined in the site configuration setting of the start page.

PayPal

The purpose of the PayPal page type is to link to the PayPal payment procedure when finalizing a pur-
chase in the checkout process. The PayPal payment gateway is the default payment provider in the EPiS-
erver Commerce sample site. When created, the PayPal page is defined in the PayPalPaymentPage
field of the site configuration setting of the start page.
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There are many different payment methods to use in different markets. Please refer to the Payment Pro-
viders section to find out more about the different payment gateways for EPiServer Commerce.

Tools and Plug-ins

In this section we describe a number of tools and plug-ins for EPiServer Commerce. These are for exam-
ple a plug-in for the EPiServer CMS Editor making it possible to select product details directly from the
product catalog. The plug-ins described here are all included by defaultin the EPiServer Commerce sam-
ple site.

Product Picker Property

The Product Picker Property is a property which can be included in any EPiServer CMS 6 page tem-
plate. The property will add a field making it possible for editors to select products from the product cat-
alog, to be displayed in an EPiServer CMS content page, using a predefined display template of your
choice. The product information will be fetched from the product catalog. Please refer to the EPiServer
Commerce technical documentation for information on how to add the Product Picker property plug-in to
a page template. Here we describe how Product Picker works in the standard page of a sample instal-
lation of EPiServer Commerce.

Displaying Product Information in a Page

1. Open an standard content page for editing in Edit mode.

2. In the Select Product field, click the selection button. The product picker dialog will open. When
you expand the catalog tree on the left, related products will be displayed. You can browse the
structure and select products. The product display can be sorted by clicking on product ID or
Name. You can also search for a product by entering free text or product ID. Select a productin
the listand click Select.

3. Save your changes. The selected product will be linked to the page and displayed in the page
using the display template that has been defined.

=-Catalogs Search for product by name or ID in current and child nodes

& Everyting -
Mobile Phones & Plans

Structure || Favarites

B8 Rootfolder Digital Downloads D & Name
(] o 000000000000 Kodak EasyShare C2330 4MP Digital Camera with 3x Optical Zoom

iﬂ et BT SR 013803025040 Canon PowerShot A70 3.2MP Digital Camera w/ 3x Optical Zoom
Products [ Brands 013803025071 Canon PowerShot AG0 2MP Digital Camera with 3x Optical Zoom
News [l 013803063998 Canon PowerShot Pro Series 53 IS 6MP with 12x Image Stabilized Zo
BT 013803078442 Canon PowerShot A570IS 7.1MP Digital Camera with 4x Optical Ima
About us 013803079616 Canon PowerShot Pro Series $5 IS 8.0MP Digital Camera with 12x Oy
013803084146 Canon PowerShot $X100I5 8MP Digital Camera with 10x Optical Ima
Customer Service 027075049253 Pentax EI-200 2.1 1MP Digital Camera w/ 3x Optical Zoom
Support 027075052611 Pentax EI-100 1.3MP Digital Camera Kit )
A B2, 027075072404 Pentax Optio 33L 3 2MP Digital Camera w/ 3x Optical Zoom 5
[Function Pages] ] 027075076600 Pentax *istD 6.1MP Digital SLR Camera (Bady Only)

S es 027075076624 Pentax Optio 33WR 3.2MP All-Weather Digital Camera with 3x Optit

027075076655 Pentax Optio 33LF 3 2MP Digital Camera w/ 3x Optical Zoom
027075079601 Pentax Optio MX 3.2MP Digital Camera with 10x Optical Zoom
027075079656 Pentax Optio 43WR 4MP Water Resistant Digital Camera with 2.8x
027075079830 Pentax Optio 540 4MP Digital Camera with 3x Optical Zoom
027075086661 Pentax Optio 550 3MP Digital Camera with 3x Optical Zoom
027075086722 Pentax *ist DS 6.1 MP Digital SLR Camera (Body Only)
027075110632 Pentax Optio 50 SMP Digital Camera with 3x Optical Zoom

m

027075110755 Pentax Optio 535 5MP Digital Camera with 3x Optical Zoom

1234
4 1 »
|+ select| | No selection| |3 cancell
Show Page Tree: b - — 4
Select Product @ &) ki

Removing Product Information in a Page

Do the following to remove product information inserted with the Product Picker.
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1. Open an standard content page for editing in Edit mode.

2. Inthe Select Product field, click the selection button.

3. Inthe product picker dialog, select No selection to remove an existing product link.

4. Save your changes. The product information will be removed from the page.
Product Link Tool

The Product Link Tool is a plug-in to the EPiServer CMS 6 Editor. The tool adds a new function to the tool-
bar allowing an editor to link content to products in the product catalog in Commerce Manager. When the
link is clicked on, the visitor will be transferred to the product page "view mode" for that product.

Adding a Product Link

You can add product links to text, files or images in an EPiServer CMS page.

1. In Edit mode, select the text, files or images where you want to add a link to a product page in the
product catalog.

2. Selectthe Insert/edit Product Link tool in the toolbar of the Editor.

3. Inthe Select Product field, you will be able to access products in the product catalog of Com-
merce Manager. When you expand the catalog tree on the left, related products will be displayed.
You can browse the structure and select products. The product display can be sorted by clicking
on product ID or Name. You can also search for a product by entering free text or product ID.
Select a productin the list and click Select.

4. In the Language field you can choose to select the desired language version for the product page,
or let the system decide by selecting Automatically.

5. Enter the details for the link such as title and target frame, just as you would for any link in EPiS-
erver CMS. Click OK.

6. The productlink will be displayed in the Editor.

Ey o EPISERVER @ 7 ~ A admin~ Q
Edit Mode Admin Mode Reports Visitor Groups
O # 4 B 0 |% & @ @& @ m & E
i i i 5
Toracone [ [ Our Services Foce View [ et Unied sy ]
Page Type: [Commerce] Standard Page Status: Published ~ CompareWith [ [+]
i# Root folder
Version
il Recycle Bin
Preview || Edit || Versions || Workflow
@ s
tart

S

Products[3 Hsave klSave and View |[LSave and Publish | 3 Cancel

News [ J Content H Scheduling ” Settings ” Shortcut H Categories ‘

Buyers guide

Aboutus Name Qur Services
| Our Services [ Heading Our Services =
Customer Service MainBody
Support r - )

@ 25 @ l= - B 0] @ hipy/daily-commerce epise/Edit/ProductPicker/ProductLink.. L=/ E) [MeEde
Affiliate Program
[Function Pages][:] BLi=== Product Link

[Resources] i ]

Curabitur vestibulum aliq) Information

habitasse platea dictumst] Link title

ahquam.‘(:mabm:r nisi. Target frame Open the link in a new window -

futrum vitae_ vestibulum

vestibulum et, malesuadal

pulvinar iaculis, ligula mi Link target

Mauris sollicitudin fermed Select product [@

mterdum lacus sit amet of Iangeage Automatically .

eros quam gravida nisl. id

sapien. Phasellus volutpal

egestas quam mauris ut 13

Path: p

Secondarytody etz

b = g (0O
== =|[iZ 1= —| Styles [ wm e @ Qf

B I U
Show Page Tree: =

= English (United States) - 1 B

EPiServer Commerce supports permanent links, meaning that when a product is renamed the
URL will be remembered and will not be broken.
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Editing a Product Link

1. Select the link and choose the Insert/edit Product Link tool in the toolbar. This will open the Prod-
uct Link dialog.
2. Editthe link options as desired and click OK to save your changes.

Removing a Product Link

Select the link and click the Unlink tool in the Editor toolbar. This will remove the link from the selected
text.

The tool buttons in the editor toolbar can be customized, for instance you can change the
grouping and orders of the buttons. This is done from the EPiServer CMS administration inter-
face and is described in the Configuring the HTML Editor section of the EPiServer CMS user
documentation.

Product Dynamic Content

The Product Picker Dynamic Content function is used for displaying products as dynamic content. In
Edit mode in EPiServer CMS, the editor can use the function to display product information from the prod-
uct catalog. This adds to the many possibilities with dynamic content, where you can reuse and display
content in multiple places on the website, but will only need to update the information in one location.

Adding Product Information as Dynamic Content

Do the following to add product information as dynamic content to a page:

1. Open the page for editing in Edit mode and place the cursor in the editor where you want to add
the information.

2. Selectthe Dynamic Content tool in the toolbar.

3. Select Product picker in the Select plug-in field. The product picker fields will appear in the Set-
tings section.

4. In the Select product field, click the button to select a product from the Commerce Manager prod-
uct catalog.

The product picker dialog will appear, and you can select a product or a product category by
expanding the product category tree, or searching in the search field. Select the desired product
and click Select.

5. The product display template is defined in the Select display path (can be changed here if
needed).

6. Click OK. A dynamic content box will appear in the editor. Save your changes and view the result
in preview or view mode.

© EPiServer AB


http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/
http://webhelp.episerver.com/

240 | User Guide for EPiServer Commerce 1 R2

m cMs o EPISERVER @ ? ~ L admin+ Q
Edit Mode Admin Mode Reports Visit

0O &8 4 B O y & @ @ @ m @ B
J Structure || Favorites || My Tasks Our Services Eaqeilicn =

Page Type: [Commerce] Standard Page Staws: Published ~ Compare With

Version

i@l Recycle Bin
| Preview ” Edit H Versions ” Workflow |

@ start
H save klSave and View [Save and Publish | £ Cancel &

& Root folder

Products[]

News [ J Content H Scheduling ” Settings ” Shortcut H Categories ‘

Buyers guide

About us Name Qur Services

f.’ Heading Our Services =
Customer Service MainBody
Support =
&= i O * (0 O [ G|
Affiliate Program
) B IV \
[Function Pages] (1 B 2 ¥ & nitpu/rdaity-commerce.ep.seffid=23_61&parentid=aipageFolderd=61eps.. -] (=) [

[Resources] i -
Dynamic Content

egestas g

accumsat Type h

sit amet

purus. C mduct pi( » A
age prope

oo @

massa at |||

molestie

ligula.

Path: p

Secondaryl} -

0 7 B B B e o e e
wrme [
Show Page Tree: I = Q

= Enaglish (United States) * = i

O You can also personalize dynamic content, and display customized information to different vis-
itor groups. Find out more under the Personalization section.

Editing Dynamic Content for a Product
Do the following to edit dynamic content for a product:

1. Open the page for editing in Edit mode and place the cursor in the editor where you want to add
the information.

2. In the dynamic content box, select the Edit option. The product picker dialog will appear, and you
can selected another product or product category. Click OK when done.

3. Save your changes and view the result in preview or view mode.

Removing Dynamic Content for a Product
Do the following to remove dynamic content for a product:

1. Open the page for editing in Edit mode.
2. Selectthe dynamic content box and press Delete on your keyboard.
3. Save your changes to the page.

Gadgets in EPiServer Commerce

A gadgetis a small application which can be displayed on the OnlineCenter dashboard for quick access.
The OnlineCenter comes with a number of predefined gadgets, and the EPiServer Commerce sample
site is also delivered with gadgets customized for e-commerce solutions. In the user documentation for
EPiServer OnlineCenter you can read more about gadgets and how to use them. You can also develop
and customize your own gadgets to suit your needs. Find out more about development of gadgets in the
technical documentation for OnlineCenter on world.episerver.com. The EPiServer Commerce gadgets
are part of the common framework and are included in a sample installation.
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Adding gadgets to the dashboard

Gadgets can easily be added to the dashboard in EPiServer Commerce by selecting Add Gadgets, and
selecting one of the available gadgets.

Start SRR e EPISERVER © 7 - ladmin~ Q
Add Gadgets...
- Commerce ~ X @

Commerce Orders ]

Sales Graph

& products: 1319 © categories: 64 [ orders: 7
no sales data available 4] customers:4 2 promotions: 1

m

m

Total Sales (this year)

no sales data available

« i G
Purchase Orders

Orders today

Orders this week

Orders this month

~N B BN

Orders this year

Gadgets for EPiServer Commerce are described in more detail in the following.

Commerce Orders Gadget

The Commerce Orders gadget displays orders statistics in the form of a sales graph and a list of pur-
chase orders in a time interval of your choice.

Do the following to add and configure the Commerce Orders gadget:

Log on to EPiServer Commerce and select Dashboard in the right-click menu.

Select the Dashboard tab under which you want the gadget to appear.

Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Orders
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.

@~

Start CM5 Commerce
Add Gadgets...
Add Gadgets
Commerce Orders Commerce
Owverview
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When the Commerce Orders gadget has been added to your dashboard, you will be able to easily mon-
itor sales activities for your EPiServer Commerce website.

Commerce Overview Gadget

The Commerce Overview gadget shows sales data from the e-commerce system. The data is grouped
by products, categories, orders, customers and promotions.

Do the following to add and configure the Commerce Overview gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Commerce Overview
gadget by clicking on itin the list. The gadget will be displayed on the dashboard. By default, it will
be updated to display new data every 30 seconds.

4. To update the refresh interval, select Edit in the drop-down menu of the gadget, and enter a new
time interval. Click OK to save you changes.

Commerce Overview [*] =

Settings Edit
Refresh Interval in secands 30 “

When the Commerce Overview gadget has been added to your dashboard, you will be able to easily mon-
itor sales data from your EPiServer Commerce website.

Comment Approval Gadget

The Comment Approval gadget makes it possible for EPiServer Commerce administrators and editors to
manage comments that are left by website visitors. This gadget provides an overview of the commenting
status, and you can view, approve or delete comments from here.

Do the following to add and configure the Comment Approval gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu.

2. Selectthe Dashboard tab under which you want the gadget to appear.

3. Select Add Gadgets in top left corner of the dashboard, and then select the Comment Approval
gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

4. By selecting Edit in the drop-down menu of the gadget, you can set the number of approval items
to display, as well as the length of the description.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.

Do the following to use the Comment Approval gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-
board tab under which the Approval gadget is located.

2. You can chose to view all comments, or filter them according to their status - Approved, Pending
or Deleted. Click Refresh to update the listif needed.

3. Selectone or more comments for which you want to update the status, by clicking the checkbox to
the left of each comment. Click the top left checkbox to select all comments displayed in the list.

4. Selectthe status you want to apply - Approve, Mark Pending or Delete. For instance, select
Approve to approve the selected comments.

Comment Abuse Report Gadget

The Comment Abuse Report gadget makes it possible for EPiServer Commerce administrators and
editors to manage comment abuse reports that have been created by website visitors. This gadget pro-
vides an overview of abuse reports, and you can remove selected comments from here.

Do the following to add and configure the Comment Abuse Report gadget:
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Log on to EPiServer Commerce and select Dashboard in the right-click menu.

Select the Dashboard tab under which you want the gadget to appear.

Select Add Gadgets in top left corner of the dashboard, and then select the Comment Abuse
Report gadget by clicking on itin the list. The gadget will be displayed on the dashboard.

By selecting Edit in the drop-down menu of the gadget, you can set the number of items to display,
as well as the number of abuse reports to be displayed for each comment.

5. Click OK to save you changes. The gadget will be displayed on your dashboard.

@~

&

Do the following to use the Comment Abuse Report gadget:

1. Log on to EPiServer Commerce and select Dashboard in the right-click menu and select the Dash-
board tab under which the Comment Abuse Report gadgetis located.

2. Selectthe comments you want to manage by clicking the checkbox to the left of each comment.
Click the top left checkbox to select all comments displayed in the list.

3. Click Remove Comment to remove the comment. Select Ignore to leave the comment without any
actions.

Commerce Settings for CMO Gadget

With EPiServer Campaign Monitor and Optimization (CMO) you can measure and monitor campaigns
on your website and optimize your landing pages. EPiServer CMO provides a simple way to analyze cam-
paigns and landing pages, rather than whole sites. Find out more about EPiServer CMO in the user doc-
umentation on world.episerver.com.

EPiServer CMO can also be used for monitoring activities on an EPiServer Commerce site. You can for
instance monitor the number of views or orders for a specific product or product category. The logging of
Commerce KPI data is supported using the Generic KPI function in CMO. The number of orders is an
example of a generic KPI. This allows for external applications such as Commerce to send notifications
using a specific application key. The application names and keys are defined in EPiServer CMO, which
will then listen for incoming notifications with these specific key values, and collect and store the data.

The following procedure applies when setting up the integration between CMO and Commerce:

Set up the web services to be used by EPiServer CMO and the corresponding URL to be used.
Define the external applications, their application names and keys, in EPiServer CMO.

Define the product views and/or product orders you want to monitor, using the EPiServer Com-
merce Settings for CMO gadget. Here you will need the application keys and the URL for the

CMO Web Services.

In EPiServer CMO, create a campaign and add the generic KPI for EPiServer Commerce.
EPiServer Commerce will update the KPI value using web services.

The monitoring result will be displayed on the campaign report page in CMO, or by using the

CMO KPI Summary gadget for EPiServer Commerce on the site that has the EPiServer CMO serv-
ice installed.

EPISERVER & 7? - A Administrator > Q

Overview LPO Campaigns Settings

¥ Settings External Applications @
General
Dara Aggregation H save £ Cancel
Security
Page Thumbnails
Live Monitor
External Applications Application Name Application Key Is Used Edit Delers
| Web shop orders 23456 Yes &3

The collected data for EPiServer Commerce is defined in the EPiServer OnlineCenter using the Com-
merce settings for CMO gadget, as described in the following.
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O To use this gadget you need to have both EPiServer CMO and EPiServer Commerce installed
on your website.

Adding the Commerce Settings for CMO Gadget

When you add and configure this gadget, you can choose to monitor activities for a selection of product(s)
or order(s).

Do the following to add and configure the CMO gadget for EPiServer Commerce:

Open the EPiServer OnlineCenter for your website(s) and select Add Gadgets.

Click on the Commerce setting for CMO gadget to add it to your dashboard.

Click Add to define the monitoring parameters.

Select Type, choose either Product View or Product Order. The Product View will define views of

a product or all products under a specific category (node). The Product Order will define orders for

one selected product or all orders of products under a specific category (node).

5. In the Product/Category field, choose a product or a category by selecting an option in the tree
structure on the left hand, and click Search in the area to the right. Select a productin the search
list and click Select. Or, you can select an entire category (node). You can also search directly for
a product name or ID. Click Select to add your selection.

6. Inthe Application Key field, enter the application ID (defined in EPiServer CMO).

7. Inthe URL for CMO Web Service field, enter the URL to be used by CMO for the web service

(defined in EPiServer CMO).

PobN=

Editing Commerce Settings for the CMO Gadget
Do the following to edit a set of settings for the CMO Gadget:

1. Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.

2. Click the Edit icon for the settings you want to edit.

3. Update the settings information, please refer to the section about adding the Commerce settings
for CMO gadget.

4. Click OK to save your changes.

Deleting Commerce Settings for the CMO Gadget
Do the following to delete the settings for the CMO Gadget:

1. Open the EPiServer OnlineCenter Dashboard, and navigate to the Commerce settings for CMO
gadget.

2. Inthe check box to the left, select the set of settings you want to delete.

3. Click the Delete button and click OK to confirm.

Managing the Tag Cloud

"Tags" are words describing the content of a website. A "tag cloud" is a visual depiction of tags on the site.
In a tag cloud the importance of a word is shown with font size or color. Tags are also hyperlinks, and
clicking on a tag will display content marked with that particular tag.

The tag cloud in EPiServer Commerce is a search tag cloud generated by users when searching for an
item on the site. The more popular a search phrase is the more highlighted it will be in the search tag
cloud. The search tag cloud on the sample site is displayed under the "Popular searches" part of the mid-
section of the start page.
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Popular searches

Canon iPhone oPhone
powershot «.:a60 Nikon

pentax 870 * track trac rac camera e0s 45 ch
plantronics voyager disk charger nkon Hardskin for
3G Black phonekleen adobe wide adapter page
sany power handsfree

The EPiServer Commerce sample site comes with a tag cloud plugin for managing the tag cloud. This is
accessed from the Action Window of EPiServer CMS. From the Tag Cloud Management section in the
Action Window, you can manage the tag cloud listitems, and perform tasks such as updating the name
and hit count for a tag, or delete a tag.

Listing tag cloud items

1. In EPiServer CMS Edit mode, open the Action Window.
2. In the Action Window, click Tag Cloud Management. A list of existing tag cloud items will be dis-
played.

.h.ch:- n Window

Search for tag:

?_Jj Search
Name & Hits Delete Edit
camera 3 b4 7
canon 5 b4 r 4
demao 5] i &
iphone 2 b4 &
nokia 1 b4 &
plan 1 b4 7
powe 1 b4 7
powershot 1 b4 &7
poweshot 1 b4 &7
price 1 b4 7
vista 1 b4 d

As default, 20 tags will be displayed at the time in the list. Click on the paging section in the footer of the
list to navigate to between pages of the list.

Sorting the tag cloud list

The tag cloud list can be sorted by tag name or by hit count. Click column headers Name/Hits to sortin
ascending or descending order.
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Searching for a tag

To search for an existing tag, enter part of or the full tag name, in the Search for a tag field at the top of
the tag list.

Updating a tag
To update a tag, click the Edit symbol next to the tag in the tag list. You can change the tag name and you

can update the hit count number for the tag. Click Save to update the changes. Note that each tag must
have a unique name.

Deleting a tag

To delete a tag, click the Delete symbol next to the tag in the tag list. Click OK to confirm the deletion.

Personalization

The personalization feature in EPiServer CMS allows you to create adapted content that will be displayed
to targeted Visitor Groups. Based on user information collected when visitors access your website, dif-
ferent content will be shown to different visitor groups of your choice. You can for instance display dif-
ferent content to first time visitors and returning visitors on your website. The personalization feature is
described in detail in the user documentation for EPiServer CMS 6 R2.

The EPiServer Commerce sample site features a number of predefined visitor group criteria customized
for an e-commerce site where you want to monitor user activities for instance for products and orders. Vis-
itor groups can be applied to the various content on your EPiServer Commerce site, thus creating a per-
sonalized website visitor experience.

The visitor groups and their associated personalization criteria can be accessed by clicking on CMS in
the global menu, and then selecting Visitor Groups in the submenu displayed. Or, you can right-click in
View mode and select Visitor Groups in the EPiServer CMS right-click menu.

The personalization criteria for EPiServer Commerce are available under Commerce Criteria when you
click Add to define visitor groups for your site. The various criteria can then be dropped into the con-
figuration area.

Start CMS Commerce EPISERVER & 7 ~ JAadmin~ Q

Edit Mode Admin Mode Reports Visitor Groups

Create Visitor Group @

Adapt content on your website by first creating visitor groups and then using the groups to target the content on pages.

Criteria »
Commerce Criteria

match |l []
Customer Properties

; Total Spent :
: D T
Recent Orders
Other Information
Total Spent

Name

Notes -

- r c Ci Crits
Security role [C] Make this visitor group available when setting access rights for pages and files. Sl TS A

Statistics Enable statistics for this visitor group Site Criteria

Time and Place Criteria

URL Critena

Visitor Groups

The predefined personalization criteria for EPiServer Commerce are described in more detail in the fol-
lowing.
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Customer Properties Criteria

With the Customer Properties criteria you can personalize content based on for instance age and geo-
graphic location.

Personalize content based on the following information (select from drop-down list):

e Date of Birth - define an age range by entering a from/to date. Select a date in the calendar or
enter a date directly in the field (default format mm/dd/yyyy).

Customer group - select one of the existing groups Customer, Partner or Distributor.
Registration source - enter the source of registration in free text format.

Country - select a country from the list.

Region code - select a region code based on the address region in addresses.

Address postal code - based on state selected, select a postal code from the list.

State - select a state from the list.

O Only one property type with a related value can be selected for a criterion, but several Cus-
tomer Properties criteria can be defined for a Visitor Group.

Order Frequency Criteria

With the Recent Orders criteria you can identify customers that have placed an order in the store" X"
times in the last"Y" days.

Personalize content based on the following information:

e Order times - select the number of times an order has been placed.
e Number of days - select the number of days.
Product in Cart or Wish List Criteria

With the Products in Cart or Wish List criteria you can identify shoppers that have placed a product of a
certain type or brand in their cart or on their wish list.

Personalize content based on the following information:

Specified product code - enter the desired product code in free text format.

Product from a specified category - select the desired product category from the list.

Product has a specified property and value - enter the desired product property and value, for
instance "brand" and "Sony".

O Only one property type with a related value can be selected for a criterion. However, you can
add several criteria of the type "Products in Cart or Wish List" to a Visitor group.

Recent Orders Criteria

With the Recent Orders criteria you can personalize content for visitors that have placed an order on the
site in the last "X" days.

Personalize content based on the following information:

e Number of days - select the number of days.

Total Spent Criteria

With the Total Spent criteria you can personalize content for visitors that have spent "X" amount of money
(in a specified currency) on the site in the last"Y" days.

Personalize content based on the following information:
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e Spent at least - select amount and currency.
e Select number of days.

Rating and Commenting

Visitors to the EPiServer Commerce sample site have the possibility to rate and comment on the various
products displayed. This functionality is built into the product display template of the EPiServer Com-
merce sample site.

Rating

To rate a product a visitor needs to be registered with an account, and logged on to the site. When select-
ing a product, there will be a clickable rating field available. The system will calculate an average rating
value based on the number of votes from users. The average rating for a product, as well as the number
of votes, will be displayed to all visitors to the site regardless of whether they are logged on or not.

o cLIcK+TA|_K 1item(s) in your cart m

Digital Cameras Camera Accessories Mobile Phone Phone Accessories Special Offers

Start - Phone Accessories - Apple Iphone PDA Premium Reusable LCD Screen Protector with Lint Cleaning Cloth
You May Also Like...

Apple Iphone PDA Premium Reusable LCD Screen
Protector with Lint Cleaning Cloth

Average rating: Number of votes: 2 )
$9.99 S~
$39.99
Compare Products
. » p Item Number: in 94 He .
You have no items to compare ELCROOOTGAHAWS Usually Ships in 24 Hours [[] Compare Apple iPhone Soft Polycarbonate

Slim fit Case- Silver - Cozip Brand
(Made in Korea)

Commenting

To comment on a product, a visitor needs to be registered with an account, and logged on to the site. You
also need to be logged on to the site to see the comments for a product. When selecting a product, there
will be a Post Comment button available. Clicking on the button will open a comment editor where the
user can add and save commenting text.

Your rating:
COMMEMNTS POST COMMENT

Great phone!
This is a great phone | just ordered one

Posted: 7 m ago By: Mary
© Remove
Status: Pending

Logged on users can remove their own comments. By default, comments added will receive status "pend-
ing" and must be approved by the site administrator before they are visible to others on the site. The
approval is done from the dashboard using the Approval Gadget. Commerce Manager administrators can
see the status for each comment, and remove all comments, from the display for each product.
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Abuse reporting of comments

When logged on to the website, you can abuse report comments that others have posted for a product.
This makes it possible for site administrators to monitor inappropriate content using the Abuse Gadgeton
the dashboard. When a comment is abuse reported, it will generate an item in the list of abuse reports for
the site administrator to manage.

Payment Options

EPiServer Commerce is a flexible platform allowing you to use many of the most popular payment pro-
viders within e-commerce. There are a number of payment solutions for different markets available "out-
of-the-box" for EPiServer Commerce. Some can be installed automatically with the EPiServer Commerce
sample site, and some are available as separate modules.

Payment Options Available with the Sample Site

When you install the EPiServer Commerce sample site, the payment provider options listed below will be
available. These will be included in the installation, and all you need to do is to configure the accounts for
these payment providers in Commerce Manager.

e Pay by PayPal Express -payment option using the PayPal Express payment services provider.
This solution is described more in the PayPal Express section.

e DIBS Pay by credit card - payment option using the DIBS credit card payment services provider.
This solution is described more in the DIBS Credit Card Payment Services section.
Pay by Phone - payment option where paymentis done by phone.
Pay by Credit Card - payment option for other common credit cards.

Payment Options Available as Separate Modules

The following payment options are available as separate modules for EPiServer Commerce:

e Klarna Payment Provider - payment using the Klarna Invoice and Part Payment services pro-
vider. Please refer to world.episerver.com for more information about this solution.

e DataCash - payment option using the DataCash payment services provider. Please refer to
world.episerver.com for more information about this solution.

Refer to the EPiServer Commerce Developer Guide for more information on how to create and configure
different payment options.

PayPal Express Payment Provider

If selected, the PayPal Express payment services are installed and configured automatically during the
installation procedure for the EPiServer Commerce sample site. When the order is placed and confirmed,
the procedure will continue with the payment. If the selected payment option is "Pay by PayPal Express"
in step 3 of the checkout procedure, the PayPal Express payment function will be activated to carry out
the payment procedure.

© EPiServer AB


http://world.episerver.com/
http://world.episerver.com/
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm
http://sdk.episerver.com/commerce/1.1/default.htm

250 | User Guide for EPiServer Commerce 1 R2

EVENING PHOMNE: ¢ 5
& What is PayPal? - PayPal - Windows Internet Explo... l — ot 3

|._,p) https:/fwww.paypal.com/se/cgi-bin/webscricmd=xpt/Marketing % |
PayPal
What Is PayPal?

FAX:

Payment Options

© DataCash

@ Pay by PayPal Express

Pal PayPal, the trusted leader in online payments, enables buyers and
Pay. businesses to send and receive money online. PayPal has over 100
million member accounts in 190 countries and regions. It's accepted by

The safer, easier way to pay. merchants everywhere, both on and off eBay.

7 Pay by credit card (DIBS) )
T ) Is it safe to use?

_ PayPal helps protect your credit card information with industry-leading
) Pay By Phone security and fraud prevention systems. When you use PayPal, your

financial information is never shared with the merchant.

*) Pay By Credit Card

Why use PayPal?

* Make purchases or send money with PayPal —it's free
+ Shop and pay conveniently by saving your infarmation with
PayPal
| + PayPal is accepted by millions of businesses worldwide and is
the preferred payment method on eBay

Star using PayPat today!

<< Back

Close Window

When you click Place Order on the order confirmation page, you will be redirected to PayPal to approve
the payment.

You can see the shipping and billing addresses entered during the checkout procedure, during which
these addresses can be changed.

When you have finalized the approval process, you will be redirected to the “Thank You” page of the EPiS-
erver Commerce sample site.

To find out more about the payment process and configuration of PayPal and other payment methods for
EPiServer Commerce, please refer to the Configuration section of the EPiServer Commerce Developer
Guide.

DIBS Credit Card Payment Services

If selected, the DIBS credit card payment services are installed and configured automatically during the
installation procedure for the EPiServer Commerce sample site. When the order is placed and confirmed,
the procedure will continue with the payment. If the selected payment option is "Pay by credit card (DIBS)"
in step 3 of the checkout procedure, the DIBS payment function will be activated to carry out the payment
procedure.
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DIBS )

Py =iz=t Servein

EPI Server AB

1. Payment method
2. Validate payment

3. Payment accepted

Purchase

sMasterCard = Information

*VISA = The shops order

number
POG57E5

Amount
034.92 UsD

Selecting the desired credit card brand will allow for entering the credit card details.
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DIBS

Papstdst Servicei

EPI Server AB

1. Pavment method

2. Validate payment

3. Payment accepted

g

Payment using VISA Purchase

Cancell Information

The shops order

* Card number:

4262880022421081 number
* Expiry month: POGGE479
o7 Amount
* Expiry year: 8,008.00 UsD
11
Payment method
* OGOV
953 W

Yalidate payment

|
Selecting Validate Payment will validate the payment. If the card details validate properly the payment
will be accepted and the process will be completed.

To find out more about the payment process and configuration of DIBS and other payment methods for
EPiServer Commerce, please refer to the Configuration section of the EPiServer Commerce Developer
Guide.

Search Providers

EPiServer Commerce features a provider model for the search index for both indexing and search que-
ries. This provision allows the development of additional custom search provider to other search systems.

When installing the EPiServer Commerce sample site, Lucene will be the default search provider
installed. To find out more about Lucene, please visit the official Lucene website.

Related topics:

e Searching for product catalog entries
e Indexing product catalogs
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Scheduled Job Clear Commerce Cache

When working with EPiServer Commerce and for instance importing or deleting a product catalog, it will
be necessary to clean the runtime cache in order to make the website up to date. This is done using a
scheduled job which is managed from the EPiServer CMS administration interface. The scheduled job
can be executed repeatedly at given time intervals, or manually.

To find out more about how to work with product catalogs, please refer to the Catalog Management sec-
tion in this documentation.

Do the following to manage the Clear Commerce Cache scheduled job:

Login as an administrator and navigate to the EPiServer CMS Admin mode.

Check the Activate check box to activate the scheduled job.

If you want to run the scheduled job manually, click Start Manually and the job will be executed.

If you want the scheduled job to be run automatically, set the desired time interval in the Sched-

uled job interval field.

5. The time when the scheduled job will be run the next time will be displayed in the Next scheduled
date field.

6. Click Save to save your changes.

PN~

Under the History tab, you can monitor the status and results when the scheduled jobs have been
executed.

To verify that the cache has been cleared,you need to refresh the catalog display pages.
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